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Welcome to the

GIFTS Plus Pack
.NET Extension

Congratulations on your purchase of the Plus Pack .NE'T extension
for GIFTS, and welcome to the Plus Pack utilities for increased
productivity. This manual describes how to configure and use these

utilities.
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About the GIFTS Plus Pack

The GIFTS Plus Pack is a set of .NET add-on utilities that integrate
seamlessly into GIFTS to offer extensive options for updating batches of
records, verifying tax status information, verifying watchlist information,
updating and adding organizations, batch requirement and payment
scheduling, enhanced charting, and enhanced e-mail capabilities. The
utilities are built on the Microsoft .NET platform, and are accessed from
within GIFT'S for a seamless user experience.

The Plus Pack includes the following ten utilities:
< GIFTS Batch Plus

< GIFTS Requirements Plus

< GIFTS Payments Plus

% GIFTS Reminders Plus

% GIFTS Charts Plus

% GIFTS Email Plus

< GIFTS Tax Status Plus

< GIFTS Watchlists Plus

< GIFTS Outcomes Plus

% GIFTS Link Plus for use with Outlook

The features of these utilities are summarized in the sections that follow.

GIFTS Baich Plus

Batch Plus provides the following capabilities for modifying batches of
records in GIFTS:

e

< Create or change classification codes: Batch coding allows you to revise
and refine your coding system as your organization grows and evolves.

About the GIFTS Plus Pack



GIFTS Batch Plus is a powerful and convenient method for altering the
coding for multiple records in a single step.

< Assign staff: You can change the member of your staff associated with
batches of Request records, and specify whether the Activities associated
with the Requests are transferred to the new staff member.

< Modify Request Type: You can change the Request Type and Request
Status for batches of GIFTS Requests.

< Modify Project Descriptions: You can add text to the beginning or end
ofthe Project Description for a batch of Requests, or overwrite the existing
descriptions with a new one.

< Assign Meeting Dates: You can assign or change the meeting dates for
batches of Requests. This allows fast and easy updates to GIFTS as your
grant review meetings evolve.

GIFTS Requirements Plus

Requirements Plus provides the following capabilities for working with
GIFTS Requirements:

% Schedule requirements: You can schedule requirements for multiple
Requests or Payments at any stage of your workflow. This flexible
requirement-scheduling tool allows you to select groups of Request or
Payment records based on a fixed or relative date, project start dates or
end dates, Payment Schedule Date, Paid Date, or other relevant dates.

< Automatically schedule payment contingencies: For groups of records,
you can schedule Payment Requirements and make the payments
contingent on completion of those requirements.

< Delete requirements: You can maintain the integrity of your data and
more effectively manage staff resources by deleting groups of
requirements that are no longer valid.

GIFTS Requirements Plus IX



GIFTS Payments Plus

Payments Plus extends the payment scheduling capabilities of GIFTS with
the following features and capabilities:

< On-demand Schedule Creation: You can create payment schedules for
Pending and Approved Requests at any time (provided that no payments
have already been created), not just during the Approval process.

< Updating Existing Schedules: You can modify the payment schedule for
a Request from a single screen. This saves keystrokes, and as you're

working you can see how the changes you make affect the total amount
scheduled.

< Batch Processing: You can create payment schedules for batches of
Requests.

< Greater Flexibility When Creating Schedules: Many of the defaults and
restrictions that apply when scheduling payments in GIFTS do not apply
to Payments Plus. For example, you can divide different percentages of
the grant amount among payments, schedule payments outside of the
Start Date or End Date of a grant, and specify whether payments that fall
on a weekend are moved to a weekday.

GIFTS Reminders Plus

Reminders Plus provides the following capabilities for sending reminders:

e

< Automatically send reminders: You can schedule a reminder to be sent
relative to the due date of any GIFTS Activity and Requirement type. For
example, you can set up a reminder on Progress Reports to be sent one
week prior to the due date, and GIFTS will automatically send out emails
to the recipient/s you selected. Reminders Plus runs on a daily basis at a
time specified by you.

X GIFTS Payments Plus



GIFTS Charts Plus

This advanced charting utility allows you to transform GIFTS data into
presentation-ready charts and graphs, and improves your ability to select the
data to be included in your charts.

GIFTS Email Plus

Extends GIFTS email capabilities by allowing you to attach GIFTS
documents or other files to your messages, and to easily retrieve the e-mail
addresses of Contacts affiliated with the information you are sharing.

GIFTS Tax Status Plus

Tax Status Plus allows you to verify and update tax status information for
Organizations in GIFTS. It also describes how to search for tax exempt
organizations in MicroEdge’s Tax Exempt Organization Database.

GIFTS Watichlists Plus

Watchlists Plus helps you comply with your own internal compliance
programs by checking Organizations and/or Contacts against specific
Watchlists, such as those provided by OFAC, the FBI, INTERPOL, and the
European Union, among others.

GIFTS Outcomes Plus

Outcomes Plus automatically facilitates the creation and setup of the fields
you need to track outcomes data, allowing you to be more efficient when
tracking the success of your giving programs.

Outcomes Plus fields and tabs were designed by MicroEdge based on the
framework, concepts, tools, and templates defined by MicroEdge’s outcome

GIFTS Charts Plus Xl



partner, The Rensselaerville Institute (TRI), a non-profit group that has
been dedicated to measuring and improving outcomes in all fields of human
achievement for more than 45 years. Before employing Outcomes Plus, we
recommend that you consult with The Rensselaerville Institute to define
your outcomes framework, and then work with a MicroEdge Product
Specialist to plan the best way to implement this framework into the GIFT'S
database using the Outcomes Plus tool.

GIFTS Link Plus for use with Outlook

GIFTS Link Plus for use with Outlook allows you to send Outlook email to
GIFTS as a Mail Activity. If you have Document Manager, you can store the
email and/or email attachments as documents. Please note that Essential
GIFTS users cannot use GIFTS Link Plus.

GIFTS Link Plus for use with Outlook



Setting U
Plus Pack Securit

This chapter describes how to configure GIFTS Plus Pack security
using the Plus Pack Configuration utility. For information about
installing or upgrading the Plus Pack, please refer to the Installing and
Configuring GIFTS Plus Pack 5 or Upgrading to GIFTS Plus Pack 5.
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Setting Up Plus Pack Security

About Security and the Configuration Utility

Batch Plus, Requirements Plus, Payments Plus, Reminders Plus, Tax Status
Plus, Watchlists Plus, Outcomes Plus, and Link Plus for use with Outlook
have the ability to change large amounts of data in a single operation. Since
these changes cannot be undone, it is important to restrict the use of these
utilities to qualified members of your staff. There are no security restrictions
for Charts Plus and E-mail Plus, which are available to all users.

You can use the Plus Pack Configuration utility to determine which GIFTS
users have access to these utilities, and which features of the utilities are
available to your users. When you assign permissions, you can grant access
to entire GIFTS user groups or to individual GIFTS users. For information
about installing or upgrading the Plus Pack, please refer to the Installing and
Configuring GIFTS Plus Pack 5 or Upgrading to GIFTS Plus Pack 5.

Note: Users can access a utility if you grant permission to their user account
or to their user group.

Accessing the Configuration Utility

The Plus Pack Configuration utility runs automatically at the conclusion of
the Plus Pack installation or upgrade process. If you would like to run the
utility at any other time, double-click PlusConfigurationTool.exe from the
Config folder of the setup files you downloaded when you installed the Plus
Pack on your GIFTS file server.

Note: The utility must be run from a GIFTS workstation with version 2 of the
Microsoft .NET Framework. If your network security policies do not allow
you to run .NET applications over your network, you need to install the
Config folder locally (on the workstation from which
PlusConfigurationTool.exe will be run).

Caution: 'The Plus Pack Configuration utility does not require an
administrative login. If you copy the utility to your network, be sure to copy
it to a location where only the GIFTS Administrator can open it. You can

About Security and the Configuration Utility



Setting Up Plus Pack Security

also use Windows security to deny the “execute” permission to
unauthorized users. For information about Windows security, please refer to
your Windows documentation.

Setting Up Batch Plus Security

To set up the menus and security for Batch Plus:

1 Open the Plus Pack Configuration utility, as described in “Accessing the
Configuration Utility” on page 2. The Plus Pack configuration options are

displayed.
2 In the Options list to the left, highlight Batch Plus. A list of Batch Plus
functions is displayed.
Plus Pack Executable Location |c:\giftsBD\G|FTSPIus\ Browse...
Options

o Select the functions that should appear in the GIFTS Flus menu for all users
Uszer Permissions

Group Permizsions Iv Update Contact Coding Sheets v Update Request Meeting Dates
=I- Requirements Plus

Uszer Permissions

Group Permissions ¥ Update Payment Cades W Update Request Staff
=I- Paymentz Plus

Uszer Permissions

Group Permissions
—I- Reminders Plus

Uszer Permissions

Group Permissions
—|- Taw Status Pluz

Uszer Permissions

Group Permissions
= Wwatchlists Plus

Uszer Permissions

Group Permissions

Iv Update Organization Coding Sheets v Update Request Project Descriptions

Iv Update Request Coding Sheets v Update Request Type/Status

3 Choose which of the functions should be displayed to Batch Plus users. If
a function is not selected, no users will have access to it.

4 Click the Group Permissions option for Batch Plus. A list of your GIFTS
user groups is displayed.

Options

-I- Batch Plus 0] Group Access Application
User Permizsions » 1 Admin

2 View Only Privileges |

=I- Requirements Plus
Uszer Permissions
Group Permissions

Setting Up Batch Plus Security 3



Setting Up Plus Pack Security

5 Click the Access Application checkbox for user groups that should have
access to Batch Plus. All users within the groups you select are granted
permission to use Batch Plus.

6 If there are any additional users who should have access to Batch Plus,
click the User Permissions option. A list of GIFTS users is displayed.

Options
= Batch Plus D Uszer Mame Access Application
g el ADMIN Admin

G.roup Permizzions » | BEN B . Basan 0

= Regirements Plus CHARITY  Charity Biall O
Uszer Permissions
Group Permissions Ch Celette Rogers O

= Paymerts Plus DAlSY Daizy Grant O
User Permissions HOFE Hope Charity |
Group Permissions KG Kelly Goldberg O

—I- Reminders Plus L Lee williamson O
User Permissions PHIL Phil &nthiopy O
Group Permissions 55 Sarah Sulivan O

—|- Taw Status Pluz B Teny Brawn 0

Uszer Permissions

Group Permissions
= Wwatchlists Plus

Uszer Permissions

Group Permissions

7 Click the Access Application checkbox for users who should have access
to Batch Plus. (If you have already granted access to a user's group, you
do not have to select his or her name to provide access.)

At this point, you can click OK to save your security settings or—if you want
to set up security for Requirements Plus, Payments Plus, Reminders Plus,
Tax Status Plus, Watchlists Plus, or Link Plus for use with Outlook—go to
“Setting Up Requirements Plus Security” on page 5 or “Setting Up Payments
Plus Security” on page 6, “Setting Up Reminders Plus Security” on page 8,
“Setting Up Tax Status Plus Security” on page 10, “Setting Up Watchlists
Plus Security” on page 14, or “Setting Up Link Plus Security” on page 19 to
continue using the configuration utility.

Setting Up Batch Plus Security



Setting Up Plus Pack Security

Setting Up Requirements Plus Security

To set up the menus and security for Requirements Plus:

1 Open the Plus Pack Configuration utility, as described in “Accessing the
Configuration Utility” on page 2. The Plus Pack configuration options are
displayed.

2 In the Options list to the left, highlight Requirements Plus. A list of
Requirements Plus functions is displayed.

Optiong

=l Batch Plus o Select the functions that should appear in the GIFTS
User Permizsions Flus! menu for all uzers
Group Permizsions

Bf M equirements Plus ¥ Create Request Requirements

Uzer Permiszions

Group Permizsions
= Payments Plus ¥ Delete Requirements in Batch

¥ Create Payment Bequirements

3 Choose which of the functions should be displayed to Requirements Plus
users. If a function is not selected, no users will have access to it.

4 Click the Group Permissions option for Requirements Plus. A list of your
GIFTS user groups is displayed.

Options

-I- Batch Plus 0] Group Access Application
User Permis.sio.ns » 1 Admin
Giraup Permissions 2 Yiews Only Privileges |

=I- Requirements Plus
Uszer Permissions

=I- Payments Pluz
Uszer Permissions
Group Permizzions

5 Clickthe Access Application checkbox for the user groups that should have
access to Requirements Plus. All users within the groups you select are
granted permission to use Requirements Plus.

Setting Up Requirements Plus Security 5



Setting Up Plus Pack Security

6 Ifthere are any additional users who should have access to Requirements
Plus, click the User Permissions option. A list of GIFT'S users is displayed.

Options

-I- Batch Plus 0] Usger Name Access Application
User Permis.sio.ns » | ADMIN Admin

R G_[DUD F'ternP1:ssmns BEM Ben E. Factor |

al Ll CHARITY  Charity Bal |
Group Permissions Ch Eoteteligners O

= Paymerts Plus Dalsy Draizy Grant O
User Permissions HOFE Hope Charity |
Group Permissions KG Kelly Goldberg O

= Reminders Plus L/ Lee Wiliamson |
User Permissions PHIL Phil &nthropy O
Group Permissions 55 Sarah Sullivan O

—|- Taw Status Pluz TE Termy Brown 0
Uszer Permissions Y
Group Permissions

7 Click the Access Application checkbox for users who should have access
to Requirements Plus. (Ifyou have already granted access to a user's group,
you do not have to select his or her name to provide access.)

At this point, you can click OK to save your security settings or—if you want
to set up security for Batch Plus, Payments Plus, Reminder Plus, Tax Status
Plus, Watchlists Plus, or Link Plus for use with Outlook—refer to “Setting
Up Batch Plus Security” on page 3 or “Setting Up Payments Plus Security”
on page 6, “Setting Up Reminders Plus Security” on page 8, “Setting Up Tax
Status Plus Security” on page 10, “Setting Up Watchlists Plus Security” on
page 14, or “Setting Up Link Plus Security” on page 19 to continue using the
configuration utility.

Setting Up Payments Plus Security

To set up the menus and security for Payments Plus:

1 Open the Plus Pack Configuration utility, as described in “Accessing the
Configuration Utility” on page 2. The Plus Pack configuration options are
displayed.

6 Setting Up Payments Plus Security



Setting Up Plus Pack Security

2 In the Options list to the left, open the Payments Plus options (if
necessary).

Options

—I- Batch Flus
User Permizsions
Group Permizzions

—I- Requirements Plus
User Permizsions
Group Permizzions

User Permizsions
Group Permizzions

3 Click the Group Permissions option for Payments Plus. A list of your
GIFTS user groups is displayed.

Options

-I- Batch Plus 0] Group Access Application
User Permis.sio.ns » 1 Admin
Giraup Permissions 2 Yiews Only Privileges |

=I- Requirements Plus
Uszer Permissions
Group Permissions
=I- Paymentz Plus
Uszer Permissions

Group Pen

—I- Reminders Plus
Uszer Permissions
Group Permissions

4 Click the Access Application checkbox for the user groups that should have
access to Payments Plus. All users within the groups you select are granted
permission to use Payments Plus.

5 Ifthere are any additional users who should have access to Payments Plus,
click the User Permissions option. A list of GIFTS users is displayed.

Options
-I- Batch Plus 0] Usger Name Access Application
User Permizsions » | ADMIN Admin
G.roup Permizzions BEN EBen E. Factor O
= Regirements Plus CHARITY  Charity Biall |
Uszer Permissions
Group Permissions Ch Eoteteligners O
= Paymerts Plus DalsY D aizy Grant O
HOFE Hope Charity |
Group Permissions KG Kelly Goldberg O
= Reminders Plus L/ Lee Wiliamson |
User Permissions PHIL Phil &nthropy O
Group Permissions 55 Sarah Sullivan O
- T Stalus F'Iu.s . TB Termy Brown O
Uszer Permissions
Group Permissions

Setting Up Payments Plus Security 7
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6 Click the Access Application checkbox for users who should have access
to Payments Plus. (If you have already granted access to a user's group,
you do not have to select his or her name to provide access.)

At this point, you can click OK to save your security settings or—if you want
to set up security for Batch Plus, Requirements Plus, Reminders Plus, Tax
Status Plus, Watchlists Plus, or Link Plus for use with Outlook—refer to
“Setting Up Batch Plus Security” on page 3 or “Setting Up Requirements
Plus Security” on page 5, “Setting Up Reminders Plus Security” on page 8,
“Setting Up Tax Status Plus Security” on page 10, “Setting Up Watchlists
Plus Security” on page 14, or “Setting Up Link Plus Security” on page 19 to
continue using the utility.

Up Reminders Plus Security

To set up the menus and security for Reminders Plus:

1 Open the Plus Pack Configuration utility, as described in “Accessing the
Configuration Utility” on page 2. The Plus Pack configuration options are
displayed.

2 In the Options list to the left, open the Reminders Plus options (if
necessary).

Optiong
—I- Batch Pluz
Uzer Permiszions
Group Permizsions
=1+ Requirements Plus
Uzer Permiszions
Group Permizsions
= Payments Fluz
Uzer Permiszions
Group Permizsions
BR Feninders Plus
Uzer Permiszions
Group Permizsions

Setting Up Reminders Plus Security



Setting Up Plus Pack Security

3 Click the Group Permissions option for Reminders Plus. A list of your
GIFTS user groups is displayed.

Options

-I- Batch Plus 0] Group Access Application
User Permis.sio.ns » 1 Admin
Giraup Permissions 2 Yiews Only Privileges |

=I- Requirements Plus
Uszer Permissions
Group Permissions

=I- Paymentz Plus
Uszer Permissions
Group Permissions

—I- Reminders Plus

Uszer Permissions

Group Permissi

—|- Taw Status Pluz
Uszer Permissions
Group Permissions

4 Click the Access Application checkbox for the user groups that should have
access to Reminders Plus. All users within the groups you select are
granted permission to use Reminders Plus.

5 Ifthere are any additional users who should have access to Reminders
Plus, click the User Permissions option. A list of GIFTS users is displayed.

Options
= Batch Plus D Uszer Mame Access Application
Uszer Permissions » | ADMIN Admin
G.roup Permizzions BEM B . Basan 0
= Regirements Plus CHARITY  Charity Biall O
Uszer Permissions
Group Permissions Ch Celette Rogers O
= Paymerts Plus DAlSY Daizy Grant O
User Permissions HOFE Hope Charity |
Group Permissions KG Kelly Goldberg O
=1 Reminders Plus L Lee Wwiliamzaon O
= B PHIL Phil Anthropy O
Group Permissions 55 Sarah Sulivan O
= Taw Status F'Iu.s . B Terry Brown O
Uszer Permissions
Group Permissions

6 Click the Access Application checkbox for users who should have access
to Reminders Plus. (If you have already granted access to a user's group,
you do not have to select his or her name to provide access.)

At this point, you can click OK to save your security settings or—if you want
to set up security for Batch Plus, Requirements Plus, Payments Plus, Tax
Status Plus, Watchlists Plus, or Link Plus for use with Outlook—refer to
“Setting Up Batch Plus Security” on page 3, “Setting Up Requirements Plus
Security” on page 5, “Setting Up Payments Plus Security” on page 6,

Setting Up Reminders Plus Security 9
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“Setting Up Tax Status Plus Security” on page 10, “Setting Up Watchlists
Plus Security” on page 14, or “Setting Up Link Plus Security” on page 19 to
continue using the utility.

Up Tax Status Plus Security

To set up the default selected tax status fields and security for Tax Status
Plus:

1 Open the Plus Pack Configuration utility, as described in “Accessing the

Configuration Utility” on page 2. The Plus Pack configuration options are
displayed.

2 In the Options list to the left, highlight Tax Status Plus. A list of default
selected Tax Status Plus fields are displayed.

Optioks

-BatchPlus Sedect the default Tax Status fields to cvenarite when you
Uzer Permizzions update an Organization following werification
Group Permizzions

—I- Requirements Plus [ Legal Name
User F'ermisrsio.ns W TaxlD
Group Permizzions

- Payments Plus [v FReqistration Date
User Permizsions W TawStatus
Group Permizzions

21 Reminders Flus v Taw Statuz Date

User Permizsions
Group Permizzions

<

Last Verification Date

<

Last Verification Mame

User Permizsions
Group Permizzions

<

Mewt Verification Date

<

Motes

3 Click the check box next to the tax status fields that will be selected by
default to overwrite current organization information when a user
updates an organization.

Note: The Web Service URL is a link to the MicroEdge web service that
retrieves information from MicroEdge’s Tax Exempt Organization
Database. Leave this field blank if you want to use MicroEdge’s default
Web Service URL.

Setting Up Tax Status Plus Security
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4 Click the Group Permissions option for Tax Status Plus. A list of your
GIFTS user groups is displayed.

Options

-I- Batch Plus 0] Group Access Application
User Permis.sio.ns » 1 Admin
Giraup Permissions 2 Yiews Only Privileges |

=I- Requirements Plus
Uszer Permissions
Group Permissions
=I- Paymentz Plus
Uszer Permissions
Group Permissions
—I- Reminders Plus
Uszer Permissions
Group Permissions
—|- Taw Status Pluz
Uszer Permissions
Group Permissi
= Wwatchlists Plus
Uszer Permissions
Group Permissions

5 Clickthe Access Application checkbox for the user groups that should have
access to Tax Status Plus. All users within the groups you select are granted
permission to use Tax Status Plus.

6 Ifthere are any additional users who should have access to Tax Status Plus,
click the User Permissions option. A list of GIFTS users is displayed.

Options
-I- Batch Plus 0] Usger Name Access Application
User Permizsions » | ADMIN Admin
G.roup Permizzions BEN EBen E. Factor O
= Regirements Plus CHARITY  Charity Biall |
Uszer Permissions
Group Permissions Ch Eoteteligners O
= Paymerts Plus Dalsy Draizy Grant O
User Permissions HOFE Hope Charity |
Group Permissions KG Kelly Goldberg O
= Reminders Plus L/ Lee Wiliamson |
User Permissions PHIL Phil &nthropy O
Group Permissions 55 Sarah Sullivan O
—I- Taw Status Plus TE Teny Browin 0
Group Permissions
= Wwatchlists Plus
Uszer Permissions
Group Permissions

7 Click the Access Application checkbox for users who should have access
to Tax Status Plus. (If you have already granted access to a user's group,
you do not have to select his or her name to provide access.)

Setting Up Tax Status Plus Security 11
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Entering Proxy Server Information for Tax Status
Plus

Since Tax Status Plus uses a web service to access information from
MicroEdge’s Tax Exempt Organization Database, you can enter proxy
server information in the Proxy Settings section of the Plus Pack
Configuration utility. This is only needed if your organization uses a proxy
server. This allows Tax Status Plus to retrieve this information using the web
service.

Tip: If your organization does not use a proxy server, you do not need to
complete this task.

Note: This is the same information that is located in the Preference’s tool’s
GIFTSConnections section in the GIFTS Administrator Module. Whatever
you enter here overwrites the information entered there.

To enter proxy server information:

1 Inthe Optionslist to the left, highlight Proxy Settings. Your proxy settings

display.
Plus Pack Executable Location |CAGIFTSSGIFTSPlush
Options
User Permissions ~

Fill i wour prowy server settings belaw.
Group Permissions

= Payments Plus
User Permissions
Group Permissions
= Reminders Plus
User Permissions
Group Permissions User Name | Admin
= Taw Status Plus
User Permissions
Group Permissions
= "Watchlists Plus Bz CORP
User Permissions

Prosg Server Mame or IP] 102036125

Part 8080

Password | wee

Group Permissions
= Link Plus
User Permissions
Group Permissions
Prowy Settings &

2 Enter the following information, if necessary:

Proxy Server (Name or IP): [URL or IP address of proxy server]
Port: [port on which proxy server is running]

Setting Up Tax Status Plus Security
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User Name: [Windows username that allows access to proxy server|
Password: [Windows password that allows access to proxy server|
Domain: [user domain]

Important: The Windows password you enter in the Password field will be
encrypted in the Preferences tool, unless it is the same as the current
password. If you want to use the same password as the one entered in the
Preferences tool, you must first delete it from the Preferences tool and enter
it here. If you do not, the web service will not be able to successfully connect
to the proxy server.

At this point, you can click OK to save your security settings or—if you want
to set up security for Batch Plus, Requirements Plus, Payments Plus,
Reminders Plus, Watchlists Plus, or Link Plus for use with Outlook—refer to
“Setting Up Batch Plus Security” on page 3, “Setting Up Requirements Plus
Security” on page 5, “Setting Up Payments Plus Security” on page 6,
“Setting Up Reminders Plus Security” on page 8, “Setting Up Watchlists Plus
Security” on page 14, or “Setting Up Link Plus Security” on page 19 to
continue using the utility.

Setting Up Tax Status Plus Security 13
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Setting Up Watchlists Plus Security

14

To set up the default Watchlists, threshold, and security for Watchlists Plus:

1 Open the Plus Pack Configuration utility, as described in “Accessing the
Configuration Utility” on page 2. The Plus Pack configuration options are
displayed.

2 In the Options list to the left, highlight Watchlists Plus. A list of default
selected Watchlists are displayed.

Plus Pack Executabls Loation [CAGIFTS\GIFTSPlush
Options
e Perm\s.sm.ns i, Select those lists that should be employed by Watchlists Plus
Group Permissions
= Payments Plus EPLS - Excluded Parties List System 3548, - Bureau OF Industry and S cur
User Pemissions QIG - HHS Office of Inspector Gener England - Bank Of England Sanction
Group Permissions Ewrope - European Union List
- Reminders Plus FEJEEFIE‘ h;iﬁ:;\;{;%ﬁias Enforceme
User Permissions INTERPOL - Irterriational Criminl P
Group Permissions OFAL - Dffice of Foreign Assets Cont)
= Tax Status Plus D5FI - Canadian List
User P _<< Remaove | |PEP_FO - Poliically Exposed Person
Gssr :rm\s.s\u.ns - TEL - Terrorist Exclusion List
foup Petmissions UMSL - United Nation Sanction List
= Watchlists Plus WENEK - World Bank Ineligible Firms
User Permissions
Group Permissions ki > L )
=/ Link Plus Threshold 0.95 |  webService Pazzword
User Permissions =
Group Permissions ‘web Service URL
Prauy Settings -

Note: As of September 14, 2007, the following Watchlists are included in
this list:

OFAC - Office of Foreign Assets Controls
BXA - Bureau of Industry and Securities
FBI - FBI Most Wanted

PEP_FO - Politically Exposed Persons
England - Bank of England Sanctions
OSFI - Canadian List

Europe - European Union List

UNSL - United Nations Sanctions List

Setting Up Watchlists Plus Security
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< WBNK - World Bank Ineligible Firms
% Interpol - International Criminal Police
% TEL - Terrorist Exclusion List

3 Ifyou do not want to include certain Watchlists when Watchlists Plus
performs a search, highlight one or more Watchlists from the right field,
and click Remove.

Note: To add a removed watchlist, highlight it in the left field and click
Include.

4 Edit the Threshold, if necessary.

Important: This field defines how close the record information from GIFTS
must match the information on a watchlist in order for a “hit”, or
acknowledgement of a matching record, to be registered in Watchlists
Plus. You can have a threshold between .75 and 1. If you use a high
threshold, such as .95 and above, information must be closely matched
for a hit to occur. If you use a lower threshold, information does not have
to be so closely matched for a hit to occur. Generally, a low threshold
returns more hits, and a high threshold returns fewer hits. The default
threshold is .95.

Note: The Web Service URL is a link to a web service, which provides the
Watchlists Plus functionality. The Web Service Password is the password
to this web service. Leave both of these fields blank, unless instructed
otherwise by MicroEdge.

Setting Up Watchlists Plus Security 15
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5 Click the Group Permissions option for Watchlists Plus. A list of your
GIFTS user groups is displayed.

Plus Pack Executable Location | C:AGIFTSSGIFTSPlus',

Options

User Pemissions

Group Permissions
Payments Plus

User Pemissions

Group Permissions
Reminders Plus

User Pemissions

Group Permissions
Tax Status Plus

User Pemissions

Group Permissions
Watchlists Plus

Lser Permissions

Link Plus
User Pemissions
Group Permissions
Proxy Settings

Brawse,

[ R

Group Access Application Update Activities
Administrator
View Only Privieges
Grants Officer
Grants Officer - MO EM
MG User

6 Clickthe Access Application checkbox for the user groups that should have
access to Watchlists Plus. Allusers within the groups you select are granted
permission to use Watchlists Plus.

Note: In order to keep compliance records accurate, it is important to
restrict the use of the utility to qualified members of your staff.

7 Click the Update Activities checkbox for the user groups that will be able
to mark Watchlists Plus Activities as false positives, or Done.

8 Ifthereare any additional users who should have access to Watchlists Plus,
click the User Permissions option. A list of GIFTS users is displayed.

Plus Pack Executable Location | C:AGIFTSAGIFTSPlush

Options

User Permissions

Group Permissions
Payments Plus

User Permissions

Group Permissions
Reminders Plus

User Permissions

Group Permissions
Tax Status Plus

User Permissions

Group Permissions
“Wwatchlists Plus
Uses 3
Group Permissions
Link Plus

User Permissions

Group Permissions
Proxy Settings

Browse,

D
» | ADMIN
BEN
BOARD
CHARITY
o]
DAISY
HOPE
K&
LW
MG LISER
PHIL
88
i

User Mame Access Application Update &ctivities
Admin .| .|
Ben E. Factor (.| (.|
z-Board Member .| .|
Charity Ball (.| (.|
Colette Rogers .| .|
Daisy Grant (.| (.|
Hape Charity .| .|
Kelly Goldberg (.| (.|
Lee ‘williamson .| .|
2 Matching GIFTS Use (.| (.|
Phil Anthropy .| .|
Sarah Sullivan (.| (.|
Terry Brawn .| .|
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9 Click the Access Application checkbox for users who should have access
to Watchlists Plus. (If you have already granted access to a user's group,
you do not have to select his or her name to provide access.)

10 Click the Update Activities checkbox for the users that will be able to mark
Watchlists Plus Activities as false positives, or Done.

Note: Users must also have the Update/Delete System Activities
permission in order to mark Watchlists Plus Activities as false positives.
For more information, please refer to the “Managing Permission Sets”
section in Chapter 4 of the GIFTS 6 Administrator’s Guide (Article #8773 in
the MicroEdge Solutions Knowledgebase).

Entering Proxy Server Information for Watchlists
Plus

Since Watchlists Plus uses a web service to access information, you can enter
proxy server information in the Proxy Settings section of the Plus Pack
Configuration utility. This allows Watchlists Plus to retrieve Watchlists
information using this web service. You do not need to repeat this task if you
have already performed it for Tax Status Plus.

'
Tip: If your organization does not use a proxy server, you do not need to

complete this task.

Note: This is the same information that is located in the Preference’s tool’s
GIFTSConnections section in the GIFTS Administrator Module. Whatever
you enter here overwrites the information entered there.

Setting Up Watchlists Plus Security 17
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To enter proxy server information:

1 Inthe Options list to the left, highlight Proxy Settings. Your proxy settings
display.
Plus Pack Eseculable Locaion |CAGIFTSAGIFTSPlus

Options
User Permissions ~
Group Permizsions
=1 Payments Plus
User Permissions
Group Permizsions
=) Reminders Plus
User Permissions
Group Permizsions User Name  |Admin
=) Tax Status Plus
User Permissions
Group Permizsions
=1 Wwatchlists Plus
User Permissions
Group Permizsions
= Link. Plug
User Permissions
Group Permizsions
Prosy Settings -

Fill in your prozy server seftings below.
Prowy Server [Mame or IP] - [10.20.35.125

Port | 8080

Pasoword | 9es]

Dromair CORP

2 Enter the following information, if necessary:

Proxy Server (Name or IP): [URL or IP address of proxy server]

Port: [port on which proxy server is running]

User Name: [Windows username that allows access to proxy server]
Password: [Windows password that allows access to proxy server]
Domain: [user domain]

Important: The Windows password you enter in the Password field will be
encrypted in the Preferences tool, unless it is the same as the current
password. If you want to use the same password as the one entered in the
Preferences tool, you must first delete it from the Preferences tool and enter
it here. If you do not, the web service will not be able to successfully connect
to the proxy server.

At this point, you can click OK to save your security settings or—if you want
to set up security for Batch Plus, Requirements Plus, Payments Plus,
Reminders Plus, Tax Status Plus, or Link Plus for use with Outlook—refer to
“Setting Up Batch Plus Security” on page 3, “Setting Up Requirements Plus
Security” on page 5, “Setting Up Payments Plus Security” on page 6,
“Setting Up Reminders Plus Security” on page 8, “Setting Up Tax Status Plus
Security” on page 10, or “Setting Up Link Plus Security” on page 19 to
continue using the utility.
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Setting Up Link Plus Security

To set up the security for Link Plus, including how email messages are
stored, how to treat existing Email Activities in GIFTS, where email
messages are to be stored, and whether or not to include email attachments
in GIFTS:

1 Open the Plus Pack Configuration utility, as described in “Accessing the
Configuration Utility” on page 2. The Plus Pack configuration options are

displayed.
2 In the Options list to the left, highlight Link Plus.
Plus Pack Exscutable Location | CAGIFT SYGIFTSPlush
Optians
User Pemissions ~

X Specify the settings far Link Plus below.
Group Permizsions

= Payments Plus
User Pemissions
Group Permizsions (%) Save messages in Activily Notes () Save messages as .msg files
= Reminders Flus
User Pemissions
Group Permizsions
- Taxusizlru;::zisssiuns Message/Attachment directory CHGIFTSAD ocument
Group Permizsions
= watchlists Flus
User Pemissions
Group Permizsions
= Link Flus
User Pemissions
Group Permizsions
Froxy Settings &

Message Storage

‘when linking to an existing Activity

Allove export of attachments

3 In the Message Storage section, select one of the following options:

< Save messages in Activity Notes: This radio button saves the body of
the Outlook email in the Long Notes section of the associated Mail
Activity.

< Save messages as .msg files: If you have Document Manager, this
radio button saves the Outlook message file (.msg) as a document
which is linked to the Mail Activity.

Note: This field only displays if you have the Document Manager.

Setting Up Link Plus Security 19
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4 In the When linking to an Existing Activity section, select one of the

following options. These options determine how existing Mail Activities
in GIFTS will be handled.

< Overwrite (existing Activity will be deleted): The existing Mail
Activity (and associated .msg file), as well as any External Document
attachments will be overwritten with the new Outlook email.

% Create new (existing Activity will remain): The existing Mail Activity
(and associated .msg file), as well as any External Document
attachments will not be overwritten with the new Outlook email.

< Ask user (user chooses to delete existing or not): The user can choose
whether or not to delete the existing Mail Activity (and associated
.msg file), as well as any External Document attachments.

In the Message / Attachment directory section, click the Browse button to
change the location where email attachments and Outlook message files
(.msg) are stored.

Note: The default location for this field is pulled from the Document path
field of the GIFTS External Preferences. Since this is a global setting for all
Link Plus users, this must be a location that all users can access. For more
information about GIFTS External Preferences, see “External
Preferences” on page 66 of the GIFTS Administrators Guide.

Note: This field only displays if you have the Document Manager.

Select the Allow export of attachments checkbox if you want users to have
the option of creating separate External Document Activities for any email
attachments when linking an Outlook email. If you deselect this checkbox,
users will not have this option, and no email attachments will be imported
into GIFTS when linking an Outlook email.

Note: This field does not display if you do not have the Document
Manager.
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7 Click the Group Permissions option for Link Plus. A list of your GIFTS

user groups is displayed.
Plus Pack Executable Location | C:AGIFTSAGIFT SPlush

Options

Browize

User Permissions ~ I}

Group Permissions v
= Payrments Plus

Uszer Permissions

Group Permissions
= Reminders Plus

Uszer Permissions

Group Permissions
= Tax Status Plus

Uszer Permissions

Group Permissions
= W/ atchlists Plus

Uszer Permissions

Group Permissions
= Link Phas
U zer Permissions

M =W =

[ =

Proxy Settings 2

Group
Adrniniztrator
iew Only Privieges
Grants Officer
Grants Officer - NO EMPLOYEE Gl
MG User

Access Application

8 Clickthe Access Application checkbox for the user groups that should have
access to Link Plus. All users within the groups you select are granted

permission to use Link Plus.

Note: In order to keep compliance records accurate, it is important to
restrict the use of the utility to qualified members of your staff.

9 Ifthere are any additional users who should have access to Link Plus, click
the User Permissions option. A list of GIFTS users is displayed.

Pluz Pack Executable Location | C:AGIFTSAGIFTSPIush

Brovese:

Options

User Pemmissions » s}
Group Perizsions ¥ | ADMIN

=I- Payments Plus BEN
Uzer Permls.sm.ns B04RD
Group Permizzions

=I- Reminders Plus EHARITY
Uzer Permizsions ER
Group Perizsions DAISY

=I- Tax Status Plus HOPE
Uszer Pemissions K&
Group Pemissions L

= Watchlists Flus MG USER
Uzer Permls.sm.ns FHIL
Group Permizzions

= Link Plus 8§

TE
Group Permizzions
Prosy Settings 7

Setting Up Link Plus Security

User Name
Admin
Ben E. Factor
z-Board Member
Charity Ball
Colette Rogers
Draisy Grant
Hope Charity
Kelly Goldberg
Lee Williamson
z- Matching GIFTS User
Phil &nthropy
Sarah Sullvan
Terry Brown

Aecess Application

HEFEEEEREREEEE
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10 Click the Access Application checkbox for users who should have access
to Link Plus. (If you have already granted access to a user's group, you do
not have to select his or her name to provide access.)

Setting Up Link Plus Security
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This chapter provides an overview of Batch Plus features and
describes how to update batches of records with the Batch Plus
utility.
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Using Batch Plus

About Batch Plus

Batch Plus allows you to update the following types of data for numerous
database records in a single step:

< Coding Sheets - You can modify, add, or remove codes for Organization,
Contact, Payment, and Request records.

< Request Staff Assignments - You can assign a batch of Requests to a
member of your staff, or change the staff assignment for a batch of
Requests.

< Request Types - You can change the Request Type and Request Status
codes for a batch of GIFTS Requests.

< Project Descriptions - You can overwrite the Project Description for
selected Requests, or add text to the beginning or end of each Project
Description.

< Meeting Dates - You can update the Meeting Date for batches of GIFTS
Requests.

< Payment Information - You can modify the Fund, GL Account, Type,
and Support Type for batches of GIFTS Payments.

Note: Your Administrator can set up Batch Plus to prevent the use of some of
these features; not all of these options may be available on your system. In
addition, all GIFTS security permissions apply to operations that you
perform with Batch Plus. If you do not have permission to make a change in
GIFTS, you also cannot make that change with Batch Plus.

Updating Coding Sheets
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With Batch Plus, you can update the Coding Sheets of your Organization,
Contact, Payment, and Request records. You can:

< Add, remove, or replace codes

< Change secondary codes to primary codes

About Batch Plus
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Before You Begin: MicroEdge strongly recommends that you thoroughly plan
any changes to your coding structure in advance. The changes you make to
the database are permanent, and cannot be undone. Make sure that you
have a current and valid backup of your database before proceeding. For
information about planning code replacements, please refer to the
“Replacing Codes” section in Chapter 2 of the GIFTS Administrator’s Guide
(also available as Article 8817 in the Solutions Knowledgebase).

To modify the Coding Sheet for a batch of Requests, Organizations,
Contacts, or Payments:

1 Inthe GIFTS Organizer, select the records you want to update. (To select
a group of records in the Organizer, hold down the SHIFT or CTRL key
as you click on records.)

2 From the Main menu, select GIFTS Plus » Update » Coding Sheetif you
are in the Requests folder, or GIFTS Plus » Update Coding if you are in
the Organizations or Contacts folder. The options for updating Coding
Sheets are displayed.

x

Hows will you be updating the coding sheet?
% Add acode " Remaove a code
[~ &dd az Primary I™ | Include &l subcodes

¢~ Make an existing code " Replace a code
primary

Code Table

| =
Code

| i
Fieplacement Code

| i

Urﬂg‘:\fe | Cancel |

4
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3 Choose an option:

To add a new code: select Add a code. If you would like to make the new
code the primary code, select the option to Add as Primary; any pre-
existing primary codes will become secondary codes.

% Add acode
V' Add as Primary
To make an existing code a primary code: Select Make an existing code
primary.

+ Make an existing code
primary

To replace a code: Select Replace a code.

' Replace a code

To remove a code: select Remove a code. If you are removing a code from
a table with multiple levels, you can select Include all subcodes to remove
all codes below the code that you specify.

& Femove a cods
¥ Include all subcodes

Example: You are updating the Program Area codes for three records. They
are coded as Culture/Performing Arts/Music, Culture/Performing Arts/
Theater, and Culture/Performing Arts.

If you choose to remove the Culture/Performing Arts code and do not
select the option to Include all subcodes, only the Culture/Performing
Arts code for the last record is removed because it is the only exact match.
The codes for Music and Theater are not removed. If you do select the
option to Include all subcodes, then the Performing Arts codes for all three
records are removed.

In the Code Table field, select the Code Table that you want to modify.

Code Table
IAge Group j

In the Code field, select the code you want to add, change, or remove.

Code
| Children (513) =

If you are replacing a code, select a replacement code in the Replacement
Code field. Otherwise, this field is not available.

Updating Coding Sheets
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7 Click the Update Now button. Batch Plus displays a list of the records that
will be updated, and prompts for confirmation that you wish to continue.

x

You have chozen to add the code Children [B-13] to the following Requests:

Grantee Organization Froject Title

Foundation far

Children

Adventure Club of Manhattan — Summer Wilderness Survival
Program - for teens

275 Arlington School of Dentistry Funding for new instruments

A04 Advenbrs Clib of b anbatt, The sunnort of "8 dwsnbirs for

There is no undo for this process, so it is strongly recommended that vou have
a current backup of your database.

Do you wish to continue?

8 Click Yes to continue. Batch Plus displays a log of the processing results
and a confirmation message, which gives you the option of making more
changes to the records you selected.

9 Inresponse to the confirmation message, click Yes if you want to make
additional changes to the records you selected in the Organizer, or No to
view a log of the changes made to your data.

You can click Print Log or Save Log to print or save a copy of the log. When
you are finished reviewing the log, click Close to end your Batch Plus
session.

Updating Request Staff Assignments

You can change the Staff member assigned to a group of Requests, and also
update the To-Do Activities and Requirements associated with those
Requests.

Updating Request Staff Assignments 27
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Before You Begin: The changes you make to the database are permanent, and
cannot be undone. Make sure that you have a current and valid backup of
your database before proceeding.

To update the Staff member assigned to a batch of Requests:

1 Inthe GIFTS Organizer, select the Requests that you want to update. (To
select a group of records in the Organizer, hold down the SHIFT or CTRL
key as you click on records.)

2 From the Main menu, select GIFTS Plus » Update » Staff. The options
for updating staff assignments are displayed.

% Update Request Staff =
Change Stef to: | |

Update To-do Activities/Requirements
¥ | Open (not dore]

| Gverdue ¥ | Future
I~ | Clased (done]

Urﬂg‘:\fe | Cancel |

3 In the Staff field, select the member of your staff to whom the records
should be assigned.

Note: Staff members are listed alphabetically.

4 Select Update To-Do Activities/ Requirements to update the To-Do
Activities and Requirements associated with the Request so that they are
the responsibility of the new staff member.

Note: Only the Activities and Requirements assigned to the Request’s
current staff member are updated; items assigned to other staff members
are not changed.

e

< Select Open (not done) to update Open Activities and Requirements.
Check Overdue to update items that are overdue, and Future to
update items that are due in the future (including the current day’s
items).

% Select Closed (done) to update closed Activities and Requirements so
that they are shown in GIFTS as being the responsibility of the new

Updating Request Staff Assignments
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staff member; GIFTS will not change the name of the staff member
who marked the Activity as Done.

5 Click the Update Now button. Batch Plus displays a list of the records that
will be updated, and prompts for confirmation that you wish to continue.

6 Click Yes to continue. Batch Plus displays a log of the processing results
and a confirmation message.

7 Click OK to close the confirmation message. The process log remains
open.

8 You can click Print Log or Save Log to print or save a copy of the results
log. When you are finished reviewing the log, click Close to end your
Batch Plus session.

Updating Request Type and Request Status

Before You Begin: The changes you make to the database are permanent, and
cannot be undone. Make sure that you have a current and valid backup of
your database before proceeding.

To change the Request Type and/or Status assigned to a group of Requests:

1 Inthe GIFTS Organizer, select the Requests that you want to update. (To
selecta group of records in the Organizer, hold down the SHIFT or CTRL
key as you click on records.)

2 From the Main menu, select GIFTS Plus » Update » Request Type/
Status. The options for updating are displayed.

# Update Request Type/Status - |EI|1|
Fequest Type
I jv

Status

Urﬂg‘:\fe | Cancel |
&

3 Inthe Request Type field, select the Request Type that you would like to
apply to the Requests.
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4 In the Status field, select the Request Status that you would like to apply
to the Requests. Note that only the Statuses for the Request Type you
chose in Step 3 are available.

5 Click the Update Now button. Batch Plus displays a list of the records that
will be updated, and prompts for confirmation that you wish to continue.

6 Click Yes to continue. Batch Plus displays a log of the processing results
and a confirmation message.

Update Complete =

2 Requests were updated successfully, To see these changes in GIFTS, select Edit- =Refresh to update the display of records
in the GIFTS Organizer.
1 record could not be updated, Please refer to the process monitor For details,

7 Click OK to close the confirmation message. The process log remains
open.
=

Update complete

p | Update Request Type/Status to Cash Grants/Considered for Board

1. Error occurred while updating Request [366.01] Considered for Save Log

Board iz not a valid Status for Approved Reguests.

2 of 3 Requests updated successhully. Bt Lem

Cloze

i

Example: In the log shown here, an Approved Request was not updated
because the Request Status selected was valid only for Pending Requests.

8 You can click Print Log or Save Log to print or save a copy of the results
log. When you are finished reviewing the log, click Close to end your
Batch Plus session.
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Updating Project Descriptions

Before You Begin: The changes you make to the database are permanent, and
cannot be undone. Make sure that you have a current and valid backup of
your database before proceeding.

To change the Project Description assigned to a group of Requests:

1 Inthe GIFTS Organizer, select the Requests that you want to update. (To
select a group of records in the Organizer, hold down the SHIFT or CTRL
key as you click on records.)

2 From the Main menu, select GIFTS Plus » Update » Project Description.
The options for updating are displayed.

# Update Project Description ﬂ

7 Clear current value
' Update curent value

" Replace with text below

' Append text Im the current value
separated by a IBlank Line vl

|

Urﬂg‘:\fe | Cancel |

3 Select the options for updating or clearing the Project Descriptions for the
Requests you selected:

% To clear the Project Description for the Requests, select the Clear
current value option.

< To replace the existing Project Description text with new text, select
the Update current value option and then the Replace with text
below option. Enter the new text in the field.
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< To append text to the beginning or end of the existing Project
Descriptions without clearing the existing text, select the options to
append text either above (before) or below (after) the existing text.
You can specify whether the new and existing text are separated by a

blank line, carriage return, space, or tab. Then enter the new text in
the field.

Click the Update Now button. Batch Plus displays a list of the records that
will be updated, and prompts for confirmation that you wish to continue.

Click Yes to continue. Batch Plus displays a log of the processing results
and a confirmation message.

Click OK to close the message. The process log remains open.

You can click Print Log or Save Log to print or save a copy of the results
log. When you are finished reviewing the log, click Close to end your
Batch Plus session.

Updating Meeting Dates
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Before You Begin: The changes you make to the database are permanent, and
cannot be undone. Make sure that you have a current and valid backup of
your database before proceeding.

To change the Meeting Date assigned to a group of Requests:

1

In the GIFTS Organizer, select the Requests that you want to update. (T'o
select a group of records in the Organizer, hold down the SHIFT or CTRL
key as you click on records.)

From the Main menu, select GIFTS Plus » Update » Meeting Date. The
options for updating are displayed.

% Update Meeting Date =

" Clear Mesting Date

' Update Meeting Date to IE.-"24.-"2DDS 'l

Urﬂg‘:\fe | Cancel |

Specify the changes you would like to make:

Updating Meeting Dates
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% 'To clear the Meeting Date for all of the selected Requests, select the
Clear Meeting Date option.

< To update the Meeting Date for all of the selected Requests, select the
Update Meeting Date option and enter the new Meeting Date for the
Requests.

4 Click the Update Now button. Batch Plus displays a list of the records that
will be updated, and prompts for confirmation that you wish to continue.

5 Click Yes to continue. Batch Plus displays a log of the processing results
and a confirmation message.

6 Click OK to close the message. The process log remains open.

7 You can click Print Log or Save Log to print or save a copy of the results
log. When you are finished reviewing the log, click Close to end your
Batch Plus session.

Updating Payment Information

Before You Begin: The changes you make to the database are permanent, and
cannot be undone. Make sure that you have a current and valid backup of
your database before proceeding.

With Batch Plus, you can update the Fund, G/L Account, Payment Type,
and Support Type codes for batches of Payments. To update these codes:

1 Inthe GIFTS Organizer, select the Payments that you want to update. (To
selecta group of records in the Organizer, hold down the SHIFT or CTRL,
key as you click on records.)
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2 From the Main menu, select GIFTS Plus » Update Codes. The options
for updating codes are displayed.

i

Code Table
Fund -

Code
Uﬁgﬁe | Eancell
&

|<N0ne>
3 In the Code Table field, select the code that you would like to change.

4 In the Code field, select the new code for the Payments. If you want to

clear the codes, select <None>.

5 Click the Update Now button. Batch Plus displays a list of the records that

will be updated, and prompts for confirmation that you wish to continue.

6 Click Yes to continue. Batch Plus displays a log of the processing results
and a confirmation message.

7 Click OK to close the message. The process log remains open.

8 You can click Print Log or Save Log to print or save a copy of the results

log. When you are finished reviewing the log, click Close to end your
Batch Plus session.

Updating Payment Information
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This chapter describes how to use Requirements Plus to create or
delete batches of Requirements for your Requests and Payments.

In This Chapter
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Creating Batches of Payment Requirements ...............c.c..... 38
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About Requirements Plus

Requirements Plus allows you to update the following types of data for
numerous database records in a single step:

% Schedule Requirements: Schedule requirements for multiple records, at
any stage of your workflow. This flexible requirement-scheduling tool
allows you to schedule requirements for groups of Request and Payment
records that you can select based upon a fixed or relative date, Project start
dates or end dates, Payment Schedule Date, Paid Date, or other relevant
dates.

< Automatically schedule payment contingencies: For groups of records,
you can schedule Payment Requirements and make the payments
contingent on completion of those requirements.

< Delete requirements: You can maintain the integrity of your data and
more effectively manage staff resources by deleting groups of
requirements that are no longer valid.

Note: Your Administrator can set up Requirements Plus to prevent the use of
some of these features; not all of these options may be available on your
system. In addition, all GIFTS security permissions apply to operations that
you perform with Requirements Plus. If you do not have permission to make
a change in GIFTS, you also cannot make that change with Requirements
Plus.

Creating Batches of Grant Requirements

36

Before You Begin: The changes you make to the database are permanent, and
cannot be undone. Make sure that you have a current and valid backup of
your database before proceeding.

To create Grant Requirements for a batch of Requests:

1 Inthe Requests folder of the GIFTS Organizer, select the records that you
want to update. (To select a group of records in the Organizer, hold down
the SHIFT or CTRL key as you click on records.)
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2 From the Main menu, select GIFTS Plus » Create Requirements. The
options for creating Grant Requirements are displayed.

ﬂ Create Request Requirements ﬂ
 Mew Reguirement Options ——————— o
Type ‘ Schedule Date ‘ s
Type ITax Exermption Letter ﬂ weekends
" Dueon | 9/10/2008 x
Add |
& Due = |Da.v[S] 'I nd

= After " Before

Dizposition Date vl Hemove |

V¥ Adjust for weekends

C
Firiish Cancel

In the Type field, select the type of Requirement you would like to add.

4 Specify the date on which the Requirements will be due. You can choose
a specific date, or a date relative to the workflow of each Request.

Example: If you are setting up requirements for final reports, you can
specify that they be due 30 days after the Project End Date. GIFTS sets the
due dates based on the Project End Date of each Request.

5 Ifyou specified a relative date and you do not want any requirements to
be due on a weekend, select the Adjust for weekends option.

Example: If the 30th day after the End Date of a project falls on a Saturday,
GIFTS will move the due date to the preceding Friday. If it falls on a
Sunday, GIFTS will move it to the following Monday.

6 Click Add to create the Requirement. It is displayed in the grid.
=

[ New Reguirement Options

Adjust for
‘wieekends

Type Schedule Date

e IF'”a‘HEDWt j [§ Final Repoit 30 roject End Date
" Dueon | 8/10/2005 'I
Gow [ a= el 7]
& After " Befare
W Remove

I adijust for weekends

1] | |

Finish | Cancel |
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7 Repeat Steps 3-6 to add any additional Requirements for the Requests.

Note: If you decide not to create one of the Requirements in the grid, you
can highlight it and click Remove.

8 Click the Finish button. Requirements Plus displays a list of the
Requirements that will be created, and prompts for confirmation that you
wish to continue.

9 Click Yes to continue. Requirements Plus displays a log of the processing
results and a confirmation message

10 Click OK to close the confirmation message. The process log remains
open.

11 You can click Print Log or Save Log to print or save a copy of the results
log. When you are finished reviewing the log, click Close to end your
Requirements Plus session.

Creating Batches of Payment
Requirements

Before You Begin: The changes you make to the database are permanent, and
cannot be undone. Make sure that you have a current and valid backup of
your database before proceeding.

When you create Requirements for your Payments, you have the option of
making the Payments contingent upon the completion of their
Requirements. Contingent Payments cannot be made until their contingent
Requirements have been marked as Done in GIFTS.

To create Requirements for a batch of Payments:

1 Inthe Paymentsfolder of the GIFTS Organizer, select the records that you
want to update. (To select a group of records in the Organizer, hold down
the SHIFT or CTRL key as you click on records.)
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2 From the Main menu, select GIFTS Plus » Create Requirements. The
options for creating Payment Requirements are displayed.

# Create Payment Requirements 5[

—Mew Requirement Options

Adjust far
Weekends

Tupe Schedule Date ‘ Contingency
Type ICha\Ienge j

£ Duson [ 87072005
tdd
& | = =~

' After ™ Before

Paid Date - Femoyve

v Adjust for weekends

[~ Mark Payments as Contingent

Fitiish Cancel

In the Type field, select the type of Requirement you would like to add.

4 Specify the date on which the Requirements will be due. You can choose
a specific date, or a date relative to the workflow of each Payment.

Example: If you are setting up requirements for signed contracts, you can
specify that they be due 21 days before each Payment’s Schedule Date.
GIFTS sets the due dates based on the Schedule Date of each Payment.

5 Ifyou specified a relative date and you do not want any requirements to
be due on a weekend, select the Adjust for weekends option.

Example: If the 21st day before a Payment’s Schedule Date falls on a
Saturday, GIFTS will move the due date to the preceding Friday. If it falls
on a Sunday, GIFTS will move it to the following Monday.

6 Select the Mark Payments as Contingent option if you want to ensure that
the Payment will not be Paid until the Requirements have been marked
as Done.
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7 Click Add to create the Requirement. It is displayed in the grid.

10

11

12

[ Mew Reguirement Options

Type ISlgnsd Contract j

€ Dueon | 9410/2005
& Due o [paysl =]

 After * Befare

Schedule Date VI

W Adiust for weekends

v Mark Payments & Contingent

Add b

Remove

H

Schedule Date Contingency @gtﬁ;ﬂs

Finish Cancel

Repeat Steps 3-7 to add any additional Requirements for the Payments.

Note: If you decide not to create one of the Requirements in the grid, you
can highlight it and click Remove.

Click the Finish button. Requirements Plus displays a list of the
Requirements that will be created, and prompts for confirmation that you

wish to continue.

Click Yes to continue. Requirements Plus displays a log of the processing
results and a confirmation message

Click OK to close the confirmation message. The process log remains

open.

You can click Print Log or Save Log to print or save a copy of the results

log. When you are finished reviewing the log, click Close to end your
Requirements Plus session.

Creating Batches of Payment Requirements
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Deleting Batches of Requirements

Before You Begin: The changes you make to the database are permanent, and
cannot be undone. Make sure that you have a current and valid backup of
your database before proceeding.

To delete a batch of Grant Requirements or Payment Requirements:

1 Inthe Requirements folder of the GIFTS Organizer, select the records that
you want to update. (To select a group of records in the Organizer, hold
down the SHIFT or CTRL key as you click on records.)

2 From the Main menu, select GIFTS Plus » Delete Requirements. GIFTS
prompts for confirmation that you wish to continue.

Confirm Deletion of Requirements =]
‘fou have chosen to delete 3 Requirements, There is no undo For this operation,
Are you cerkain that you wish to proceed?

fes Mo |

3 Click Yes to continue. Requirements Plus displays a log of the processing
results and a confirmation message

4 Click OK to close the confirmation message. The process log remains
open.

5 You can click Print Log or Save Log to print or save a copy of the results
log. When you are finished reviewing the log, click Close to end your
Requirements Plus session.
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Payments Plus

This chapter describes how to use Payments Plus to create or modify
payment schedules for GIFTS Requests.

In This Chapter
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Scheduling Payments for a Batch of Requests ...............c....... 48
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About Payments Plus

The standard GIFTS software provides options for automatically creating a
payment schedule for a Request during the Approval process. Payments Plus
enhances your ability to create and modify payment schedules with the
following features:

44

e
o

On-demand Schedule Creation: You can create payment schedules for
Pending and Approved Requests at any time (provided that no payments
have already been created), not just during the Approval process.

Updating Existing Schedules: You can modify the payment schedule for
a Request from a single screen. This saves keystrokes, and as you're
working you can see how the changes you make affect the total amount
scheduled.

ﬂ Modify Payment Schedule B3

Request [480] -- $25.000.00 (project ta rn from B41/2006 to 6/1/2007)

The grid below shows those Payments that curently exist for this Request. Make any desiied changes to schedule dates
or amaunts, then click Finish to complete the update.

| Budget Resolution
No_ rezolution needed: Budget vear does not

e

# | Status |Schedu|aDale F Amount |

1 Schedued {05/01/2006 2006 $10,00000 40
2 Scheduled D8/01/3006 T+[2008  ¢5.000.00 20
3 Scheduled 11/01/2006 2006 $5.000.00 20
4 Scheduled 02/01/2007 2007 $5,000.00 20

=

»

=

Mo resalution needed: Budget Year does not

=

No_ rezolution needed: Budget vear does not

=

laa]a]«

Mo resalution needed: Budget Year does not

Payment Schedule Total : $25,000.00 [100.0% of grant amourt] E | Cancel |

Batch Processing: You can create payment schedules for batches of
Requests.

Greater Flexibility When Creating Schedules: Many of the defaults and
restrictions that apply when scheduling payments in GIFTS do not apply
to Payments Plus. For example, you can divide different percentages of
the grant amount among payments, schedule payments outside of the
Start Date or End Date of a grant, and specify whether payments that fall
on a weekend are moved to a weekday.

Note: GIFTS security permissions—as well as branch restrictions, if your
organization has branch security—apply to operations that you perform with
Payments Plus. If you do not have permission to make a change in GIFTS,
you also cannot make that change with Payments Plus.

About Payments Plus
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Creating a Payment Schedule for a Request

To create a payment schedule for a Pending or Approved Request:
1 In the Requests folder of the GIFTS Organizer, select the Request.

2 From the Main menu, select GIFTS Plus » Create/Update Payments. The
options for creating a payment schedule are displayed.

ﬁ Step 1 - Select Schedule Options x|
Request [481] - $40,000.00 [project to win from 74242006 ta 7/2/2007)
# of Payment(s) |4 3: V' Adjust schedule dates for weekends
¥ Round payment amounts to nearest whole number
Scheduls Every |3 ﬁ IMonth[s] j
Default Codes
TstPayment Date & on " after Payment Type IEharltahIe Contribution j

|Project Star Date (7/2/2008) x|

G/L Account |<Nnne specified: j

Mext -» | Cancel |

3 Select the number of Payments you wish to schedule and the interval
between each payment (in days, weeks, months, or years).

4 From the list of dates, specify the date that will be used as the basis for
scheduling the first Payment. Your options for choosing a date vary
according to the Disposition of the Request and by the available data.

Examples: The Approval Date and Project End Date are only available for
Approved Requests. Likewise, the Request’s Meeting Date is provided as
an option only when one has been specified for that Request.

5 Select whether the first Payment falls “on” or “after” the date you chose
in the preceding step.

Example: If the Payments are scheduled every three months and you choose
to start the Payments “after” the Project Start Date, the first Payment will
be scheduled three months after the Start Date.

6 Ifyou do not want any Payments to be scheduled on a weekend, select
the “Adjust schedule dates for weekends” option.
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Example: If a Payment’s date falls on a Saturday, GIFTS will move it’s
schedule date to the preceding Friday. If it falls on a Sunday, GIFTS will
move it to the following Monday.

7 Select the “Round payment amounts to nearest whole number” option if
you want to ensure that all of your Payments are made in whole
numbers—even as you edit payment amounts based on percentages.

8 Select the default Payment Type and General Ledger Account codes to be
applied to all of the Payments.

9 Click Next. You are prompted to review and modify the payment

schedule:

Request [481] -- $40,000.00 (project to run from 7/2/2006 to 7/2/2007)

The grid below shows those Payments that will be created for this Request. Make any desired changes to schedule dates
or amaunts, then click Finish to complete Payment creation.

Schedule Date P | Amount | % | Budget Resolution
07/03/2006 | 2006  $10,000.00 25% <Select a Reserve Fund/Ling [bemy
1040242006 ~| 2006 $10.00000 25% <5Select a Reserve Fund/Line |bems
01./02/2007 T+ 2007 $10,000.00 25% Mo resalution needed: Budget Year does not exist
04/02/2007 ~| 2007 $10.000.00 25% Mo resolution needed: Budoet Year does not exist
| bl
Payment Schedule Total: $40,000.00 (100.00% of grant amaunt] < Back I - | Carcel

% You can edit the Schedule Date, Fiscal Year (FY), or amount of the
scheduled Payments. Note that you can change the amount of the
Payments by either editing their amounts or their percentages. As
you change amounts, the Payment Schedule Total at the bottom of
the window is updated to reflect the changes you make.

< If you have the optional Budget Module, you may be required to
resolve the Payments against your Budget. You can resolve the
Payments against line items for the grantee organization or from a
reserve fund. To resolve a Payment, click the icon at the right edge of
the Budget Resolution column and choose a Budget item.

Budget Rezolution |

<Select a Reserve Fund/Line Item:
<5elect a Reserve Fund/Line Item: o
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For more information about the conditions under which Payments
must be resolved, please refer to the “When Payments Need to be
Resolved” section of the Budget Module User’s Guide.

10 Click Finish. If the payment creation is successful, a confirmation message
is displayed after the GIFTS Payment records are created. If any of the
Payments cannot be created, the entire process is cancelled and a message
explaining the cause of the cancellation is displayed.

11 Click OK to close the confirmation message.

If the process ran successfully, the payment schedule for the Request has
been created. You can make further changes by either editing the Payments
individually in GIFTS, or by using Payments Plus to re-open the Request’s
payment schedule, as described in the next section.

Modifying the Payment Schedule for a Request

To modify the dates, amount, or resolution of payments for a Pending or

Approved Request:
1 In the Requests folder of the GIFTS Organizer, select the Request.

2 From the Main menu, select GIFTS Plus » Create/ Update Payments. The
Request’s payment schedule is displayed.

4§ Modify Payment 5 chedule

Request [481] - $40,000.00 [project to wn from 74242006 ta 7/2/2007)

The grid below shows those Payments that currently exist for this Fequest. Make any desired changes to schedule dates
or amounts, then click Finish to complete the update

I3

| Budget Rezolution
Community Reserve [$42,500.01)
Community Reserve [$42,500.01)
No_ resalution needed: Budget Year does nat

No_ rezolution needed: Budget Vear does not

it | Status |ScheduIaDale Fr Arnount
1 Pad O7/03/2006 || 2006 § 410,000 001

2 Schedued 10/02/2005 |+|2006 §
3 Schedued 01/02/2007 [-[2007 1000000
4 Schedued 04/02/2007 |+|2007  $10,000.00

ra
o]
by

»

ra
5
by

ra
]
by

Lalalals

ra
5
by

Payment Schedule Total :  $40.000.00 (100.00% of grant amotmt] Bl | Cancel |

Note: Voided and Cancelled Payments are not displayed.
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You may edit the Schedule Date, Fiscal Year (FY), Amount, and Budget
Resolution of the Payments. Note that some data may be read-only
(“grayed out”) if any of the following restrictions apply:

% You cannot edit the Schedule Date or Amount for Paid or Refunded
Payments.

< Your GIFTS security permissions may prevent you from changing the
Fiscal Year assigned to Payments.

< If you have the Budget Module, you cannot edit Payments resolved
against a Closed Budget Year or against line items that you do not
have permission to access.

Click Finish. If the payment modification is successful, a confirmation
message is displayed after the Payments are updated. If any of the
Payments cannot be updated, the entire processis cancelled and a message
explaining the cause of the cancellation is displayed.

Click OK to close the confirmation message.

If the process ran successfully, the payment schedule for the Request has
been updated.

Scheduling Payments for a Batch of Requests

48

To create a payment schedule for a batch of Pending or Approved Requests:

1

In the Requests folder of the GIFTS Organizer, select the Requests. You
can select a mix of Pending and Approved Requests, aslongas your GIFTS
permissions allow you edit all of the Requests that you select.

Tip: To select a group of Requests in the Organizer, hold down the SHIFT
or CTRL key as you click on them.

Scheduling Payments for a Batch of Requests



Using Payments Plus

2 From the Main menu, select GIFTS Plus » Create/ Update Payments. The
options for creating a payment schedule are displayed.

ﬁ Step 1 - Select Schedule Options

Generate schedule of Papments for selected Requests

# of Payment(s] F 3: ¥ Adjust scheduls dates for weskends

¥ Round papment amaunts to nearest whols number

Schedule Eveny |4 ﬁ IW'eek[s] j

Default Codes

1stPayment Date " on % after Payrment Type |Charitab\etontribution j

I Digpogition D ate j

G/L Account |<None specifieds j

Next > | Cancel |

3 Select the number of payments you wish to schedule and the interval
between each Payment (in days, weeks, months, or years).

4 From the list of dates, specify the date that will be used as the basis for
scheduling the first Payment. Be sure to choose a date that is valid for all
of the Requests you selected.

Example: If you select Meeting Date and a Request in the batch does not
have a Meeting Date, Payments Plus will not create Payments for that
Request because there is no date on which to base the payment schedule.

5 Select whether the first Payment for each Request falls “on” or “after” the
date you chose in the preceding step.

Example: If the Payments are scheduled every four weeks and you choose to
start the payments “after” the Disposition Date, the first Payment for each
Request will be scheduled four weeks after its Disposition Date.

6 Ifyou do not want any Payments to be scheduled on a weekend, select
the “Adjust schedule dates for weekends” option.

Example: If a Payment’s date falls on a Saturday, GIFTS will move it’s
scheduled date to the preceding Friday. If it falls on a Sunday, GIFT'S will
move it to the following Monday.

7 Select the “Round payment amounts to nearest whole number” option if
you want to ensure that all of your Payments are made in whole
numbers—even as you edit Payment Amounts based on percentages.
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8 Select the default Payment Type and General Ledger Account codes to be
applied to all of the Payments.

9 Click Next. You are prompted to review and modify the payment

schedule:

The following schedule will be used to create Papments for the selected Requests. Make any desired changes and then
click Nest to specify Budget Resalution.

t | Schedule Date % -
p | 1 4%ieek(s] after Disposiion Date 17%
2 B'Week[s] after Disposition D ate 17
3 12'Weekls) after Disposition Date 16%
4 1BWeek[s] after Disposition D ate 17
5 20'Week|s) after Disposition Date 16%
R P —r—— T |

Payment Schedule Tota: 100.00%

<-Back Mest - | Cancel

e
o

You can edit the amount of the scheduled Payments by changing the
percentage allocated to each one. Since the grant amount for each
Request is different, you can not edit specific payment values. As you
change the percentages, the Payment Schedule Total at the bottom of
the window is updated to reflect the changes you make.

If you chose a specific date in the previous step (instead of a date
relative to each Request, such as the Disposition Date), you can edit
the Schedule Date of each Payment.

Scheduling Payments for a Batch of Requests
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10 Ifyoudo nothave the optional Budget Module, please proceed to Step 12.
If you have the Budget Module, click Next. Payments Plus displays a list
of the Open Budget Years for your system.

# Step 3 - Specify Budget Resolution E3

The Request's linked budget item will be used when resolving any Payments to be created for it Vou may also specify
belaw the reserve fund to be used if a budget item iz not defined ar the linked item daes nat have sufficient funds.

‘Year Default Reserve Fund _‘I

2005 <Hone selected: J
ki 2006 Arts Reserve [$70,095.50] J

1 I»l_vI

Finish | Cancel

<- Back

Budget resolution is required for all payments that are created for
Approved Requests; funds for Pending Requests are not committed.

For each Approved Request, Payments Plus will attempt to resolve
Payments against the Budget item to which the Request is linked.
Payments Plus can attempt to draw funds from a default reserve fund that
you specify if any of the following conditions apply:

% There is no Budget item linked to the Request
< The linked Budget item has insufficient funds

< A Payment falls in a different Budget Year than the linked Budget
item

11 Ifyou would like to specify a default reserve fund for a Budget Year, click
the icon at the right edge of the Default Reserve Fund column to select a
reserve fund. This reserve fund will be used only for Payments that fall
within that year. Repeat this step for each Budget Year that should have a
default reserve fund.

Nofe: Selection of default reserve funds is not required; however,
Payments Plus does not create payments if their funds cannot be resolved
against a Budget Item.

12 Click Finish. A process log is displayed as the Payments are created. A
confirmation message is displayed at the end of the process, which
indicates whether any Payments could not be created.
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13 Click OK to close the confirmation message. The process log remains

open.
# GIFTS Payments Plus = =] B3

Payment creation complete

p | Payments could not be created for Request [481] Payments alieady exist for this Reguest.

Payments successhully created for Request [482]

Payments successiully created for Request [507]

Payments successiully created for Request [519] Print Lag |
Close |

14 You can click Print Log or Save Log to print or save a copy of the results
log. When you are finished reviewing the log, close it to end your
Payments Plus session.

You can make further changes by either editing the Payments individually in
GIFTS or by using Payments Plus to re-open the payment schedule for
individual Requests, as described in “Modifying the Payment Schedule for a
Request” on page 47.
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This chapter describes how to use Reminders Plus to create or
modify reminders for GIFTS Activities and Requirements.
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About Reminders Plus

Sending reminders with the standard GIFTS software entails running
regular searches for upcoming or overdue items and using the
correspondence feature to manually send reminders. Reminders Plus
automates this process, saving you a significant amount of time and
ensuring that reminders are never mistakenly forgotten.

With Reminders Plus you can:

% Schedule automated reminders: You can schedule a reminder to be sent
for any GIFTS Activity or Requirement type that does not have a Done
date or Received date, respectively. For example, you can set up a
reminder on Progress Reports to be sent one week prior to the due date
and GIFTS will automatically send out emails to the recipient/s you select.

< Send reminders to multiple recipients: You can select an unlimited
number of recipients for your reminders, specifying To, Cc, or Bcc for
each. In addition to grantee contacts and staff from your GIFTS database,
you can manually enter additional email addresses. You can even send
reminders to mobile phones with SMS capability. You also have the ability
to exclude contacts on an individual level.

< Keep arecord of sent reminders: You can choose to create an Activity
for each reminder sent. Activity notes include the recipient names and
addresses and also the body text of reminders, providing a full record of
all correspondence.

< Specify a time to send the reminders: Reminders Plus can be set up to
run on a daily basis at a time specified by you using the Windows Task
Scheduler.

Creating a Reminder

To create a new reminder for an Activity or a Requirement:

1 From the GIFTS Organizer Main menu, select GIFTS Plus » Reminders
Plus. (You do not need to have an Activity or Requirement selected.) The
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Reminders Summary form opens. If you have any existing reminders, they
are displayed here.

=l

File  Tools

D Iew Reminder @ Edit Reminder

inal Report Due in - Activity O Months  ADMIN 10411/20 101042006 4:47:4  Success

2 From the File menu or the toolbar, select New Reminder. The New
Reminder form opens.

3 Enter a Name for your reminder. The name is used to recognize your
reminder within GIFTS only and does not display to recipients.

# Reminder [New] o im] 5
Marme IFinaI Fieport i T weeks]|
Record I Requirement j

Type [ Financial Repart -
[ Receipt Required
=l

| [] Progress Report
faiscedh [ Signed Contract LI

4 In the Record field, select Activity or Requirement.

In the Type field, select all the record types for which you want this
reminder to be sent. You can create a very generic reminder and use it for
all record types, or you could create a different reminder for each type.

Note: The Advanced button is for creating reminders based on criteria
other than Activity and Requirement due dates, using SQL queries. An
example could be if you only wanted a reminder sent for Requests within
a specific Program Area. If you are interested in custom advanced
functionality, please contact MicroEdge Custom Programming Services
for more information.

6 Inthe Recipients section of the form, select To, Cc, or Bce for any contact
and staff options you want. If you leave a field blank, the corresponding
recipient will not receive an email.

Note: Inactive contacts and staff will not receive reminders.

Creating a Reminder 55



10
11

12

56

Using Reminders Plus

If you have selected to remind staff but there are certain staff who never
want reminders, you can block them by clicking Exclude. This opens a
separate window with a list of active staff users.

x

[ Admin

[] BenE. Factar
[w] z-Board Member
[[] Charity Ball

[ Kelly Galdberg

[w] Lee Willamsan

[[] z- Matching GIFTS User
1 Phil Anthropy

[w] Sarah Sullivan

] Termy Brawn

Cancel |

Select any users you want to exclude from the reminder and click OK.
Note that Exclude settings override any other Recipient selections you
have made.

For Other, select To, Cc, Bcc, or SMS.
< For To, Cc, and Bcc, enter an email address.

< For SMS, enter a 10-digit mobile phone number with SMS (short
message service) messaging capability.

JBee: =] ther | Add

Ta: phil. anthropyEwd. org
Ce: charity. ball@w54.arg Remave |

Sms: 5551234567

Click Add.

Repeat for each ‘other’ contact you want to add. To remove an ‘other’
contact, select the address and click Remove.

In the Subject Prefix field, enter any text you want to display as a prefix on
the subject line of your message. (The subject line of your message is

Creating a Reminder
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determined by your mail template.) You can leave this field blank if you
prefer.

Send

Subject Prefix IGIFTS Reminders Plus:

Template IDverdue Fequirement j

Oceus I El I\’\"'EEkS j' IA”E' j' Dug Date
¥ Create Activity ¥ Enabled ax [\I Cancel |

13 From the Template drop-down menu, select the email template you want
to use for the reminder. You must use an existing GIFTS email
correspondence template; if nothing displays in the drop-down menu, you
do not have any templates set up in GIFTS. Please refer to Creating a New
Correspondence Template (Article #8796 in the MicroEdge Solutions
Knowledgebase) for instructions.

14 Inthe Occurs fields, specify the date on which you want the reminder sent
relative to the due date of the Activity or Requirement. You can have
reminders sent X days, weeks, or months before or after a due date. If you
want a reminder sent on the due date, set it to be sent 0 days before or after
the due date.

Note: Ifyou set your reminder to be sent 0 weeks or months before or after
the due date, and you send reminders on a daily basis, your recipients will
get a reminder every day of the week or month in which their Activity or
Requirement is due.

15 Ifyou want an Activity to be created for your reminder, select the Create
Activity check box. If created, Activity notes include the recipient names
and addresses and also the body text of reminders, providing a full record
of all correspondence.

16 By default, new reminders are Enabled, meaning they are active and will
be sent. To disable your reminder, clear the Enable box. Disabled
reminders are not sent when Reminders Plus runs.

Creating reminders does not mean they will be sent; you need to schedule
the Reminders Plus Engine to run and send them. For instructions on
sending reminders, please see “Scheduling and Running Reminders Plus” on
page 60.
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Editing Reminders

Reminders are edited using the same form with which they are created.

To edit a reminder:

1

From the GIFTS Organizer Main menu, select GIFTS Plus » Reminders
Plus. The reminders Summary form opens. Your existing reminders are
displayed.

-ioix

File  Tools

D Iew Reminder @ Edit Reminder

Frequency | Change s | Change D Last FRun Status

. Final Report Due in - Activity O Months  ADMIN 10411/20 101042006 4:47:4  Success

Double-click the reminder you want to edit. The Edit Reminder form
opens.

The Edit Reminder form has the same fields as the New Reminder form.
For an explanation of the fields, please see “Creating a Reminder” on
page 54.

Make any changes you want to the reminder and click OK at the bottom
of the form. Your reminder is edited.

Specifying Email Settings

58

Reminders Plus uses the same email program as GIFTS, but in some cases
GIFTS prompts for additional information when sending email. Since
Reminders Plus is run on an automated, scheduled basis, any such additional
information needs to be stored as a setting.

If your GIFTS system is set up to use Lotus Notes API, VIM, or SMTP/POP,
you need to specify email settings. If your GIFTS system is set up to use

MAP]I, you do not need to specify settings.

Note: If you are not sure what your GIFTS email settings are, you can verify

them from the GIFTS Administrator Module. Go to Setup » Preferences,

and look at “E-Mail Program Used” on the External tab.

Editing Reminders
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To specify email settings:
1 From the Summary form of Reminders Plus, go to Tools » Email Settings.

Note: If Email Settings is disabled (greyed out) on the Tools menu, your
GIFTS system is set up to use MAPI and you do not need to specify
settings.

Depending on your email settings, one of the following forms appears.

< Lotus Notes API
L=

Authentication

User: Il

Password: I

Cancel |

% VIM or SMTP/POP
B

Authentication

User:

Password:

From Dizplay M ame:

Fieply To Email Address:

()8 I Cancel |

2 Entera User name and Password. Note that these should come from your
mail system and not GIFTS.

3 For VIM or SMTP/POP, enter a From Display Name (the name that will
display as the sender of the reminder) and a Reply To Email Address (the
address which will display as the “from” address and to which recipients’
replies will be sent).

4 Click OK. These settings will be used for all messages sent from Reminders
Plus until changed.
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Scheduling and Running Reminders Plus

60

The part of Reminders Plus that actually generates and sends the reminders
you create is called the Reminders Plus Engine. It can be scheduled to run
automatically via a task scheduler or it can be run manually. The following
sections describe how to run the Reminders Plus Engine.

Although you can create reminders from any GIFTS workstation, you can
only schedule and send reminders from a workstation on which you have
run the Reminders Plus Engine Setup. For information on the running the
Reminders Plus Engine Setup, please see your GIFTS Plus Pack 3
Installation or Upgrade documentation.

If you are not sure whether the Reminders Plus Engine Setup has been run
on your workstation, you can verify that through your Control Panel.

To verify that the Reminders Plus Engine Setup has been run:

1 Go to the Start menu and choose Control Panel » Accessories » Add or
Remove Programs. Alist of all the programs installed on your workstation
appears.

2 Scroll down the list to look for:

|ﬁ| MicroEdge RemindersPlus Engine

If you do not see the MicroEdge RemindersPlus Engine, it has not been
set up on your workstation and you cannot schedule and run reminders
from this machine. If you think you should have this capability, please
contact the administrator who installed or upgraded your GIFTS Plus
Pack.

Scheduling Automated Reminders

The workstation sending reminders does not need to have a user logged in
to send reminders, but it must be turned on. Be sure to schedule automated
reminders on a machine that will be left on.

Important: If you are running Windows Vista on your workstation, refer to the
instructions located on page 63.

Scheduling and Running Reminders Plus
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To schedule the Reminders Plus Engine to run as an automated task:

1 From the workstation on which you have run the Reminders Plus Engine
Setup, go to the desktop Start menu and choose All Programs »
Accessories » System Tools » Scheduled Tasks. The Scheduled Tasks
Control Panel open.

Note: If you are using Windows 2000, the path is Start » Settings »
Control Panel » Scheduled Tasks.

2 Double-click Add Scheduled Task. The Scheduled Task Wizard opens.
3 Click Next. You are prompted to select the program you want to run.

4 Click Browse and select the GIFTSRemindersPlus.exe file located in your
GIFTSPlus directory.

5 Click Open to select the GIFTSRemindersPlus.exe file. You are prompted
to enter the name and frequency of the task.

6 Enteradescription, and select whether you are scheduling Reminders Plus
to run once or on a regular basis.

Scheduled Task Wizard x|

Type a name for thiz task. The task name can be
the same name az the program name.

|GIFTSFiemindersPlus

Perfarm this task:

* Daily

= wieekly

= Monthly

" One time only

" ihen my computer starts
 when | log on

< Back I Mext > I Cancel |

7 Click Next. You are prompted to enter the time and day on which you
want the program to run.

8 Enter a starting day and time.

9 Click Next. You are prompted to enter the login information for the
Windows user account that will be used to run the Reminders Plus Engine.
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Enter the login and password for your Windows user account. Remember
that to schedule the Reminders Plus Engine, you must have permission
for Reminders Plus.

Click Next. The Wizard displays the options you selected.

Select the “Open advanced properties for this task when I click Finish”
option.

Click Finish. The task properties are displayed.

Note: If Windows displays an “access denied” message, the user ID you
entered does not have permission to use Reminders Plus, or the password
you entered was not correct.

In the Run field, at the end of the path to GIFTSRemindersPlus.exe, type a
blank space and then type “-generate” (do not type a blank space after “-
generate”). This parameter indicates that the Reminders Plus Engine
should run, generating and sending reminders.

GIFTSRemindersPlus ed e

Task |Schedule| Settingsl Securityl

ggg C:wIMDOMWSAT asks\GIFTSRemindersPlus. job

Fun: IIFTSB‘I WGEIFTSPIusAGIFT SRemindersPlus. exe - generate

Browse... |

Start in; [E:AGIFTSETNGIFTSPlus

Comments: ’

Fun as: IMIEHDEDGE\piewett Set pazsword... |

[~ Run only if logged an
¥ Enabled [scheduled task runs at specified time]

QK I Cancel | Apply |

Click OK to save your changes. If you are prompted to re-enter your
Windows login information, re-enter it and click OK.

Scheduling and Running Reminders Plus
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To schedule the Reminders Plus Engine to run as an automated task from a
workstation running Windows Vista:

1 From the Windows Start menu, choose All Programs » Accessories »
System Tools » Task Scheduler. The Task Scheduler Window appears.

2 Click Create Basic Task from the Actions section. The Create Basic Task
Wizard appears.

Enter the Name and Description for the batch, and then click Next.

4 Select when you want the batch to run, either once or on a reoccurring
basis, and then click Next.

5 Enter a starting date and time, and the frequency, if needed. Then click

Next.

Weekly

Create a Basic Task

Start: 0 =l . .
Trigger Sart [ 44008 ] [Goomnen = I Uniyersal time
Action Recur evens I]-I weeks an:
Finish r Sunday i Monday r Tuesday r Wednesday

r Thursday r FEriday r Saturday

6 Select Start a program, and then click Next.

7 Click Browse and select the GIFTSRemindersPlus.exe file located in your
GIFTSPlus directory.

8 Click Open.

9 Inthe Add arguments field, enter “-generate”. This instructs the scheduler
to run the batch in silent mode.
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10 In the same field after the “-generate”, add the name of the batch and the
name of the GIFT'S user who created the batch in the following format:
batch=[batch name] login=[GIFTS user ID].

o |

Start a Program

Create a Basic Task

Trigger Prograrn/fscript:
Weekly
. Chgifts\GIFTSRemindersPlus exe Browvse... |
Action —

Starta Program Add arguments (optional): I-@nerate batch=[batch name]login=[GIFTS user ID]
Finish

Startin (optional): I

11 Click Next.

12 To configure advanced settings, select the Open the Properties dialog for
this task when I click Finish checkbox.

Note: 'This step is optional and launches the Properties window after you
click Finish which allows you to enter advanced settings.

13 Click Finish.

The Reminders Plus Engine and Window Scheduled Tasks are now set up to
run at the time you specified, without any further user intervention. When
the Reminders Plus Engine runs, any reminders scheduled for that day are
sent out and—for any reminders that were set up to create an Activity—an
Activity is created in GIFTS.

Running Reminders Plus Manually

The Reminders Plus Engine can also be run manually at any time from a
workstation on which the Reminders Plus Engine Setup has been run.

The Reminders Plus Engine is run via the GIFTSRemindersPlus.exe located
in your GIFTSPlus directory. However, because this executable also runs
Reminders Plus, if you double-click the GIFTSRemindersPlus.exe, it will
open the Plus Pack feature, exactly as if you had selected it from your GIFTS
menu. In order to tell the GIFTSRemindersPlus.exe to run the Reminders
Plus Engine to generate and send reminders, you need add certain
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parameters to the command. This is done by creating and modifying a
shortcut to the GIFTSRemindersPlus.exe.

To create a shortcut to run the Reminders Plus Engine:
1 Locate GIFTSRemindersPlus.exe in your GIFTSPlus directory.

2 Right-click on GIFTSRemindersPlus.exe and select Create Shortcut. A
shortcut is created in the same folder. You can move this shortcut, for
example to your desktop, after creating it.

|Sh0rtcut to GIFTSRemindersPIus.exe|

3 Right-click on the shortcut and select Rename. Rename your shortcut
Reminders Plus Engine, or something else you will remember easily. You
do not need to include .exe in the name.

4 Right-click on the shortcut and select Properties. The Properties window
appears.

5 Inthe Target field, at the end of the path to GIFTSRemindersPlus.exe, type
a blank space and then type “-generate” (do not type a blank space after *
generate”). This parameter indicates that the Reminders Plus Engine
should run, generating and sending reminders.

Reminders Plus Shortcut Properties 2=l

General  Shortcut | Eompatibilityl Securityl

Reminders Plus Shortcut

Target type: Application

Target location: GIFTSPlus

Target: I\GIFTSF'Ius\GIFTSHemindersF’Ius.exe -generate

6 Click Apply.

Your shortcut is now set up to run the Reminders Plus Engine. You can
double-click this shortcut to generate and send reminders manually at any
time.
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Disabling and Deleting Reminders

You can disable or delete a reminder at any time. A disabled reminder will
not be sent, but its settings are saved and it can be enabled again to be sent in
the future. A deleted reminder is permanently removed from your system.

To disable a reminder:

1 From the Summary form of Reminders Plus, double-click on a reminder
to open the Edit form.

2 At the bottom of the form, clear the Enabled check box.

V¥ Create Activity T, Enabled |
% ()8 Cancel |

3 Click OK. The reminder is disabled and will not be sent unless it is enabled
again.

To delete a reminder:

1 From the Summary form of Reminders Plus, click on a reminder to select
it.
2 Go to File » Delete Reminder. A confirmation message appears.

3 Click Yes to delete the reminder. This action cannot be undone.

Viewing the Error Log File

If Reminders Plus encounters any errors when it runs (either scheduled or
manually), it generates an error log file where you can view information
about the error/s that occurred. Error logs are text files, created on a daily
basis (when errors occur) and named in the following format: Reminder
MM-DD-YYYY. If more than one reminder encounters errors in a day, all the
error messages for that day are included in a single log file.
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You can quickly see if a reminder had any errors by looking at the Status
column of the Summary form.

-loix

File  Tools

D Iew Reminder @ Edit Reminder

Mame | Fecaord | Frequenc:y| Change LI | Change [ | Last Run | Statuzs |
Feport Due i Requirement 1 'wWeek ADMIN 10/40/200 Ermor
Don't Forget!  Requirement 1 'Week ADMIN 9/25/2008

If a reminder’s status is Error, an error log file has been created. Note that if
no errors occur, a log file is not created. A status of Error does not
necessarily mean that your reminder has not been sent. It can indicate a
partial error, for example, that one of three recipients was missing an email
address. The log file contains these details.

To view the error log file:

1 From the Summary form of Reminders Plus, go to Tools » View Error
Log. The directory where your error logs are written opens in a separate
window. The default location is the Logs\Reminders Plus folder in your
GIFTS directory.

2 Select the log file you want and double-click to open it and view error
details.

3 When you are finished reviewing errors, you can close the log file and log
file directory windows.
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This chapter describes the new charting features found in GIFTS
Charts Plus. You can chart more kinds of Payment and Request data
by an expanded list of categories, and use powerful charting tools to
format charts to meet your organization’s needs.

In This Chapter
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About Charts Plus

70

GIFTS Charts Plus is available for charting both Requests and Payments. To
access the Charts Plus feature, log in to GIFTS, select either the Requests or
Payments folder in the Organizer, then choose GIFTS Plus » GIFTS Charts
Plus from the main menu:

% GIFTS Charts Plus =] B3

Specify Data | Chart [t I

—Specify data to be included
Balance
Count of Requests
Grant Amount
Orginal Grant Amount
Fecommended Amount
Fequest Amount
q Aeld > | 4
< Hemove | _H
Lalculation I 'l
—Specify how the data should be grouped

When setting up your chart, there are two main determinations you will
make:

< Which data do you want to chart? — In both Requests or Payments charting,
you have a selection of data available. For example, if you want a chart
that shows the total of Grant Amounts your organization gave away in
each Fiscal Year, Grant Amount is the data you want to chart.

Note: You can select more than one data field for a single chart.

< How do you want the chart to group the data? — Once you know which data
you want to chart, you will decide how you want it grouped in the chart.
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In our first example, we described a simple chart that shows total of
Grant Amounts per Fiscal Year. In GIFTS Charts Plus, this means the
data (Grant Amount) is grouped by Fiscal Year.

The next two sections of this chapter describe selecting data to chart, and
how to use the grouping options of GIFTS Charts Plus.

When You’re Ready to View Your Chart

The options in the next two sections are found in the Specify Data tab of
GIFTS Charts Plus. When you're ready to see the chart you've created there,
click the Chart It! tab to open it:

4§ GIFTS Charts Plus M= k3
Specify Dat@ | Chart It |
|'S|:|ec:ify data to be included
| |

Balance [

Options found in the Chart It! tab are described in “Formatting and Other
Chart Options” on page 85.

Selecting the Data You Want to Chart

This section of the chapter discusses which fields you can chart data from,
how to add and remove the fields, and the options available for calculating
the selected data.

Selecting Requests or Payments to Chart

The first step is to display the Requests or Payments you want to chart in the
GIFTS Organizer. Use standard GIFTS functionality (such as searching or
zooming) to display the records you want to chart data from.

Once you have displayed the desired Requests or Payments in the Organizer,
highlight the ones you want to chart. If you want to chart all records
currently displayed in the Organizer, you can press CTRL+A in the folder to
select all.
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Once you have selected the records you want to chart data from, choose
GIFTS Plus » GIFTS Charts Plus from the main menu to begin setting up
your chart.

Selecting the Fields You Want to Chart

After you have selected the Requests or Payments you want to chart in the
GIFTS Organizer, you can use Charts Plus to specify exactly which data
from those records the chart should measure and display:

% GIFTS Charts Plus =] B3
Specify Data | Chart It |
—Specify data to be included For this Requests chart, we
Balance have selected to chart both
Count of Requests Request Amount and Grant
Orginal Grant Amount Amount.
Recommended Amount

Sdd >
Ll Usethesearrow keys to change

The Add and Remove X
the order of the fields selected.

buttons are used to
add or remove the
highlighted field from
the chart.

il

<- Remowve
For example, if you creating a
bar chartand want the bars for
Grant Amount to appear to the
left of the bars for Request
Amount, you can highlight
Grant Amount and click the up
arrow to move it.

The Calculation Calculation ISum 'l

options are described
in “Calculation —Specify haw the data should be grouped
Options for Charted j
Data” on page 75. I

On the left of the “Specify data to be included” section of the Specify Data
tab is a complete list of fields you can chart data from. (For more
information on the kinds of fields available, please see “Which Fields Can I
Chart?” on page 74.)

If you want to chart data from a field, select the field in the left list and click
Add. The field will move to the right list, and the data from the field will be
charted.
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Selecting Multiple Fields to Chart

In the screen shot above, we selected two fields to chart data from: Request
Amount and Grant Amount. How does this appear once we chart this data?

It depends on which kind of chart you choose. (For more information on
choosing chart types, please see “Series Properties” on page 98.) In general,
however, when you choose more than one data field to chart, data for each
field will appear next to each other within each grouping.

For example, let’s chart Request Amount and Grant Amount, grouped by
Fiscal Year. In the following bar chart, we see the two amounts charted next
to each other within each Fiscal Year:

% GIFTS Charts Plus =] B3

Specify Data  Chart It] |

REBEm-(R-REPS DR EDER| K

‘equest Amount, Total Grant Amount by Fisce

$1,500,000.00
$1,400,000.00
$1,200,000.00
$1,000,000.00

. Total Reguest Amount
[ Total Grant Amount

$&00,000.00
$600,000.00

$400,000.00

$200,000.00

$0.00

For each Fiscal Year—that is, within each grouping—two bars appear: one
for Total Request Amount, one for Total Grant Amount.
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Which Fields Can | Chart?

Fields available for charting in Requests and Payments are limited to those
with numerical values. By default, these include all currency (or amount)
fields in the Requests and Payments. Also, you can chart by record count—
that is, the number of selected Request or Payment records which fall within
each grouping.

GIFTS Customizer GIFTS Customizer fields with numerical values can
also be charted. If you use the GIFTS Customizer, you can chart Request or
Payment custom fields of the following types:

Small Number, no Decimal Currency
Medium Number, no Decimal Number, with Decimal

Large Number, no Decimal

Multi-currency  If you use GIFTS multi-currency features to track Request
and Payment amounts using exchange rates, these currency fields can be
charted as well. For example, working with multi-currency Payments, you
could chart both functional and local/other Payment Amounts.
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Calculation Options for Charted Data

Below the list of selected fields in the Specify Data tab, you can select how
you want the chart to calculate data from the fields:

% GIFTS Charts Plus =] B3

Specify Data | Chart [t! I

—Specify data to be included

Balance

Count of Requests
Orginal Grant Amount
Recommended Amount
Fequest Amount

e =

<- Remove

|

Calculation ISum 'l

—Specify how the data should be grouped

I Fizzal Year j

Select from the following Calculate options:

Option Description

Sum For the charted field, the total from all selected Requests or
Payments within each grouping.

Average For the charted field, the average of all selected Requests or
Payments within each grouping.

Maximum For the charted field, the single highest amount or number
from the selected Requests or Payments within each grouping.

Minimum For the charted field, the single lowest amount or number
from the selected Requests or Payments within each grouping.

Note: The Calculate options are not available for record counts such as Count
of Payments or Count of Requests.
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Selecting How to Group Your Data

Once you have selected the Request or Payment field(s) you want to chart,
you next choose how to group them. GIFTS Charts Plus provides a great
number of different categories to group by, and grouping options let you
specify how broad or narrow each group will be.

\| 1) !
Tip: Explore the different grouping options to see what works well for you.

You may find a useful way to group data in a chart that you haven’t thought
of before.

Different grouping categories are available for charting Requests than for
charting Payments. Different kinds of categories have different grouping
options. We will discuss these different aspects of grouping in the following
order:

< Request Grouping Categories — This topic provides an overview of the
fields and categories by which you can group charted Request data.

< Payment Grouping Categories — This topic provides an overview of the
fields and categories by which you can group charted Request data.

< Grouping Options Based on Group Type — After you choose a category
by which to group charted data, you may have grouping options to
choose. Different grouping category types have different options,
described in this topic.

Request Grouping Categories

The following categories provide a general overview of Request details by
which you can group chart data:

Category Description

Request Type, Status, or These categories allow you to group Request amounts and
Disposition numbers into different stages of your workflow.
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Category Description

Request amounts Group data by Recommended, Request, or Grant Amount,
or by calculated amounts like Balance.

For example, you could choose “Count of Requests” as your
data, then group that data by ranges of grant Amount
($0.00-$50,000.00, $50,001-$100,000, etc.) to see how
many grants of each size you have given.

NOTE: Multi-currency users can group chart data using
either the local/other or functional amount.

For information on options for grouping by amount and
number, please see “Grouping Options Based on Group Type”
on page 80

Request dates Select a date range for Disposition Date, Request Date,
Project Start or End Date, and so on.

For information on options for grouping by date fields,
please see “Grouping Options Based on Group Type” on

page 80
Request Coding Sheet You can select a Code Table from the Request Coding Sheet
Categories and the chart will break down Request data by code.

Example: Chart Grant Amount by Program Area and see
how much you are giving to each kind of project.

For information on options for grouping by Coding Sheet
categories, please see “Grouping Options Based on Group
Type” on page 80

Grantee Organization’s You can select a Code Table from the Grantee
Coding Sheet Organization’s Coding Sheet and the chart will break down
Request data by code.

For example, you could chart Request Amount by
Geographical Area Served to see which regions of the
country may be less aware of your charitable organization.
For information on options for grouping by Coding Sheet
categories, please see “Grouping Options Based on Group
Type” on page 80

Grantee Organization Your chart can break down Request data by Grantee
details Organization, or by the Grantee Organizations’ countries,
states, or Zip codes.

Other Request details Group by Request Primary Contact or other Request details
found in the GIFTS Charts Plus options.
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GIFTS Customizer — Certain GIFTS Customizer fields are also available
for grouping data in charts. When you are charting Request data, custom
fields from the the following records are available:

% Requests
% Request Grantee Organizations

Request custom fields and custom fields from Grantee Organizations can be
used as chart groups if the custom fields are of the following types:

Small Number, no Decimal Currency

Medium Number, no Decimal Number, with Decimal
Large Number, no Decimal Date

Values

For information on grouping options for date, currency, and number fields,
please see “Grouping Options Based on Group Type” on page 80.

Payment Grouping Categories

The following categories provide a general overview of Request details by
which you can group chart data:

Category Description

Payment Status These categories allow you to group Payments data into
categories like Paid, Hold, and so on.

Payment Amount Chart Payments data in groups based on ranges of
Payment Amount.

NOTE: If you use GIFTS multi-currency options, you can
chart by a range of local/other or functional amounts.

For information on options for grouping by amount, please
see “Grouping Options Based on Group Type” on page 80

Payment dates Select a date range for Schedule Date, Paid Date, and so
on.
For information on options for grouping by date fields,
please see “Grouping Options Based on Group Type” on
page 80
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Category Description
Request Coding Sheet You can select a Code Table from the Coding Sheet of the
Categories Payment’s Request and the chart will break down Payment

data by code.

Example: Chart Payment Amount by Request’s Program
Area and see how much you are giving to each kind of
project.

For information on options for grouping by Coding Sheet
categories, please see “Grouping Options Based on Group
Type” on page 80

Grantee Organization’s You can select a Code Table from the Grantee
Coding Sheet Organization’s Coding Sheet and the chart will break down
Payment data by code.

For example, you could chart Count of Payments by
Geographical Area Served to see which regions of the
country have received the most Payments.

For information on options for grouping by Coding Sheet
categories, please see “Grouping Options Based on Group
Type” on page 80

Payee Organization’s You can select a Code Table from the Payee Organization’s
Coding Sheet Coding Sheet and the chart will break down Payment data
by code.

For information on options for grouping by Coding Sheet
categories, please see “Grouping Options Based on Group
Type” on page 80

Other Payment details Group by Request Primary Contact or other Payment
details like G/L Account, Fund, or Fiscal Year.

GIFTS Customizer — Certain GIFTS Customizer fields are also available
for grouping data in charts. When you are charting Payments data, custom
fields from the the following records are available:

% Payments
“ Requests
% Grantee Organizations

% Payee Organizations
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Payment, Request, and Organization custom fields can be used as chart
groups if the custom fields are of the following types:

Small Number, no Decimal Currency

Medium Number, no Decimal Number, with Decimal
Large Number, no Decimal Date

Values

For information on grouping options for date, currency, and number fields,
please see “Grouping Options Based on Group Type” below.
Grouping Options Based on Group Type

When you select certain types of categories by which to group datain a
chart, GIFTS Charts Plus provides different grouping options particular to

that group type.
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Amount and Number Categories For example, Recommended Amount
(when charting Requests) or Payment Amount (when charting Payments):

% GIFTS Charts Plus [-[O]x]

Specify Data | Chart It I

—Specify data to be included
Balance Count of Requests

Murnber of Books
Qrginal Grant Amaunt
Recommended Amount

Request Amount
Add >

il

<- Remove

Calculation %

—Specity how the data should be grouped

Original G t
Range (10000 3:

Option Description

Range When you group data by amount or number, you need to provide a
range. In this field, enter a number indicating the size of the range.

In the example above, we have selected to group by Original Grant
Amount using a range of 10,000. This chart will show us the number
of selected Requests for which the Original Grant Amounts were:

< $0.00 - $10,000.00
< $10,000.01 - $20,000.00
...and so on.
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Date Categories For example, Project Start Date (when charting
Requests) or Paid Date (when charting Payments):

% GIFTS Charts Plus =
Specify Data | Char It |

[ Specify data to be included

Count of Requests
Girant Amount Orginal Grant Amount

MNumber of Books
Add>

Recommended Armount
Request Amaunt
<-Hemove

=

i

Caleulation | Sum =

— Specify how the data should be grouped

IMeetmg Date ﬂ
Group by 'ﬁ \
Day
Moarth
QJuarter
Option Description
Group by When you group data by a date, you determine the range of dates to

comprise each category by choosing grouping by day, month,
quarter, or year.

In the example above, we have chosen to group by Meeting Date.
We can group Requests data by the year (Requests with Meeting
Dates within the same year will be grouped together), quarter,
month, or day.

NOTE: If your Fiscal Year is not the same as the calendar year—for
example, your Fiscal Year as specified in the GIFTS system runs from
October 1-September 30—you will have six options here: You can
group by Fiscal Year, Calendar Year, Fiscal Year Quarter, Calendar
Year Quarter, Month, or Day.
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Coding Sheet Entries When charting Request data, you can group data
by code, breaking down amounts by classifications in the Request’s Coding
Sheet or the Grantee Organization’s Coding Sheet:

% GIFTS Charts Plus [-[O]x]

Specify Data | Chart It I
—Specify data to be included

Grant Amount

(rginal Grant Amount
Recommended Amount
Request Amount

Add -

<- Remove

il

Calculation %

—Specity how the data shavld be grauped

IPngram HLrea j

Display ipi - Code Level |Level 2 -

Option Description

Display This selection determines how the chart labels each
group of data. You can choose to label your chart using
each classification’s Description, Code, or both.

Code Level This option is available if you select a multi-level Code
Table by which to group data. Select the level at which
you want to break down data in your chart.

This option is not shown if you choose a single-level Code
Table.
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In the illustration above, we have chosen to chart Grant Amount by different
Program Areas specified in the Request Coding Sheet. We are breaking
down data at Level 2 Program Area, to get a little more detailed view:

4§ GIFTS Charts Plus —
Specify Data  Chart It I
ARS m-[Ae-Bets P RLET TR N

Total Grant Amount by Program Ares

$90,000 .00

$80,000.00 -
$70,000.00 -
$60,000.00 -
$50,000.00 -
$40,000.00 -
$30,000.00 -
$20,000.00 -

$10,000.00 -

$0.00

=N code specified= -

Pertorming Arts -

Adult & Continuwing Ed

Higher Ed -

Health & Welness -
Children & Families

Elementary & Secondary Ed

Contact and Organization Names You can chart Request data by
Grantee Organization or by the Grantee Organization’s Primary Contact.
Payments can be charted using those groupings, as well as by Payee
Organization and Payee Organization’s Primary Contact. GIFTS Charts Plus
provides options on how to label these groups in your chart:

Group Type Description

Organization When you group data by Organization, the chart can label
groups using the following Organization details:
< AKA
< ID

< Legal Name
< Name
% Sort As Name
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Group Type Description

Contact When you group data by Contact, the chart can label
groups using the following Contact details:

< Full Name
< ID
« Last Name, First Name

Viewing Your Chart

When you're ready to see the chart you've created, click the Chart It! tab to
open it:

4§ GIFTS Charts Plus [_ |O0)
Specify Datb | Chart It |

|’Specif_l,l data to be included
| |

Balance [

The next section describes the options you can use to format the chart
you’ve created.

Formatting and Other Chart Options

Charts Plus allows you to create many different kinds of charts—bar charts,
pie charts, and many others—and to format the charts and its labels a
number of different ways.

Once you have created a chart you like, you can save the chart settings and
apply them to new charts you create. You can also print your chart, or copy
the chart as a graphic and paste it into word processing documents and
other files.

This section provides an overview of these and other options available in
GIFTS Charts Plus.

v

|
Tip: GIFTS Charts Plus is a powerful and dynamic tool, and the possibilities
and variations the Charts Plus options provide are too numerous be detailed
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here. We encourage you to try different things to find charts that suit your

needs best.

The Charts Plus Toolbar

In the Chart It! tab, the Charts Plus toolbar provides a quick way to access

most chart options.

Note: Many of these options are more easily shown than described; several
items in the table below will refer you to later topics to get full information

Description

about them.
Icon Name
o Personalized
o= Charts
B Copy to
£& Clipboard

% Print

Gallery

I Palette Selector

86

Options under this selection allow you to save chart
settings, apply your saved settings, and to restore
your chart to the Charts Plus default settings.

Note that you can only save one set of chart settings.
These settings will be saved and available to you until
you save another set.

If you want to paste your chart into a word processing
document or other files, click this icon and choose to
copy an image of the chart as either a Bitmap or a
Metafile. Then go to the other file and press CTRL+V
to paste the chart in.

You can also choose to copy only chart data to the
clipboard. This table of data can be pasted in
spreadsheet programs such as Excel, or other files.

Print your chart by clicking this icon.

The Gallery allows you to change your chart to
another type, such as a bar chart, horizontal bar
chart, pie chart, and many others.

Click this icon to select a different color scheme for
your chart.
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Icon Name

Description

3& 3D/2D

Rotate View

D Rotate Around Y

AXis
¥ Rotate Around X
E AXis

" Clustered (Z-Axis)

i Axes Settings
% :
AEC Point Labels
e

3? Data Editor

Legend Box

@ Zoom

Formatting and Other Chart Options

You can toggle this icon to switch your chart between
two-dimensional and three-dimensional views. If you
choose a 3D chart, the next option, Rotate View, is

available. This and other 3D options are described in
“Working with Three-Dimensional Charts” on page 88.

These four options—Rotate View, Rotate Around Y
Axis, Rotate Around X Axis, and Clustered (Z-Axis)—
can be used with three-dimensional charts.

For more information on how these options work,
please see “Working with Three-Dimensional Charts”
on page 88.

Axes Settings are available for bar charts, line charts,
and point charts. They allow you to add grid lines to
the chart, change labels, and so on.

For details, please see “Working with Axes Settings” on
page 91.

If you click this icon to add point labels, the chart will
label each chart element—for example, each “slice”
of a pie chart—with the amount or number the
element represents. Please see “Displaying Point
Labels” on page 94 for more details.

After you have created a chart, you can edit the data
shown by clicking the Data Editor icon.

For more information, please see “Editing Chart Data”
on page 95.

Clicking this icon toggles the legend box on and off.
The legend box is useful if you have selected more
than one amount or number to chart.

Toggle Zoom on and you can select an area of the
chart and zoom in on it. Toggle the Zoom icon off
and the full chart is displayed again.
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Icon Name Description

Properties Click here to open the Properties menu. Many
options in the Properties menu can be accessed using
other icons in the Charts Plus toolbar.

For more information on chart Properties, please see
“Working with Chart Properties” on page 96.

Working with Three-Dimensional Charts

In the illustration below, we selected several Requests and created a simple
chart of their total Request and Grant Amounts, grouped by fiscal year:

% GIFTS Charts Plus [_[O] =]

Specify Data  Chart 11 |
YRR T (5

Jtal Reguest Amount, Total Grant Amount by Fiscal Yes

Here we have toggled the
Legend Boxicon on. The legend
appears, allowing us to see
what each color bar in our bar
chart represents.

$1,500,000.00 -|

§1,400,000.00 |

$1,200,000.00 -|

$1,000,000.00 |

. Tatsl Request Amourt
[ Total Grant Amount

$800,000.00 -

$600,000.00

$400,000.00 -

$200,000.00

$0.00
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This is a two-dimensional chart; this is the default setting when you first
s create a new chart in GIFTS Charts Plus. Click the 3D /2D icon in the Charts
Plus toolbar to change this into a three-dimensional chart:

4% GIFTS Charts Plus [-10] %]

Specify Data  Chart [t I
22gw-[Fs- B ¢80 @ 8 LER 5

Total Request Amourt, Total Grart Amourt By Fiscal Year

Here we have turned the
legend box off.

$1,600,000.00 -

$1,400,000.00 -
$1,200,000.00 -
$1,000,000.00 -
$800,000.00
$600,000.00 -
$400,000.00 -
$200,000.00 .
$0.00 ! ' ’

2002 2003 2004

After you have changed your chart to a 3D chart, the other 3D chart options
will allow you to rotate the chart to create different dynamic effects.

Rotate A three-dimensional chart can be rotated around its X axis (the
horizontal base of a bar chart) and/or its Y axis (the vertical side). Before you
==  can perform these rotations, you must first toggle the Rotate icon on.

Note: 3D chart rotation settings can also be found in the Charts Plus
Properties window, as described in “Working with Chart Properties” on
page 96.
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Rotate Around Y Axis Click this icon to rotate your 3D chart around its Y
axis. In the illustration below;, this is our original 3D chart after clicking
twice:

$# GIFTS Charts Plus

Rotate Around X Axis Click this icon to rotate your 3D chart around its X
= axis. In the illustration below;, this is our original 3D chart after clicking
twice:

# GIFTS Charts Plus
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Clustered (Z-Axis) In the 3D charts we've tried so far, the two chart
elements—Total Request Amount and Total Grant Amount—have been
=%  shown side by side. By clicking the Clustered (Z-Axis) icon, we can show
. them one behind another:

4§ GIFTS Charts Plus o]
Bl. 5@ £ 01|

Total Request Amount, Total Grant Amount by Fiscal Year

Specify Data

el =

$1,600,000.00 -

$1,400,00000 -

$1,200,000.00 -

$1,000,000.00 -

$800,000.00 -

$600,000.00 ~

40000000 -

$200,000.00 -

$0.00

Note: The Clustered (Z-Axis) icon is available for 2D charts as well. However,
if the second element is less than the first element in front of it, that first
element won’t be seen in the chart.

Working with Axes Settings

Axes Settings provides you with options for both the X and Y axes when
working with bar, line, gantt, and point charts.

\|l

-,

Tip: One of the more useful GIFTS Charts Plus options—to use vertical
labels for the X axis—appears in this menu. This option changes the chart
labels along the bottom of your chart to read up-and-down. If you are
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charting by a grouping category with a long label, this will prevent the labels
from overlapping one another, thus rendering some invisible in the chart:

#% GIFTS Charts Plus B |
Specify Data  Chart It I

2 6 & | il - (Rl - Bbo Gt B &

o HS o (07 | i = B ®

Total Recommended Amourt, Totsl Grant Amourt by Program Area

$1,300,000.00
$1,200,000.00
$1,100,000.00
$1,000,000.00
$300,000.00 -
$500,000.00 -
$700,000.00 -
$500,000.00 -
$500,000.00 -
$400,000.00 -
$300,000.00 -

$200,000.00 —
§$100,000.00 - |
$0.00

Education

Artz and Culture l

Civic and Community

Health and Human Services

i When you click the Axes Settings icon, the following menu is displayed:

— Y Axis and X Axis in the menu are not

B ed optionsthemselves—they are headings
indicating which axis the menu items
Interlaced following them apply to.

() arid
Vertical Labels

Staggered

Show Labels

Options ...

Note: More detailed options for customizing the Y axis can be found in the
Charts Plus properties, as described in “Working with Chart Properties” on
page 96.
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The following options are available for the Y axis:

Option Description

Grid Select this option to display horizontal grid lines behind the chart
elements. For example, if you are charting Total Payment
Amount, grid lines might be placed to indicate multiples of
$1,000.00.

Interlaced Select this option, and instead of horizontal grid lines, horizontal

bands of alternating shading will appear behind the chart
elements.

For example, if you are charting Request Amount, alternating
bands representing intervals of $10,000.00 will appear behind
chart elements.

The following options are available for the X axis:

Option

Description

Grid

Vertical Labels

Staggered

Show Labels

Formatting and Other Chart Options

Select this option to display vertical grid lines behind the chart
elements. For example, if you are charting Total Payment
Amount grouped by a Range of 1,000, grid lines will be placed to
indicate multiples of $1,000.00.

In a bar chart, for example, labels for each bar appear along the X
axis below the chart. These labels indicate the grouping that the
chart element is in.

If you are charting by a grouping with long labels—for example,
by Program Area or other Coding Sheet classification—horizontal
text labels may overlap and render some labels invisible.

Choose this option to change the labels to read up-and-down
rather than horizontally.

Another option for long X axis grouping labels is to stagger them.
Select this option, and labels will alternate position, each appear

one line above or below the last:
o NN NN ENEE e |

g
Civic and Community Education
Artz and Cutture: Health and Human Services

At the same time, you can choose not to show group labels at all
by toggling the Show Labels option off.
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Displaying Point Labels

T Use the Point Labels icon to have the chart label each chart element—for
= example, each “slice” of a pie chart—with the amount or number the
element represents.

Click the icon to open the Point Label Options:

[~ Show pairt labels
[ Force autside [pie charts anly]
Shyle:
IAmount j
Change Font... |
Pairit Label Fant

Finizhed | Cancel |
Option Description
Show point labels Select this option to show point labels in your chart.

Force outside (pie charts  If you are creating a pie chart, and do not want point
only) labels to appear in the “slices” of the pie, select this
option.

NOTE: The illustration following this table shows an
example of a pie chart with this option turned on.

Style Since your chart elements—the “points” you are
labeling—are numbers and amounts, you have options
on what the label calculates and displays.

< Amount—Example: $12,340.00
< Amount (Percentage)—Example: $12,340.00 (34.12%)

< Amount of Total—Example: $281,102.00 of
$1,899,300.00

< Amount of Total (Percentage)—Example: $281,102.00
of $1,899,300.00 (14.80%)

< Percentage—34.12%
% Percentage (Amount)}—34.12% ($12,340.00)

% Percentage (Amount of Total)—14.80% ($281,102.00 of
$1,899,300.00)
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Option Description
Change Font Select this option to choose a different font for your point
labels.

When you have set your options, click Finish to display your chart with
point labels:

4§ GIFTS Charts Plus W—
Specily Data  Chart 1 |

3 a|e-md-[wls b s R|EEDER| &

Total Grant Amount by Program Ares

§1,132,350.00 (35 60%) *\' b

. Civic and Community
§1,223,950.00 (38E7%) Arts and Cutture

M Eciucation

D Health and Human Services

$632, 75500 (21 47%)
§135,456.00 (4.26%)

Editing Chart Data

3’ After you have created a chart, you can edit the data shown. Click the Data
Editor icon on the chart toolbar. The data table opens within the chart

window:
B Total Requsst Amourt $1,244 350,00 5135,456.00 §535,765.00 51 208,475.00
I Total Grant Amourt | $1,220 35000 | 5135,455.00 | §652,765.00 | 51,132,250.00|

Double click on the data value you want to edit. Your cursor now appears in
that table cell, allowing you to change the value. (You can edit the data labels
as well.) Then press ENTER to refresh the chart to reflect the new data.
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Note: Adjusting data in the chart’s Data Editor will not affect the data stored in
GIFTS. If you make changes in the Data Editor, close the chart, then recreate
the same chart, your previous changes to the data will not appear.

Working with Chart Properties

96

Click the Properties Icon to open the chart Properties window:

Properties !E[ E

General | Sefies I Y s I

- Color —aD

Palette: I [ 1 =11 ] 'l I QD
[ Botated vi
Backgound: [ -] e
[ Cluster [Z awis)
Chatbor [ | +|
¥

~ Effect:

Stacked: Ih{ﬂ; Side by Side VI
Aues II:l Flat Frame VI

IV Anti-Aliasing
b IBD 3: ' IBD 3:
QK | Cancel | Apply |

Many of the properties repeat features found in the Charts Plus toolbar. The
selections here in some cases provide more detailed options.

\ll

-

Tip: Many properties described below are accessible in other ways in Charts
Plus. Accessing certain options using an alternate method (rather than
working through the Properties window detailed here) can be more
intuitive. These alternate ways to get to a preference are noted where
appropriate.
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General Properties

In the General Properties tab, you can select chart colors, choose effects like
stacked bar charts, select the way the chart axes are displayed, and use the
3D chart features described in “Working with Three-Dimensional Charts”

on page 88.

Option

Description

In the Colors section of the General tab:

Palette
Background

Chart Box

Here you can select a different color scheme for your chart.
Change the color of the screen behind the chart.

Change the color of the chart box. The chart box in bar, line,
point, and other charts is the background within the chart (as
opposed to background behind the whole chart, set using the
previous option).

In the Effects section of the General tab:

Stacked

Axes

When creating bar charts where more than one data selection is
charted, you can choose to show the amounts stacked instead
of side-by-side.

This menu provides options on how you want the chart to
display the X and Y axes (or the “frame” of the chart).

In the 3D section of the General tab:

3D

Rotated View

Clustered (Z-Axis)

Xand Y settings

Working with Chart Properties

Select this check box to switch your chart from a two-
dimensional to a three-dimensional view.

Select this option to create a rotated 3D chart, as described in
“Working with Three-Dimensional Charts” on page 88.

Select this check box to show multiple data elements within a
grouping one behind the other, rather than side-by-side, as
shown in “Working with Three-Dimensional Charts” on page 88.

If you are working with a rotated-view 3D chart, use these
settings to enter the degree (0-360) to which the chart should be
rotated against each axis.

When you change the X or Y settings, the globe above will
indicate the current position.
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Series Properties

In the Series tab of chart Properties, you can change your chart type, and
select colors, shading, shape, and borders of chart elements (e.g., slices in a
pie chart or bars in a bar chart).

Properties !E[ E
General  Series |YAxis I
All Series —Bar
idth; |26 =
Gallery: Im Gap width: I 3'
" Sguare
Paint Label
[ PartLebels ' Cylinder
' Cone
gl v Border

Scheme: lm Effect: lm
Lolor: lﬁ Calar: lﬁ
Alternate: lﬁ Style: m
Pattem: l% “eight: IE

QK | Cancel | Apply |

All Series In the All Series section of the Series tab, you can select a
different chart type. These are the same options found using the Gallery
icon, as described in “The Charts Plus Toolbar” on page 86.

The option to display point labels in your chart is also found here. For point
label font and formatting options, however, you should set up point labels
from the Charts Plus toolbar, as described in “Displaying Point Labels™ on
page 94.

Fill  Fill properties determine the color and appearance of bars and lines in
chart types that use those markers.

Important: The color options provided in this section of the Charts Plus
properties—except the first, Gradient—can only be used if you access
properties the right way. If you want to change the color of bars or lines in
the chart, close Properties, right-click in the chart on the data element you
want to change, then select Properties in the menu. Then you will be able to
change its color.
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Bar/Marker Options in the top right corner of the Series tab change
depending on the type of chart you choose in the Gallery menu to the left.

< No options are available for area, pie, surface, doughnut, bubble, contour,
or area-curve charts.

% The following Bar options are available for bar, high-low-close, cube,
pyramid, open-high-low-close, candlestick, and gantt charts:

Option Description

Gap width Set the width of the gap the chart will show between bars
in your chart.

Square/Cylinder/Cone Select the shape the chart should use for data elements in
the chart.

% The following Marker options are available for line, scatter, curve, pareto,
step, and radar charts:

Option Description

Shape Select the shape that the chart should use to show the
data points in the chart.

If you are creating a line chart and do not want to show
points, select the blank option here.
Size Select the size of the data points in your chart.

Same color lines Select this check box to make the lines in the charts
above the same color as the related data elements it
measures. This is used in pareto and other charts which
show both bars (like in a bar chart) as well as lines to
show amounts.

Border The options here allow you to modify the borders around each
data element (for example, the borders of the cylinders in a 3D bar chart).
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Y Axis Properties
You have many options to customize the Y axis, or left side of your bar or
line charts:

Properties !E[ E

Generall Serieg T Awis |

~Scale - Gridiines / Tickmarks

Steq: IAuto I Show Gridines
Minimum: IAUED Tickmark: I Outside < l
I aximurn: IAuto Calar: I_ VI

Decimals: |2 3: Style: I— 'l
Format: IEurrenc:y 'l weight: Ii 'l
I”" Logarithmic I Interlaced

- Label 2 [—
Angle: I Horizontal =~ l

" Staggered

QK | Cancel | Apply |

Some of the most useful here are Step and Minimum:
< Step—Step determines the interval between eachamount or numberlabel
shown along the outside of the Y Axis.

For example, depending on the range of amounts in the chart’s
groupings, GIFTS Charts Plus might automatically label every
$10,000.00:

$30,000.00
$20,000.00
$10,000.00

$0.00 -
&1 2001
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Here in the Y Axis properties, you can specify another Step (for example,
$20,000.00 instead), and the chart will change the Y Axis interval to that
number.

$40,000.00 -

$20,000.00 -

FO00 | —
G 2001

< Minimum—By default, the chart will display all amounts from the
minimum group amount to the maximum group amount. If you enter a
number in this field, the chart will only display a range from that number
to the maximum group amount.

This can be useful if group amounts vary within a fairly small range. To
accentuate the differences between the group amounts, set a higher
minimum and the differences will be more readily visible.

For example, here are Request and Grant Amounts grouped by Project
Start Date (grouped by quarter), using the default Y axis minimum (i.e.,
Zero):

4§ GIFTS Charts Plus M= |

HE PG DR DER| R

Amount, Total Grart Amount by Project Start Date |

A $1_EULUUU 00
$150,00000 |

14000000 -
'$1_30LUUU 00 -
$12000000
1100000 -
 $100,000.00 -
3000000 |
ssngono0 |
 a7ngonon
: $EULUUU 00 -
ss0go0o0 |
 sang0non
: $30LUUU 00 -
000000 |

91000000 -
000 -
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By setting the Minimum to $50,000.00, we can see the show the
differences in quarters yet more vividly:

#% GIFTS Charts Plus
SpecifyData Chart It |

1=l B |

EErd

Bl - @b s 7@ 4 ER| %

$160,000.00

© Total Reguest Amount, Total Grant Amount by Project Start Date |

RN
L0y
$130,000.00 -
§120,000.00
Bl
§100,000.00 -
HID
1$50,000.00 -
AL

$60,000.00

350,000.00 —

The following table details all Y Axis properties options:

Option

Description

In the Scale section of the Y Axis tab:

Step

102

Step determines the interval between each amount or number
label shown along the outside of the Y Axis.

For example, depending on the range of amounts in the chart’s
groupings, GIFTS Charts Plus might automatically label every
$10,000.00:

$30,000.00

$20,000.00

§10,000.00

§0.00

Gl 2001

Here in the Y Axis properties, you can specify another Step (for
example, $20,000.00 instead), and the chart will change the Y
Axis interval to that number.

Working with Chart Properties



Option

Using Charts Plus

Description

Minimum

Maximum

Decimals

Format

Logarithmic

By default, the chart will display all amounts from the
minimum group amount to the maximum group amount. If
you enter a number in this field, the chart will only display a
range from that number to the maximum group amount.

This can be useful if group amounts vary within a fairly small
range. To accentuate the differences between the group
amounts, set a higher minimum and the differences will be
more readily visible.

Enter a number here, and the chart will not show group
amounts above it.

Enter the number of decimal places you want to display for the
numbers marking off the Y axis intervals.

Select the format you want to use for the numbers marking off
the Y axis intervals. Currency is the default setting, and
appropriate for most Payments and Requests charts (which
mostly deal with monetary amounts).

This check box displays the numbers along the Y axis in
logarithmic terms. (This is unlikely to have much use when
charting Grant Amounts and Numbers of Payments.)

In the Labels section of the Y Axis tab:

Angle

Staggered

You can change the angle of the labels marking the Y axis
intervals from horizontal to vertical or 45 degrees.

Select this check box to stagger the Y axis labels.

In the Gridlines/Tickmarks section of the Y Axis tab:

Show Gridlines

Working with Chart Properties

Select this option to show horizontal gridlines marking each Y
axis interval.
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Option Description

Tickmark Choose the kind of tickmark you want to use to mark each
interval or step along the Y axis: none, inside, outside, or
across.
Here we have chosen across:

F10,000.00 Tickmarks
5,000.00
F0.00 1
& 2001

Color These three options allow you to change the color, style, and
weight (or thickness) of the Y axis tickmarks.

Style

Weight

Interlaced Select this option, and instead of horizontal grid lines,
horizontal bands of alternating shading will appear behind the
chart elements.
For example, if you are charting Request Amount, alternating
bands representing intervals of $10,000.00 will appear behind
chart elements.

Color This selection determines the color of the bands created when

you choose the Interlaced option above.
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This chapter describes how to use E-Mail Plus to send e-mail
messages to Contacts and members of your staff. Messages sent from
E-mail Plus can include GIFTS documents or other files as
attachments.

In This Chapter

Using B-Mail PIUS .......ooviiiiiieiiiieeeecseee e 106
Sending Batch E-Mails with E-Mail Plus.............ccccoceeneee. 109
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Using E-Mail Plus

E-mail Plus allows you to send e-mail messages from GIFTS that include file
attachments, and to easily select the e-mail addresses of your staff and of the
Contacts affiliated with the information you are sharing.

To send a message with E-mail Plus:

1 In the GIFTS Organizer, select the Request, Organization, or Contact
records associated with the contacts to whom you wish to send a message.

2 From the Main menu, choose GIFTS Plus » GIFTS E-Mail Plus. The E-
Mail Plus window is displayed.

# Send E-mail for Request [282.01] - |EI|1|

: File Action

= i send Message ":/Q Check Speling  Attachments =

To.. ||neffm@bk|ynballet.ord
cc... ||

BCC... ||
Subject I

| =

By default, the recipient of the message is the Contact you had selected in
the Organizer; if you selected a Request or Organization, the recipient is
the Primary Contact of the Request or Organization.

Note: If you selected more than one record in the Organizer, the options
for specifying the message recipients are different; please refer to
“Sending Batch E-Mails with E-Mail Plus” on page 109 for more
information.
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3 Toadd or change the message recipients, click the To button. E-Mail Plus
displays a list of Contacts affiliated with the record you selected.

% Select To Recipients gl =l
Stalf |
Name/Tile | E-mail |
vyl & Mr. Martin Doyle doylemiziafc. org
1 Executive Director
r Msz. Joanne Colling collingjoanned@ncp.org
L President
r Mr. Mortimer Humphriez  humphries@model. org
L Executive Director of Op
r Mr. Thomasz Smithton smithtontom{@afc. org
L Executive Director
r Ms. Alice Johnston slice@afc.org

Events Coordinator

Seglﬁd | Des;“lectl Finishedl Cancel |
=
R

% Select the Contacts you would like to add as recipients. You can click
Select All to select all of the Contacts listed, or Deselect All to deselect
all of them.

K3

% If you would also like to send the message to members of your staff,
click the Staff tab and select the users you would like to include. Note
that only users with an e-mail address on file are displayed.

K3

< When you have selected the people to be added as recipients, click
Finished to return to the E-Mail Plus window.

4 If you would like to send copies of the message to CC or BCC recipients,
you can click CC or BCC to add those recipients.

5 Enter the Subject and body text of the message. If you want to spell check
your message, click Check Spelling or press the F3 key.

Note: Click the right mouse button and choose the appropriate selection
to cut, copy, paste or select all text in the Body text field.

6 Ifyou would like to attach files to the message:
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< Click the Attachments button or choose Action » Attachments from
the E-Mail Plus menu. GIFTS displays two options: to select a GIFTS
document or to browse for files on your computer.

Attachments «

= Erowse for file(s)... Chrl+O

|@ Select Docurment(s). .. h Chrl+D |

% Ifyou choose the option to Browse for file(s), the standard Windows
dialog for file browsing is displayed. Select the file from your
computer or network, and click Open. The filename is displayed in

the grid.
Altachments:
File Name | File Size
» E Progrezz Report Guidelines. doc 149

< If you choose the option to Select Document(s), GIFTS displays a list
of associated GIFTS documents. You can use the options in the Show
menu to filter the list, and select the External Documents Only
option to restrict the list to documents attached with the optional
Document Manager. Click Finished to return to the E-Mail Plus
window, where the document’s filename is now displayed.

% 'To add another attachment, you can click the Attachments button
again. To remove an attachment, select it in the grid and press the
DELETE key.

7 Set the options for tracking the message:

Option Description

Log Mail Activity If this option is on, GIFTS creates an Activity record indicating
that the message was sent. The Activity record includes “E-Mail
as its Title, the Subject that you specified for the message, and
“Sent E-Mail” in the Notes field.

»

Save Message in Enable this option to save the text of the message in the Long
Activity Notes field of the Activity record.
Read Receipt Requests a message from the recipient’s e-mail system to

confirm that the message was received. Your GIFTS user
account must include an e-mail address to which the receipt
can be sent. Not all e-mail systems will send a receipt.
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8 Click Send Message or choose File » Send Message from the E-Mail Plus
menu to send the message. E-Mail Plus displays alog showing the progress
of the e-mail.

9 When the process is complete, E-Mail Plus displays a confirmation
message.

10 Click OK to close the confirmation message. The process log remains
open.

11 You can click Print Log or Save Log to print or save a copy of the results
log. When you are finished reviewing the log, close the process monitor
to end your E-Mail Plus session.

Sending Batch E-Mails with E-Mail Plus

The procedure for sending batch e-mails with E-Mail Plus is nearly identical
to the procedure for sending a message regarding a single record. However,
the choices for specifying the message’s recipients and file attachments are
different.

To send batch e-mail using E-Mail Plus:

1 In the GIFTS Organizer, select a batch of Requests, Organizations, or
Contacts. (T'o select a group of records in the Organizer, hold down the
SHIFT or CTRL key as you click on records.)

2 From the Main menu, choose GIFTS Plus » GIFTS E-Mail Plus. The E-
Mail Plus window is displayed.

% Send Batch Request E-mail 10l =|

: File Action

E 7 Send Message ":/Q Check Spelling @ Attachments

Send ta Primary Contacts in ¢+ a single e-mail ¢~ separate e-mails

(ol ||
BCL... ||

Subject I

The recipients of the message are the Primary Contacts of each record you
selected; you cannot edit the recipients of batch messages.
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Specify whether you want to send a single e-mail (with all recipients listed
in the “To:” field), or separate messages to each recipient.

If you would like to send copies of the message(s) to members of your staff,
you can click the CC or BCC buttons to add those recipients.

_ioix
| Mame | E-mail |
p | [T Admin admin@madel.org
[ Colette Rogers crogers(@model.org
[T Kely Goldberg kgoldbergi@madel. org
[ TenyBrown throwni@model.org

A

Seglﬁd | Des;“lectl Finishedl Cancel |

< Select the users you would like to add as recipients. Note that only
users with an e-mail address on file are displayed. You can click Select
All to select all of the users listed, or Deselect All to deselect all of
them.

i

< When you have selected the users to be added as recipients, click
Finished to return to the E-Mail Plus window.

If you are sending a single message, each CC or BCC recipient receives a
copy of the message you send. If you are sending separate e-mails, each
CC or BCC recipient will receive a copy of each message sent.

Note: Inbatch mode, GIFTS Contacts are not listed when you click the CC
or BCC buttons. If you would like to send a copy or your message (or
messages) to a specific person, you can manually enter their e-mail
address in the CC or BCC field.

Enter the Subject and body text of the message. If you want to spell check
your message, click Check Spelling or press the F3 key.

6 If you would like to attach files to the message:

Sending Batch E-Mails with E-Mail Plus
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% Click the Attachments button or choose Action » Attachments from
the E-Mail Plus menu. The standard Windows dialog for file
browsing is displayed.

% Select the file from your computer or network, and click Open. The
filename is displayed in the grid.

Altachments:

File Name | File Size

» E Progrezz Report Guidelines. doc 149

< To add another attachment, you can click the Attachments button
again. To remove an attachment, select it in the grid and press the
DELETE key.

7 Set the options for tracking the message(s):

Option Description

Log Mail Activity If this option is on, GIFTS creates an Activity record indicating
that the message was sent. The Activity record includes “E-Mail”
as its Title, the Subject that you specified for the message, and
“Sent E-Mail” in the Notes field.

Save Message in Enable this option to save the text of the message in the Long
Activity Notes field of the Activity record.
Read Receipt Requests a message from the recipient’s e-mail system to

confirm that the message was received. Your GIFTS user
account must include an e-mail address to which the receipt
can be sent. Not all e-mail systems will send a receipt.

8 Click Send Message or choose File » Send Message from the E-Mail Plus
menu to send the message. E-Mail Plus displays alog showing the progress
of the batch e-mail.

9 When the process is complete, E-Mail Plus displays a confirmation
message.

10 Click OK to close the confirmation message. The process log remains
open.

11 You can click Print Log or Save Log to print or save a copy of the results
log. When you are finished reviewing the log, close the process monitor
to end your E-Mail Plus session.
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Status Pl

This chapter describes how to use Tax Status Plus to verify and
update tax status information for Organizations in GIFTS. It also
describes how to search for tax exempt organizations in MicroEdge’s
Tax Exempt Organization Database.

In This Chapter

About Tax Status PIUS ..........ccocouiiiiniciiccecceccens 114
Verifying an Organization’s Tax Status ...........c.cccccccceeeeeenes 116
Updating Organization Information ..........c.cceevveecininnnee 121
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About Tax Status Plus
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Tax Status Plus allows you to verify the tax status of one or more
Organizations in GIFTS against MicroEdge’s Tax Exempt Organization
Database. After verifying the tax status of one or more Organizations, you
can update GIFTS with current tax status information.

You can also use Tax Status Plus to look up tax exempt organizations not in
GIFTS.

For more information on Organization tax status data, please refer to the
“Tax Status” section in Chapter 8 of the GIFTS 6 User’s Guide (Article #8587
in the MicroEdge Solutions Knowledgebase).

About MicroEdge’s Tax Exempt Organization
Database

MicroEdge’s Tax Exempt Organization Database is a database that contains
the most current information on all tax exempt organizations. MicroEdge
frequently updates this database with information from the IRS Exempt
Organization Master Listing and the Canada Revenue Agency’s registered
charities database.

Setting Up Tax Status Codes

GIFTS can only be updated with tax status codes that are found in its tax
status code table. Before you use Tax Status Plus, your GIFTS Administrator
must be sure that the tax status code table is up-to-date.

When you verify an Organization’s tax status, a search is done on the tax
status, and if found, the tax status codes of the Organization in GIFT'S and
MicroEdge’s Tax Exempt Organization Database are compared.

Whenever you make an attempt to update GIFTS with a code not found in
GIFTS, you will be notified. Your GIFTS Administrator can add the missing
code using the steps below, and you can then repeat the update.

About Tax Status Plus
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To set up tax status codes in the GIFTS Administrator Module:

1 Select Setup » Code Tables from the Administrator menu. The Table
Maintenance window is displayed.

2 Go to the System tab and double click Tax Status. The Code Maintenance
[Tax Status] window is displayed.

File Action Help
Clvew [ 2 8 Find

Select [tem

i [03] BO01cl3)

[ [08] B0 clE)
[31509a(1)

3 Do one of the following:

< 'To add a new tax status code, click New.

< 'To update a tax status code already in the table, double-click the code.
4 Enter the code for the tax status.

Note: For a listing of all the tax codes and their associated descriptions and
organization types, please refer to “Appendix: Tax Status Codes” on
page 145.

5 Enter the description for the tax status.

Note: This description appears in the Tax Status section of the Tax Status
menu in the Organization window and can be anything that describes the
tax status. For instance, if the tax status code is 03, an accurate description
might be 501(c)3.

6 Repeat this process until all tax status codes are set up.

Note: For more information about adding and editing codes in the
Administrator Module, please refer to “Adding Codes” and “Editing
Codes” in Chapter 2 of your GIFTS Administrator’s Guide. (Article #8834
and #8836 in the MicroEdge Solutions Knowledgebase).
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Verifying an Organization’s Tax Status
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You can verify the tax status an Organization to ensure that GIFTS contains
the most current tax status information. You can then update GIFTS with
this current information.

To verify an Organization’s tax status:

1 Inthe Organizations folder of the GIFTS Organizer, select the records that
you want to verify. (To select a group of records, hold down the SHIFT
or CTRL key as you click on records.)

2 From the Main menu, choose GIFTS Plus » Tax Status Plus Verify. The
GIFTSPlus Verification utility searches for the Organization’s Tax ID in
MicroEdge’s Tax Exempt Organization Database, and if the Tax ID is
found, compares the tax status code for the Organization in the two
databases. The Tax Status Plus - Verification Summary window is
displayed.

The resultz of your tax statuz verfications are summarized below,

tatched

The taw ztatus of 9 Organizations matched. Viiew Besults
Mot Matched

The tax status of 18 Organizations did nat match
Mot Found

The Tax |0 waz not found for 31 Organizations. Wi Hesults.

The Tax Status Plus - Verification Summary window contains three
sections:

< Matched: This section displays the Organizations whose GIFT'S Tax
ID and tax status matched the information in MicroEdge’s Tax
Exempt Organization Database. For more information, please refer
to “Viewing Matched Organizations” on page 117.

< Not Matched: This section displays the Organizations whose GIFT'S
Tax ID matched the information in MicroEdge’s Tax Exempt
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Organization Database, but not the tax status. For more information,
please refer to “Viewing Not Matched Organizations” on page 118.

< Not Found: This section displays the Organizations whose GIFTS Tax
ID was either missing or not found in MicroEdge’s Tax Exempt
Organization Database. For more information, please refer to
“Viewing Not Found Organizations” on page 120.

Viewing Matched Organizations

After verifying the tax status of one or more Organizations, you can view
information for Organizations whose GIFTS Tax ID’s and tax statuses match
the information in MicroEdge’s Tax Exempt Organization Database.

To view matched Organizations:

1 From the Matched section of the Tax Status Plus - Verification Summary
window, click View Results. The Tax Status Results - Matched window is
displayed.

Wou can update the tax statuz of each Oroanization with detals from their matching Organization.
Click Detads to see what new data wil be added to the Organization

GIFTS Organization Matching Organization TalD TanSlatus  See Details

[] | Arna Deavere Smith Wotks | Anna Deavere Smith Works Ine | 020688545 | S01¢(3) Datails
[] | Anna Deavers Smith Works | Anna Deavere Smith Works Inc | 020888545 | 501¢(3) Dt il
[ | Anna Deavere Smith Works | Anna Deavere Smith Works Inc | 020856545 | 501c(3) Detailz
[ | Anna Desvers Smith Works | Anna Deavere Smith works Inc | 020866545 | 501c(3) Dietails
[] | Barbara Lubin Goldsmith F | Basbara Lubin Goldsmeth Found | 237031386 | S01¢(3) Dedailz
[] | Basbata Lubin Goldsmith F | Basbara Lubin Goldsrath Found | 237031386 | S01¢(3) Detailz
[] | Baibaca Lubin Goldsmith F Basbara Lubin Goldsmith Found | 237031586 | S01¢(3) Details
[] | Ben & Ruth Smith Foundati | Ben & Futh Srith Foundation 136279523 | S01e(3) Details
p | [ | Bettram M Goldsmith Foun | Bestiam| M Goldsmath Foundation | 226084506 | 501c(3) Details
SelectAl | Deselectal | Pint | Update | Cose |

The Tax Status Results - Matched window contains the following fields:

Field Description

GIFTS Organization | The name of the Organization in GIFTS.
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Field Description

Matching The name of the organization in MicroEdge’s Tax Exempt
Organization Organization Database that shares the same Tax ID.

Tax ID The Tax ID matched.

Tax Status The tax status matched.

See Details Click Details to view which Organization fields can be updated.

Please refer to “Updating Organization Information” on
page 121 for more information.

2 Choose from the following options on the Tax Status Results window:

Option Description

Select All Selects all the Organizations.

Deselect All Clears all the selected Organizations.

Print Prints the displayed information.

Update Updates GIFTS for the selected Organizations. Please refer to
“Updating Organization Information” on page 121 for more
information.

Close Closes the window.

Viewing Not Matched Organizations

After verifying the tax status of one or more Organizations, you can view
information for Organizations whose GIFTS Tax ID matched the
information in MicroEdge’s Tax Exempt Organization Database, but not

the tax status.

To view not matched Organizations:

1 From the Not Matched section of the Tax Status Plus - Verification
Summary window, click View Results. The Tax Status Results - Not

Verifying an Organization’s Tax Status
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Matched window is displayed.

You can update the tax statuz of each Organization with detads from thei matching Organization
Click Detals lo see what new data wil be added to the Organization

GIFTS Oigarizalion _ Melching Orgerizatio  TawlD  Curent ToxStalus_New TaxStatus_See Delais
[] | Amesican Legion Po_ | Ameiican Legion Post | 150517032 SO1NS | Detait
[] | Aanesican Legion Po_| Ameiican Legion Post_| 150517032 SO1cNS | Delas
[] | Aanesican Legion Po_| Ametican Legion Post_| 150517052 SOIcNS | Delas
[] | Aamesican Legion Po_| Ametican Legion Post_| 146046283 5018 | Dewss
[J | Ameiican Legion Po_| Ametican Legion Post_| 146046283 501N | Delais
[] | Amesican Legion Po_| Ametican Legion Post | 148046283 SN |Delsis
[] | Anna Deavere Smé | Anna Deavere Smith | 020586545 501(cl3 Details
[] | A Deavere Smét_| Anna Deavere Smih_| 020666545 SR Delais
[] | Baibara Lubin Gold_| Barbora Lubin Golds_| 237031985 SR Delails
[] | Baibara Lubin Gold_| Barbara Lubin Golds_| 237031985 SR Detaie
» [ ] | Blsckenihinstinge_| Blacksmith Insliute In_| 134079778 ST Delai
Selectal |  Oescectan | Pint. | Updste |  Close

The Tax Status Results - Not Matched window contains the following

fields:

Field

Description

GIFTS Organization

Matching
Organization

Tax ID

Current Tax Status

New Tax Status

See Details

The Tax ID matched.

Organization Database.

The name of the Organization in GIFTS.

The tax status of the Organization in GIFTS.

The name of the organization in MicroEdge’s Tax Exempt
Organization Database.

The tax status of the Organization in MicroEdge’s Tax Exempt

Click Details to view which Organization’s fields can be

updated. Please refer to “Updating Organization Information’
on page 121 for more information.

2 Choose from the following options on the Tax Status Results - Not
Matched window:

Option Description

Select All Selects all the Organizations.
Deselect All Clears all the selected Organizations.
Print Prints the displayed information.

Verifying an Organization’s Tax Status
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Option Description

Update Updates GIFTS for the selected Organizations. Please refer to
“Updating Organization Information” on page 121 for more
information.

Close Closes the window.

Viewing Not Found Organizations

After verifying the tax status of one or more Organizations, you can view
information for Organizations whose Tax ID was not found in MicroEdge’s
Tax Exempt Organization Database.

To view not found Organizations:

1 From the Not Found section of the Tax Status Plus - Verification Summary
window, click View Results. The Tax Status Results - Not Found window
is displayed.

Select an Organization and click Look Up to search for tax status information.

Organization 1] Stale/Province A
Abuse Pievention and R ehabditation 2 DC
Adventute Chub of Manhattan 19
Amencan Foundaton for Chidren 1
Aulington School of Dentisty 2
Brooklyn Ballet 3
Calfomia Chidren's Theatre 4
1
5
[

b

Children's Fund
Computers for Eids

Eazt Side Leaming Ceanter
Eazt Side Leaming Canter 23
Girl Scouts of the L, 5. A 7

Priri... Look Up.. | Close |

The Tax Status Results - Not Found window contains the following fields:

S EIE R S B E

Field Description

Organization The name of the Organization in GIFTS.

ID The Tax ID of the Organization in GIFTS.

State/Province The state or province where the Organization is located,

according to GIFTS.
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2 Choose from the following options on the Tax Status Results - Not Found

window:

Option Description

Print Prints the displayed information.

Look Up Searches for the selected Organization(s) in the MicroEdge’s
database using the organization name and the state or
province where the Organization is located. Please refer to
“Looking Up a “Not Found” Tax Exempt Organization” on
page 125 for more information.

Close Closes the window.

Updating Organization Information

When verifying an Organization’s tax status, you can view the tax status
fields that can be updated. You can then select the fields you want to update,
and update them in GIFTS.

Note: Steps 1 and 2 below are optional and only necessary if you want to view
or change the tax status fields to be updated. If you only want to update
Organization information, go to Step 3.

To view and update Organization fields:

1 From the Tax Status Results - Matched window or the Tax Status Results
- Not Matched window, click Details next to an Organization. The Update
Details window is displayed.

Selected fields wil be ovenwitten
Field Curent New

] W LegalName Anna Deavere Anna Deaveie
[+] | Registration Date Movember, 2004 Noemhel.m&
[ | TaxStatus 501c(3) 501(c)2
= Tax Status Date Movember, 2004 November, 2004
[+ | LastVerified On 114"}1’2‘0‘0‘6 1171042006
[7) | LastVerifiedBy ADMIN ADMIN
[) | NextVerification On 117372007 171072007
) | TaxHotes Public Charity | Public Charky -

E

Set Cancel
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The Update Details window contains the following columns:

Column Description

Field The name of the field. Click the check box next to this field to
select it, or clear the check box to clear it.

Current The field information in GIFTS.

New The field information in MicroEdge’s Tax Exempt Organization

Database. If you select this field and update GIFTS, the
information in this field overwrites the information in GIFTS.

Note: Selected fields will be overwritten in GIFTS if you update this
Organization. The fields which are selected by default are determined by
your setup preferences. For more information, please refer to “Setting Up
Tax Status Plus Security” on page 9.

2 Choose one of options on the Update Details window:

Option Description
Print Prints the displayed information.
Set Saves any changes and closes the window. To update GIFTS with

the selected fields, go to Step 3.

Cancel Closes the window without saving any changes.

Note: For detailed information about the Tax Notes field, please refer to
Article #10431 in the MicroEdge Solutions Knowledgebase

3 From the Tax Status Results window, click Update. This updates the
selected Organizations with selected information from MicroEdge’s Tax
Exempt Organization Database. If you do not update all the Organizations
on the Tax Status Results window, a window is displayed indicating the
number of Organizations that have been updated. Click View Results to
return to the Tax Status Results window.

122 Updating Organization Information



Using Tax Status Plus

Looking Up Tax Exempt Organizations

You can look up tax exempt organizations not in GIFTS at any time from the
Organizations folder or while verifying Organizations’ tax status from the
Tax Status Plus - Verification Summary window.

Looking Up New Tax Exempt Organizations

You can look up tax exempt organizations in MicroEdge’s Tax Exempt
Organization Database at any time. If you choose, you can add these
organization to GIFTS.

Important: This feature does not check for duplicate or similar Organizations
in GIFTS. If you add a tax exempt organization using this feature, make sure
it is not already in GIFTS, or a duplicate Organization will be created.

To look up a new tax exempt organization:

1 From the main menu, choose GIFTS Plus » Tax Status Plus Lookup. The
Look Up Organization Tax Data window is displayed.

Name |r_-nntan£‘ 'l |

Ciy |
States "
Province [ Poslall
Tax ID |
Source
T IRS  Canads Revenue Agency * Both

Seach.. Clage

2 Enter search criteria in the following fields:

Field Description

Name The name of the organization. Use the drop-down menu to
select whether you are entering a whole or partial name.

City The city where the organization is located.

State/Province The state or province where the organization is located.

Postal The postal code of the organization.

Tax ID The Tax ID of the organization.
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Field Description

Source Select the section of MicroEdge’s Tax Exempt Organization
Database to search, either IRS, Canada Revenue Agency, or
both.

3 Click Search. The Tax Status Plus - Search Results window is displayed.

Thesa Onganizations can be added to your GIFTS databaze. Click on Detals for the fields which will be
populated.

Edit Search...

Matching Organization Tax D Public Charity? Tax Status See Details #

3R Youth Ennchment Program - 562114335 Ves S01(z)3 Diatals
» | [ |Jehnson C Smith University
E&B“ 1901 100 Beatties Foed

4-H Clubs &nd Affliated 4-H 39150370 Yes S01(c)3 Detals
0 grganizahum Smith Vialley 4-H
I

N2 Sy W lfens il

410 Smith Foundation Inc F96076924 No 507(c)3 Detals

[ | Po Box 245001
Miwaukes, W1 53224-9501

A Phdlip Goldsmith & Frieda B50613640 No 501[c)3 Details
[] | Goldsmith Foundstion Inc

347 M L& Cienega Bhed SteJ
Leve Anessles T QRS 47700

& Vincent Smith & Hany £ D4B0445EG Mo CTTTE Detals
[0 | Bichimond Scholesstin Fund v

¢ >
Selact Al | Du:ehctAI| Prirs... ] Add ] Close ]

The Tax Status Plus - Search Results window contains the following fields:

Field Description

Matching The organization’s contact information in MicroEdge’s Tax

Organization Exempt Organization Database.

Tax ID The Tax ID of the organization in MicroEdge’s Tax Exempt
Organization Database.

Public Charity? This field indicates whether or not the organization is a public
charity.

Tax Status The tax status of the organization in MicroEdge’s Tax Exempt
Organization Database.

See Details Click Details to view which fields will be added to GIFTS.

Note: GIFTS only displays the first 100 organizations found. If you need to
refine your search criteria, click Edit Search.
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4 Choose from the following options on the Tax Status Plus - Search Results

window:

Option Description

Select All Selects all the organizations.

Deselect All Clears all the selected organizations.

Print Prints the displayed information.

Add Adds the selected organizations to GIFTS. Before clicking this
button, select the check box next to the organizations you want
to add.

To view the details that will be entered into GIFTS for the new
Organization, click Details.
Close Closes the window.

Looking Up a “Not Found” Tax Exempt
Organization

If an Organization appears in the Not Found section of the Tax Status Plus -
Verification Summary window, the Organization’s Tax ID was not found in
MicroEdge’s Tax Exempt Organization Database. You can look up the
organization and if you find its match, update it in GIFTS with current tax
status data.
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To look up a tax exempt organization:

1 Click View Details in the Not Found section of the Tax Status Plus -
Verification Summary window. The Tax Status Results - Not Found
window is displayed.

Select an Organization and click Look Up to search for tax status information.
Organization 11 Stale/Frovince | A
Abuse Pievention and R ehabditation 2
Adventute Chub of Manhattan 19
Amencan Foundaton for Chidren 1
Aulington School of Dentistry F
Brooklyn Ballel 3
Calfomia Chidren's Theatre 4
1
5
[

-

Children's Fund
Computers for Eids

Eazt Side Leaming Canter
Eazt Side Leaming Canter 23
Girl Scouts of the L, 5. A 7

[

M EEEEEREEE

b

Priri... Look Up.. | Close |

Note: For more information, please refer to “Verifying an Organization’s
Tax Status” on page 116.

2 Select an Organization and click Look Up. If organizations with the same
names and states/provinces are found in MicroEdge’s Tax Exempt
Organization Database, the Tax Status Plus - Search Results window
displays these organizations. Go to step 5. If the organization is not found,
a message displays that reads “No records found. Would you like to refine
the search criteria?”
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3 Click Yes. The Look Up Organization Tax Data window is displayed.

Name |r_-nntann j |

City |
States
Province | Posiall
Tax ID |
Source
T IRS  Canads Revenue Agency * Both

Seach.. | Clage |

The Look Up Organization Tax Data window contains the following

fields:
Field Description
Name The name of the organization. Use the drop-down menu to
select whether you are entering a whole or partial name.
City The city where the organization is located.
State/Province The state or province where the organization is located.
Postal The postal code of the organization.
Tax ID The Tax ID of the organization.
Source Select the section of MicroEdge’s database(s) to search, either

IRS, Canada Revenue Agency, or both.
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4 Click Search. The Tax Status Plus - Search Results window is displayed.

ou can update the tax status data of this Qiganization with detads from one of the search results, Click
on Detals bo see what new data will be added to the Organization

GIFTS Oiganization

Model Company Foundation [26]
612 N, Eyeland Avenus

Mew ok, NY 10024

Tax D: <Missing>

Edit Search..,

Matching Organization TaxID Public Charity? Tax Status Sew Detads A

Amesican Legion Post (0583 150517092 Mo R Details
» | Smith Savage

Corrvet Biown Bronson St
| Playtes WY 135340000

Aiesican Legion Past 1607 146046283 No S50(eng Details
Post Ge Sith

Anna Deavers Smith Works Inc OA0EEES45 Yexr S01(c)3 Details
194 Mercer Ste 515F
Mew York, NY" 100121502

Baibasa Lubin Galdsmith 237031986 No S0 Details
Foundation _ ]

Pin... Updse | Close

The Tax Status Plus - Search Results window contains the following fields:

Field Description

GIFTS Organization | The Organization information in GIFTS.

Matching The organization’s contact information in MicrokEdge’s

Organization database.

Tax ID The Tax ID of the organization in MicroEdge’s Tax Exempt
Organization Database.

Public Charity? This field indicates whether or not the organization is a public
charity.

Tax Status The tax status of the organization in MicroEdge’s Tax Exempt

Organization Database.

See Details Click Details to view this organization’s fields that can be
updated. Please refer to ““Updating Organization Information”
on page 121 for more information.

5 Choose from the following options on the Tax Status Plus - Search Results

window:
Option Description
Edit Search Allows you to refine your search criteria.
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Option Description
Print Prints the displayed information.
Update Adds the selected organization(s) to GIFTS. Before clicking this

button, select the organization(s) you want to add.

To view what fields will be added, click Details next to a
selected organization.

Close Closes the window.
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Watchlists Plus

This chapter describes how to install and use Watchlists Plus.

In This Chapter

About Watchlists PIUS ........coveuiiiiiieiecbeesesesieieseecseeeenes 132
Checking the Watchlist Status for Organizations and Contacts 134
Viewing Detailed Query Results...........ccccovvvririeeeiriinininns 139

Viewing Watchlist Information and Updating Activities..... 147
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About Waichlists Plus

132

Since September 11, 2001, USS. government investigations have revealed
that terrorist organizations have exploited charitable organizations in order
to support their operations. Since this can result in violations of economic
sanctions programs, such as the U.S. Department of the Treasury’s Office of
Foreign Assets Control (OFAC) requirements against doing business with
certain countries and individuals, charitable organizations should take steps
to ensure that they are in compliance with these programs.

Watchlists Plus helps you comply with your own internal compliance
programs by checking Organizations and/or Contacts against specific
Watchlists, such as those provided by OFAC, the FBI, INTERPOL, and the
European Union, among others. If one of your Organizations or Contacts
appears on a watchlist, refer to the watchlist organization’s policies and
procedures in determining how to proceed.

Note: Your administrator defines the specific Watchlists searched using the
Plus Pack Configuration tool. For more information, see “Setting Up
Watchlists Plus Security” on page 14 of the Plus Pack 4 User’s Guide.

You can use Watchlists Plus to check all the Organizations and Contacts in
GIFTS against these Watchlists on a semi-regular basis, such as quarterly or

yearly.

Watchlists Plus and GIFTS Activities

Each time you use Watchlists Plus to check Organizations or Contacts
against Watchlists, an Activity is automatically created in GIFTS for each
record. This Activity contains the person conducting the search, the number
of “hits” (or appearances) on any Watchlists, and the names of the Watchlists
searched.

If the Organization or Contact does not appear on any watchlist, the
associated Activity is automatically marked as Done. If any Organization or
Contact registers a “hit” on any watchlist (that is, if the watchlist contains
similar information about the Organization or Contact), the associated
Activity’s Due Date is set as five days from the current date. During those
five days, you can conduct further research to determine whether or not the
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Organization or Contact is the one on the watchlist. If you determine that
the Organization or Contact is a “false positive,” or different from the one
for which it registered a hit, you can mark the associated Activity as Done,
which closes it. The accuracy of hits depends on the Threshold field setting
in the Plus Pack Configuration utility. For more information, refer to
“Setting Up Watchlists Plus Security” on page 14.

If you determine that the Organization or Contact is the same as the one for
which it registered a hit, you do not have to do anything to the associated
Watchlist Plus Activity. After five days have passed since the creation of the
Activity, it will automatically be marked as Overdue. Any Organizations or
Contacts that have an associated Watchlist Plus Activity marked as Overdue
can be assumed to be on one or more Watchlists.

Nofe: If an Organization or Contact is found to be on one or more Watchlists,
you can also delete them from GIFTS or create an alert for the Organization
or Contact that contains this watchlist information. For more information,
see “Using Organization Alerts” on page 199 or “Using Contact Alerts” on
page 362 of the GIFTS 6 User’s Guide (also available as Article 8493 and as
Article 8450, respectively, in the Solutions Knowledgebase).

Watchlist Plus Activities help create an audit trail that shows that your
organization ran a compliance check.
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Checking the Watchlist Status for
Organizations and Contacts

You can use Watchlists Plus to run a query that checks whether Contacts
and/or Organizations in GIFTS appear on Watchlists. You can either run a
new query or check the current status according to the last query ran for the
record.

Note: The Watchlists that are searched are defined in the Plus Pack
Configuration tool. For more information, see “Setting Up Watchlists Plus
Security” on page 14 of the Plus Pack 4 User’s Guide.

Running a New Query

You can run a new Watchlists query if one has never been run for certain
records, or if you want to check records against current watchlist
information.

Note: Every time you run a new query, you create a new Watchlists Plus
Activity for every record in your query.

To run a new Watchlists query:

1 Inthe Organizations or Contacts folder of the GIFTS Organizer, select the
records that you want to check. (T'o select a group of records, hold down
the SHIFT or CTRL key as you click on records.)
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2 From the Main menu, choose GIFTS Plus » GIFTS Watchlists Plus. The
Watchlists Plus window displays.

49 Organizations selected. Ik addition, you can verfy the following:

Farents and Subsidiaries Include in Search

Frimary Contacts [ Social Security Mo,

Employees []Date of Bitth ear  +4 |1 % | pears
[ Request's Primary Contacts [ City, State, and County

[] Other affiliated Contacts
[JInclude closed Affiliations

[ Check. .. ] [ Cancel ]

3 Ifyou wish to include related records in your query, such as Primary
Organization (for Contacts), or Employees (for Organizations), click the
checkbox next to the appropriate field on the left side of the Watchlists
Plus window.

4 If you wish to include additional search criteria for each record, such as
social security numbers and date of birth year (for Contacts), or city, state
and country (for both Contacts and Organizations), click the checkbox
next to the appropriate field(s) in the Include in Search section.

Important: By default, Watchlists Plus only includes Organization names
and/or Contact first and last names in each query.
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5 Click Check. The Processing window displays the current number of
records processed and the total number of records in the query. After the
query is complete, the Watchlist Plus Summary window displays.

The results of your “Watchlists Pluz check are summarized below.
Mew Hits
1 Contact kad new hitz returned. The Watchlists Plus Activities
for thogze records are due in B daps, -
Wiew Results...
Mo Mew Hitz
58 Organizations and their related recordsz returned no new -
e Wiew Results...

Note: At any time in the query process, you can click Cancel in the
Processing window, and then click Yes to display the Watchlists Plus
Summary window for the current records processed.

The Watchlists Plus Summary window contains two sections:

e

< New Hits: This section displays the number of records that either are
being included in a query for the first time and registered a hit on
watchlist(s), or registered a hit on watchlist(s) in a previous query and
the most recent Watchlists Plus Activity for that record is still open.
For more information, please refer to “Viewing New Hits Record
Results” on page 143.

< No New Hits: This section includes the number of records that either
did not register a hit on any watchlist(s) or registered a hit on
watchlist(s) in a previous query and the most recent Watchlists Plus
Activity for that record has been closed. For more information, please
refer to “Viewing No New Hits Record Results” on page 145.

Checking the Current Status

Every time you run a new watchlist query, you create a new WatchList Plus
Activity for every record in your query. If you have already run a query and
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only want to view the watchlist status of one or more records, you can
simply check the current status.

To check the current watchlist status of one or more records:

1 Inthe Organizations or Contacts folder of the GIFTS Organizer, select the
records that you want to check. (To select a group of records, hold down
the SHIFT or CTRL key as you click on records.)

2 From the Main menu, choose GIFTS Plus » GIFTS Watchlists Plus. The
Watchlists Plus window displays.

49 Organizations selected. Ik addition, you can verfy the following:

Farents and Subsidiaries Include in Search

Frimary Contacts [ Social Securty Mo,

Employees []Date of Bitth ear  +4 |1 % | pears
[ Request's Primary Contacts [ City, State, and County

[] Other affiliated Contacts
[JInclude closed Affiliations

[ Check. .. ] [ Cancel ]

3 Ifyou wish to include related records in your query, such as Primary
Organization (for Contacts), or Employees (for Organizations), click the
checkbox next to the appropriate field(s) on the left side of the Watchlists
Plus window.
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4 Click Last Status. The Watchlist Plus Summary window displays.

The most recent statuses of the selected records are summarized below.

Open

1 Contact have open hitz requining rezolution, or have never

been checked.

Werified

58 Organizations and their related records had na hitz, or only
hitz which hawve been marked falze positive, m

The Watchlists Plus Summary window contains two sections:

< Open: This section displays the number of records that either have
never been included in a query or have registered a hit on watchlist(s)
in a previous query and the most recent Activity for that record is still
open. For more information, please refer to “Viewing Open Record

Results” on page 139.

< Verified: This section displays the number of records that either did
not register a hit on any watchlist(s) for any previous queries or
registered a hit on watchlist(s) in a previous query and the most
recent Activity for that record has been closed. For more information,
please refer to “Viewing Verified Record Results” on page 141.
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Viewing Detailed Query Results

After checking the current watchlist status of records or running a new
query, you can view detailed query results for these records.

Viewing Open Record Results

After checking the current watchlist status for records, you can view detailed
query results for records appearing in the “Open” section of the Watchlists
Plus Summary window. These are records that either have never been
included in a query or have registered a hit on watchlist(s) in a previous
query and the most recent Watchlists Plus Activity for that record is still
open.

1 From the Open section of the Watchlists Plus Summary window, click
View Results. The Watchlists Plus Open window displays.

Eelow are the most recent Watchlists Plus results for the selected Contacts and their affiliated records.

Name Fole GIFTS ID Last Checked Closed By Status Hits See Dietails
|‘Sm\th,Jnhr\atha | |12 |3/22/2uu7 \<Nnne> \Dpen \1 \Detans \
| SheaDance L | Fiimay Organizal | 12 EEZET | ADMIN | Verfied [o | Details |

™ Hids relsted recrds with 1o bits

The Watchlists Plus Open window contains the following fields:

Field Description

Name The Organization name or the Contact’s first and last name.

Names displayed in red text with an asterisk next to them are
records that registered hits. Names displayed in black text are
records that registered no hits.

Names that are not indented are records you specifically
selected to include in this query.

Indented names are records affiliated with the selected
records, and are displayed if you selected to include affiliated
records in your query.

Viewing Detailed Query Results 139



Using Watchlists Plus

Field

Description

Relationship

GIFTS ID
Last Checked

Closed By

Status

Hits

See Details

Hide related
records with no
hits

If this field contains no information, it is a record you
specifically selected to include in your query.

If this field contains information, it is for an affiliated record,
and describes the relationship between it and the selected
record. The selected record appears above it and has a name
that is not indented.

For example, in the screenshot above, the Shea Dance
Company is the Primary Organization of Johnathan Smith.

The GIFTS ID of the Contact or Organization.

The date of the most recent query which included this record.
This is also the Create Date of the most recent Watchlists Plus
Activity for this record.

The name of the person who marked the record’s associated
Activity as Done. If this field displays <none>, the associated
Activity has not been marked as Done.

This field displays one of the following messages:

< Verified: The most recent associated Watchlists Plus Activity
has been marked as Done.

< Open: The most recent associated Watchlists Plus Activity is
still open.

< <none>: The record has no Watchlists Plus Activity
associated with it, and has therefore never been included in
a query.

The number of Watchlists on which the Organization or Contact
registered a hit.

Click Details to view the watchlist information that registered a
hit for this record, and to update information for the Watchlists
Plus Activity associated with this record. For more information,
please refer to “Viewing Watchlist Information and Updating
Activities” on page 147.

Note: This link is inactive if the record registered no hits.

Click this checkbox to hide affiliated records that returned no
hits.

2 Choose from the following options on the Watchlists Plus Open window:

Option

Description

Print

140
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Option Description

Close Closes the window.

Viewing Verified Record Results

After checking the current watchlist status for records, you can view detailed
query results for records appearing in the “Verified” section of the Watchlists
Plus Summary window. These are records that either did not register a hit
on any watchlist(s) in any previous queries or registered a hit on watchlist(s)
in a previous query and the most recent Activity for that record has been
closed.

1 From the Verified section of the Watchlists Plus Summary window, click
View Results. The Watchlists Plus Verified window displays.

Below are the most recent Walchlists Plus results for the selected Cantacts and their affiiated records.
Name Fole GIFTS ID Last Checked Closed By Status False Pos See Detalls
» | lbright, Caral 83 el XTI AR Ventied i Details
Teen bid Cent | Primary Diganizal | 20 32202007 ADMIN Veified [] Detals
Alevander, Tom 63 3/22/2007 ADMIN Veified [ Detals
ModelCompa | Primary Diganizal | 26 372272007 ADMIN Veified ] Detals
Anderson, D avid 4 3/22/2007 ADMIN Veified [ Detals
Califorria Chil | Primary Diganizat | 4 372272007 ADMIN Veified ] Detals
Anderson, Rose 70 3/22/2007 ADMIN Veified [ Detals
ModelCompa | Primary Diganizal | 26 372272007 ADMIN Veified ] Detals
Appleton, Viginia 5 3/22/2007 ADMIN Veified [ Detals
Computers for | Primary Diganizat | & 3/22/2007 ADMIN Weriied 1 Detalls v
< >

The Watchlists Plus Open window contains the following fields:

Field Description

Name The Organization name or the Contact’s first and last name.

Names displayed in red text with an asterisk next to them are
records that registered hits. Names displayed in black text are
records that registered no hits.

Names that are not indented are records you specifically
selected to include in this query.

Indented names are records affiliated with the selected
records, and are displayed if you selected to include affiliated
records in your query.

Viewing Detailed Query Results 141



142

Using Watchlists Plus

Field

Description

Relationship

GIFTS ID
Last Checked

Closed By

Status

False Pos

See Details

If this field contains no information, it is a record you
specifically selected to include in your query.

If this field contains information, it is for an affiliated record,
and describes the relationship between it and the selected
record. The selected record appears above it and has a name
that is not indented.

For example, in the screenshot above, the Teen Aid Center is
the Primary Organization of Carol Albright.

The GIFTS ID of the Contact or Organization.

The date of the most recent query which included this record.
This is also the Create Date of the most recent Watchlists Plus
Activity for this record.

The name of the person who marked the record’s associated
Activity as Done. If this field displays <none>, the associated
Activity has not been marked as Done.

This field displays Verified, which indicates that the most
recent associated Watchlists Plus Activity has been marked as
Done.

The number of false positives for the record. A “false positive”
occurs if a record registers a hit on a watchlist, but is
determined to not be the one on the watchlist. The record’s
most recent associated Watchlists Plus Activity has therefore
been marked as Done.

For more information about Watchlists Plus Activities and false
positives, please refer to “Watchlists Plus and GIFTS Activities”
on page 132.

Click Details to view the watchlist information that registered a
hit for this record (that was determined to be a false positive),
and to update information for the Watchlists Plus Activity
associated with this record. For more information, please refer
to “Viewing Watchlist Information and Updating Activities” on
page 147.

Note: This link is inactive if the record registered no hits that
were determined to be false positives.
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2 Choose from the following options on the Watchlists Plus Verified

window:
Option Description
Print Prints the displayed information.
Close Closes the window.

Viewing New Hits Record Results

After running a new query, you can view detailed query results for records
appearing in the “New Hits” section of the Watchlists Plus Summary
window. These are records included in a query for the first time that
registered a hit on watchlist(s), and records that registered a hit on
watchlist(s) in a previous query that have the most recent Watchlists Plus
Activity still open.

1 From the New Hits section of the Watchlists Plus Summary window, click
View Results. The Watchlists Plus New Hits window displays.

The zelected Contacts and their related records returned the following new hits.
Mame Role GIFTS ID Hits See Details
* Smith, Johnatha 12 1 Details
Shea Dance C | Primary Organizat | 12 1] Dretails
I Hide related records with na hits [ Frint... ] [ Close ]

The Watchlists Plus New Hits window contains the following fields:

Field Description

Name The Organization name or the Contact’s first and last name.

Names displayed in red text with an asterisk next to them are
records that registered hits. Names displayed in black text are
records that registered no hits.

Names that are not indented are records you specifically
selected to include in this query.

Indented names are records affiliated with the selected
records, and are displayed if you selected to include affiliated
records in your query.
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Field Description

Relationship If this field contains no information, it is a record you
specifically selected to include in your query.

If this field contains information, it is for an affiliated record,
and describes the relationship between it and the selected
record. The selected record appears above it and has a name
that is not indented.

For example, in the screenshot above, the Shea Dance
Company is the Primary Organization of Johnathan Smith.

GIFTSID The GIFTS ID of the Contact or Organization.

Hits The number of Watchlists on which the Contact or Organization
information registered a hit.

See Details Click Details to view the watchlist(s) information that registered
a hit for this record, and to update information for the
Watchlists Plus Activity associated with this record. For more
information, please refer to “Viewing Watchlist Information
and Updating Activities” on page 147.

Note: This link is inactive if the record registered no hits.

Hide related Click this checkbox to hide records that registered no hits.
records with no
hits

2 Choose from the following options on the Watchlists Plus New Hits

window:
Option Description
Print Prints the displayed information.
Close Closes the window.
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Viewing No New Hits Record Results

After running a new query, you can view detailed query results for records
appearing in the “No New Hits” section of the Watchlists Plus Summary
window. These are records which either did not register a hit on any
watchlist(s) for this query or registered a hit on watchlist(s) in a previous
query and the most recent Watchlists Plus Activity for the record has been

closed.

1 From the No New Hits section of the Watchlists Plus Summary window,
click View Results. The Watchlists Plus No New Hits window displays.

The selected Contacts and their related records returmed no new hits.
Mame Role GIFTS ID False Pos See Details L
» | Albright, Caral B3 1] Details
Teen Aid Cent | Primary Organizat | 20 1] Details
Alexander, Tom B9 1] Details
Model Compa | Primary Organizat | 26 1] Details
Anderson, David 4 1] Details
Califarnia Chil Frimary Organizat | 4 1] Details
Anderson, Rose Kl 1] Details
Model Compa | Primary Organizat | 26 1] Details
Appleton, Virginia 5 1] Details
Computers for | Primary Organizat | 5 1] Details
Austin, Janet E 1] Details w
[ Frint... ] [ Cloze ]

The Watchlists Plus No New Hits window contains the following fields:

Field

Description

Name

Viewing Detailed Query Results

The Organization name or the Contact’s first and last name.

Names that are not indented are records you specifically
selected to include in this query.

Indented names are records affiliated with the selected
records, and are displayed if you selected to include affiliated
records in your query.
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Field Description

Relationship If this field contains no information, it is a record you
specifically selected to include in your query.

If this field contains information, it is for an affiliated record,
and describes the relationship between it and the selected
record. The selected record appears above it and has a name
that is not indented.

For example, in the screenshot above, the Teen Aid Center is
the Primary Organization of Carol Albright.

GIFTSID The GIFTS ID of the Contact or Organization.

False Pos The number of false positives for the record. A “false positive”
occurs if a record registers a hit on a watchlist, but is
determined to not be the one on the watchlist. The record’s
most recent associated Watchlists Plus Activity has therefore
been marked as Done.

For more information about Watchlists Plus Activities and false
positives, please refer to “Watchlists Plus and GIFTS Activities”
on page 132.

See Details Click Details to view the watchlist information that registered a
hit for this record (that was determined to be a false positive),
and to update information for the Watchlists Plus Activity
associated with this record. For more information, please refer
to “Viewing Watchlist Information and Updating Activities” on
page 147.

Note: This link is inactive if the record returned no hits that
were determined to be false positives.

2 Choose from the following options on the Watchlists Plus No New Hits

window:
Option Description
Print Prints the displayed information.
Close Closes the window.
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Viewing Watchlist Information and
Updating Activities

After viewing detailed query results, you can view the watchlist information
for which a record registered a hit, and update information for the
Watchlists Plus Activity associated with that record.

This watchlist information is downloaded from each watchlist, and allows
you to view additional information in order to determine whether or not
the hit is a false positive or not.

1 From the See Details column of the Watchlists Plus Open window or the
Watchlists Plus New Hits window, click Details. The Watchlists Plus
Details window displays.

Select a hit to see details about the match. You can mark them false positives below the match details.

List Entity Name Score Pragrams Femarks
B35 FBI_FGT[FEI UG

Aliases Addresses
ERANDTZ, ndp J. e Tty

Country Stats Zip Remarks
BRANTZ, Andy.)

BRANTZ, John

GIFTS Recard ‘Watchlists Plus Activity

Brantz, Andrew.J. [301] Notss R et

The Watchlists Plus Details window contains the following fields:

Field Description

List The name of the watchlist that registered a hit for the record.

Note: The information in the Alias and Addresses sections
changes if you select a new watchlist.

Entity # Proprietary information from the watchlist.
Name The name of the Contact or Organization.

Score Proprietary information from the watchlist.
Programs Proprietary information from the watchlist.
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Field Description

Remarks Proprietary information from the watchlist.

Aliases Any aliases for the Contact, if applicable.

Addresses Address information for the Organization or Contact.

GIFTS Record The data in GIFTS that registered a hit on the watchlist.

Notes Enter any information to include as notes in the Watchlists Plus

False Positive

Activity associated with this record.

Click this checkbox if this record is not the one for which it
registered a hit on the watchlist(s). This marks the Watchlists
Plus Activity associated with this record as Done.

Note: You must have the appropriate permission in order for
this field to be active. For more information, refer to “Setting
Up Watchlists Plus Security” on page 14.

2 Choose from the following options on the Watchlists Plus Details window:

Option Description

Print Prints the displayed information.

OK Saves any updated Activity information and closes the window.
Close Closes the window without saving any updated information.

Viewing Watchlist Information and Updating Activities
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This chapter describes how to use Outcomes Plus.
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About Outcomes Plus

150

Outcomes Plus automatically facilitates the creation and setup of the fields
you need to track outcomes data, allowing you to be more efficient when
tracking the success of your giving programs.

The installation process, based on the investment types selected, includes
the addition of fields, tabs, views, searches, report templates and a new
Outcomes code table. Outcomes Plus is installed separately from the rest of
Plus Pack.

When setting up Outcomes Plus, you define the investment types that you
would like to track based on your outcomes framework, and select the
Request Type with which to associate each investment type you select. This
adds pre-selected Customizer fields to Requests with these Request Types,
as well as to Requirements, and if you have the Reviewers Module or
ReviewerCONNECT, to Review records as well.

Important: Outcomes Plus fields and tabs were designed by MicroEdge based
on the framework, concepts, tools, and templates defined by MicroEdge’s
outcome partner, The Rensselaerville Institute (TRI), a non-profit group
that has been dedicated to measuring and improving outcomes in all fields
of human achievement for more than 45 years. Before employing Outcomes
Plus, we recommend that you consult with The Rensselaerville Institute to
define your outcomes framework, and then work with a MicroEdge Product
Specialist to plan the best way to implement this framework into the GIFTS
database using the Outcomes Plus tool.

About Outcomes Plus
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The image below shows an example Request updated with Outcomes Plus
to track outcomes.

o5 Request [New] EJ|§|EJ

File Action Help
[ Save and Close | [=] Send Letter... 77 Write-up... &) Alert... + Approve... X Decine...
toea Speciics | Paricparts | Resuts | Miestones | Tracking | Approach | Key Peosie | FinslNuml |

Sustainability

Core knov-how

Achievements in past three pears

Similar groups

Individuals with
issues

[ oH

|ssues to address

\ /

Tip: You can click the dog-eared tab to view other Outcomes Plus tabs for
the Request.

Customizer Fields by Investment Type

When you set up Outcomes Plus, you can select to track the following
investment types:

K3

< Improving Lives (Direct Service) - Direct Service grants are those given to
organizations that serve people to help them improve their quality oflife.
Examples include a healthy cooking class or low-cost inoculations.

% Achievement Building - Achievement Building grants are given to
organizations to increase the capacity of the programs and services they
deliver.
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< Advancing Innovation - Advancing Innovation grants are given to
organizations that develop and test new approaches to increase the
effectiveness of the approach to the program.

% Capital Improvement - Capital Improvement grants are those that help
increase efficiency or effectiveness in an organization.

< Policy or Advocacy - Policy or Advocacy grants are those that are used to
change the institutional structures, underlying conditions, or policies and
practices that influence the likelihood of improved outcomes in their area
of interest.

< Applied Research - Applied Research grants are those that are used to
generate, analyze, and interpret data to identify problems, causalty, and
solutions.

When you select any of these investment types, Customizer fields are
automatically added to Requests with a Request Type associated to the
investment type, as well as to Requirements and/or Reviews. These
Customizer fields appear in separate tabs for Requests based on the Request
Types selected during the setup. Additional tabs and fields are associated
with Requirements and Reviews. The Area Specifics tab in the image on
page 147 is one example.

The Customizer fields that are added to Requests, Requirements, and
Reviews are detailed below.

Note: If you have the optional Reviewer Module or ReviewerCONNECT,
some fields will be added to the Reviews record instead of the Requests
record. These fields are noted below.

Improving Lives (Direct Service)

Listed below are the fields used to track and report on outcomes data for
Direct Service grants, or grants that serve people directly. This Request Type
contains the following tabs: Area Specifics, Participants, Results, Milestones,
Tracking, Approach, and Key People. These tabs contain fields that are
defined in the following section.

Note: This Request Type also contains other tabs, including Final Success,
Performance, Results Buying, Chance at Results, Best Use of $, and Final

Customizer Fields by Investment Type
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Num tab. These tabs contain fields that are self-explanatory and thus are not
included in this section.

Area Specifics tab

X

3% Request [740]
File Action Help

Save and Close | [ Send Letter... /7 Write-up... 40 Alert. . o fpprove... X Decine...

i Participanlsw Hesults] Milestones] Tracking] Appmach] Key F‘eop\e] Final Success

Sustainability

Core Know-How

Achievements in past 3 pears

Similar Groups

Individuals with
issues

[ o

lszues to address

The following information describes what data should be in each field of the
Area Specifics tab:

% Sustainability: This field should contain information that addresses
finances (such as trends, events, and other factors that influence the
organization’s financial viability), and leadership (including ability to
achieve success and past or anticipated replacement of key people).

< Core Know-How: This field should contain information regarding what
the organization does especially well in this area. This can include
knowledge, skills, and how well they are able to influence others to change
their behavior or conditions.

% Achievements in past 3 years: This field should contain information
describing how the organization has successfully served this group of
people in the past through other programs.
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+ Similar Groups: This field should contain information describing how the

organization is different from other groups involved in similar programs
which would lead you to want to invest in them.

% Individuals with issues: This field should contain the number of individuals
or an estimate of individuals that have the issue in the community.

% Issues to address: This field should state the challenge or problem the

grantee is trying to address in clear terms as it is experienced by their
participants.

Participants Tab

% Request [New] E'E‘ El

File | Action Help

[=1 Send Letter... a wirite-up... ) Alert... | & Approve... ¥ Dedire. ..

¢ Participants l Results ] Milestones ] Tracking ] Approach ] k.ey People ] Final Success ] Performance ]

Farticipants Characteristics

Few bartiers to
results

0
Iid barriers to
reslts

0
tany barriers to
reslts

Total to be
zerved

Few bariers details

Mid barriers details

Participant example

Many barriers details

Participant example

Total to be served
[calculated)

Participant example

Percent with
many bariers

| o

[o

HERRZ

The following information describes what data should be in each field of the
Participants tab:

% Participants Characteristics: The information in this field should describe
the characteristics of the people who will be involved in the program.

e

< Few/Mid/Many barriers to results: These fields should contain the

projected number who have issues that could affect their success by the
severity of the issues. These are the numbers that are expected to have
few, middle (mid), or many barriers to achieving success, respectively.
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< Few/Mid/Many barriers details: These fields should contain information
that describes what some of these barriers are for each group.

< Participant examples: These fields should include examples or details on
specificindividualsincluded in the program. It should include information
on their specific circumstances and characteristics.

% Total to be served: This field should contain the number of people who
the grantee plans to serve with this program.

% Total to be served (calculated): This is a calculated field that displays the
total of the numbers in the Few/Mid/Many barriers to results fields and
should be used to verify the accuracy of the “Total to be served’ field.

< Percent with many barriers: This is a calculated field that displays the
percentage of individuals with many barriers as compared to the total
number to be served.

Results tab

% Request [New]

File | Action Help
=1 Send Letter... @Writg—up... At | o Approve.. X Declne..

Participants " Reslts ] Milestanes ] Tracking ] Approach ] Key People ] Final Success ] Performance ]

Nurmber wha will Number who wolld achieve this

achieve the result regardless of the program Inwestment Per Result Cost Per Result
5] [ ol | $0.00 [ $0.00

Results Statement Results Verification

Broader Gains/ROI

The following information describes what data should be in each field of the
Results tab:
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Number who will achieve the result: This field should contain the number
of people expected to effectively achieve the change described in the
‘Results Statement.’

Number who would achieve this regardless of the program: This field
should contain the number of people who would reach the program goal
without the help of the organization and it’s program.

Investment Per Result: This calculated field displays the request amount
divided by the number who will achieve the result giving you an idea of
your investment per person for this project.

Cost Per Result: This calculated field displays the Project Budget amount
divided by the number who will achieve the result. It illustrates the
broader cost for each person to achieve the result.

Results Statement: This field should contain information about the desired
change in behavior and/or condition for the program participants.

Results Verification: The data tools or observations used to verify the
achieved results.

Broader Gains/ROI: The grantee should include ancillary benefits that
may be achieved as a result of the program.

Customizer Fields by Investment Type
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Milestones Tab

L Request [Mew] El |§|PZ|

File Action Help
=] Send Letter... ¢ Write-up... ) Alert... of fpprove... X Dedine...

Participants W Results " Milestones ] Tracking ] Approach ] Key People ] Final Success ] Perfarmance ]

Milestones

The following information describes what data should be in the field in the
Milestones tab:

< Milestones: The organization should either list their most critical activities
or simply state what they think predicts success. In addition, they should
include what they plan to look for to confirm that their participants are on
track.
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Tracking Tab

% Request [New] E“Elg|

File | Action Help
=] Send Letter. .. EEWr\tg—up... L) alert... | & Approve... ¥ Dedline. ..

Participants w Results ] Milestones | Tracking ] Approach ] F.ey People ] Final Success ] Ferfoimance ]

Information you will use to track progiess of the project

Result Longewity

‘what do pou most want to leam?

The following information describes what data should be in each field of the
Tracking tab:

e

< Information you will use to track progress of the project: The information
in this field should describe the other information you will use to track the
progress of the program. An example might be taking attendance.

< Result Longevity: This field allows the grantee to describe how a follow-
up component to their program mightbe the best money to insure durable
success.

< What do you most want to learn: High performing organizations make
learning intentional by asking the grantee what they most want to learn.
You can gauge their growth potential and ability to succeed in addition to
gaining more information about the project.
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Approach Tab

L Request [Mew] glﬁ|g|

File Action Help
=] Send Letter... {¢ Writeup... ) Alert... of fpprove.. X Dedine. .

Participants ] Resuls ] Milestanes ] Tracking  Approach ] Fey People ] Final Success ] Perfoimance ]

Approach Description

Evidence of Success

Azzumptions regarding intenzity and duration

The following information describes what data should be in each field of the
Approach tab:

< Approach Description: The organization should include a few core
elements of their particular way of solving a problem and why they think
it is the best way to engage participants and help them succeed.

< Evidence of Success: If the grantee has evidence of the success of their
approach, it should be included here.

% Assumptions regarding intensity and duration: This field allows the
grantee to describe what it really takes to achieve the result. For example,
this field can contain the number of hours per day they need to commit
to this project or the number of times a week they need to interact with
their participants.
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Key People Tab

a5 Request [Mew] E“E‘E|

File Action Help
= Send Letter... 7 Write-up... L) Alert. . o fpprove... X Decine...

Participants ] Results ] Milestanes ] Tracking ] Approach | K.ey Peaple ] Final Success ] Performance ]

Perzon leading the project and their characteristics

Perzons responsible for implementing and their characteristics Partners/Inteimedianes

The following information describes what data should be in each field of the
Key People tab:

< Person leading the project and their characteristics: This field contains
information about the person leading the project and his or her
qualifications.

% Persons responsible for implementing and their characteristics: This field
contains information about the other people responsible for
implementing the project, including their qualifications.

< Partners/Intermediaries: The information in this field should focus on
those groups who have to play a role for the grantee to be successful and
on their commitments to play that role.

The following Customizer fields are automatically added to any Requests
for the Request Type associated with the Improving Lives (Direct Service)
investment type. This section lists the Request tab name first, followed by
the Customizer field names and labels in the tab.
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Using Outcomes Plus

Note: If you have the Reviews Module or ReviewerCONNECT, the following
tabs (Results Buying, Chance at Results, Best Use of $) and associated fields
appear in the Review, not the Request. If you do not have the Reviews
Module or ReviewerCONNECT, the tabs and the fields will be created in the

Request record.

Area Specific

Field Name

Label

Sustainability
Core_Know_How
Past_Achievement
Similiar_Groups
Individuals_With_lIssues

Issue_Challenge

Participants

Field Name

Sustainability

Core know-how

Achievements in past three years
Similar groups

Individual with issues

Issues to address

Label

Participant_Community

Partic_Few_Barriers

Partic_Few_Barriers_Notes

Partic_Mid_Barriers

Partic_Mid_Barriers_Notes

Partic_Many_Barriers

Partic_Many_Barriers_Notes

Partic_Example1
Partic_Example2
Partic_Example3

Partic_Num_To_Serve

Customizer Fields by Investment Type

Participants characteristics
Few barriers to results
Few barriers details

Mid barriers to results

Mid barriers details

Many barriers to results
Many barriers details
Participant example
Participant example
Participant example

Total to be served
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Field Name

Label

Total_to_be_served

Percent_with_many_barriers

Results

Field Name

Total to be served (calculated)

Percent with many barriers

Label

Results_Num1

Results_No_Program

Investment_per_result
Cost_Per_Result
Results_Statement1
Results_Verification

Results_Broader_Gains

Milestones

Number who will achieve the result

Number who would achieve this
regardless of the program

Investment per result
Cost per result
Results Statement
Results verification

Broader gains/ROI

Field Name Label

Milestones Milestones
Tracking

Field Name Label

Tracking_Info

Result_Longevity

Learning_Questions

162

Information you will use to track
progress of the project

Result longevity

What do you most want to learn?
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Approach

Field Name

Label

Project_Approach
Project_Evidence

Project_Assumptions

Key People

Field Name

Approach description
Evidence of success

Assumptions regarding intensity and
duration

Label

Key_Project_Lead

Key_Implementors

Key_Partners

Results Buying

Field Name

Person(s) leading the project and their
characteristics

Person(s) responsible for implementing
and their characteristics

Partners/Intermediaries

Label

Targets_Clear

Target_Level_High

Target_Approach_Effective

Section_1_Score_il
Target_Ranking

Target_Notes

Customizer Fields by Investment Type

Are project results clear and easily
verifiable?

Results set high enough relative to what
would happen without the program
and nature of participants?

Results clearly contribute to foundation
outcomes?

Section 1 score
Section 1 rank

Comments
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Chance at Results

Field Name Label

Rating_Key_People Do key people have attributes/
capabilities that predict success?

Rating_Mission_Alignment Clear alignment between organization
mission, intended program content
and the proposed results/approach?

Rating_Prior_Achievement Is prior achievement in a similar area
or population strong?

Rating_Strategy Is project clear in terms of needed
intensity/duration to get participants to
stated results?

Rating_Partners_Resources Are commitments clear from partners
or intermediaries?

Rating_Milestones Is the description of participant
progress (milestones) through the
program predictive of success?

Section_2_Score_il Section 2 score
Chance_at_Results_Ranking Section 2 rank
Chance_at_Results_Notes Comments

Best Use of $

Field Name Label

Use_of_Money_Reasonable Are the requested funds to achieve
results reasonable for this participant
group and project approach?

Use_of_Money_Clear Is it clear what our funds are paying for
and how that affects the results for this
project?

Use_of_Money_Future Are there broader gains or replication
possibilities that go beyond the project
itself?
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Field Name

Label

Section_3_Score_il
Use_of_Money_Ranking
Overall_Score_il
Use_of_Money_Notes

Proposal_Overall_Ranking

Final Num

Field Name

Section 3 score
Section 3 rank
Overall score
Comments

Overall rank

Label

Final_Num_Achieved1
Final_percent_who_achieved
Final_cost_per_results
Final_investment_per_results
Final_Num_Few_Barriers
Final_Num_Mid_Barriers
Final_Num_Many_Barriers
Final_Num_Served1

Final_Number_Served_calc

Final Success

Field Name

Participants achieving results
Final percent who achieved
Final cost per result

Final investment per result
Final number few barriers
Final number mid barriers
Final number many barriers
Final number served

Final number served (calculated)

Label

Final_Results_Grantee_SelfRate
Final_Results_Impediments

Five_Things_Different

Customizer Fields by Investment Type

Success in achieving results
Impediments to results

Five things doing differently
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Performance

Field Name Label

Performance_Rating How would you rate the grant
performance?

Rec_Next_Steps_Low Next investment steps for programs
rated low success

Rec_Next_Steps_Medium Next investment steps for programs
rated medium success

Rec_Next_Steps_High Next investment steps for programs
rated high success

Performance_Comments Comments on performance

Rec_Next_Steps_Comments Comments on recommendations

Achievement Building

Listed below are the fields used to track and report on outcomes data for
Achievement Building grants, or grants for organizations that deliver
programs and services. This Request Type contains the following tabs: Area
Specifics, Results, Milestones, Approach, and Key People. These tabs contain
fields that are defined in the following section.

Note: This Request Type also contains other tabs, including Final Success,
Performance, Results Buying, Chance at Results, and Best Use of $. These
tabs contain fields that are self-explanatory and thus are not included in this
section.
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Area Specifics Tab

% Request [New]

File Action Help
= Send Letter... [7 Write-up... L) Alert. . o fpprave... X Dedine...

Reviews  Area Specifics ] Results ] Milestones ] Approach ] ey People ] Final Success ] Performance ]

Suztainability

Caore Know-How

Achievements in past 3 pears

Similar Groups

Challenge or opportunity

The following information describes what data should be in each field of the
Area Specifics tab:

% Sustainability: This field should contain information that addresses
finances (such as trends, events, and other factors that influence the
organization’s financial viability), and leadership (including ability to
achieve success and past or anticipated replacement of key people).

% Core Know-How: This field should contain information regarding what
the organization does especially well in this area. This can include
knowledge, skills, and how well they are able to influence others to change
their behavior or conditions.

< Achievements in past 3 years: This field should contain information
describing how the organization has successfully served this group of
people in the past through other programs.

% Similar Groups: This field should contain information describing how the
organization is different from other groups involved in similar programs
which would lead you to want to invest in them.
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e

% Challenge or Opportunity: This field should state the challenge or
problem the grantee is trying to address in clear terms as it is experienced
by their participants.

Results Tab

% Request [New]

File | Action Help
=l Send Letter.. [g Whiteup...  £) Alert. + Approve... ¥ pecline...

Reviews ] Area Specifics " Resuls ] Milestanes ] Approach ] Key People ] Final Success ] Perfarmance ]

Mew capacity they will create

Results Statement

The following information describes what data should be in each field of the
Results tab:

< New capacity they will create: This field should contain information about
the best way to invest in the organization in order to increase human gain
and the organization’s sustained ability to provide it.

% Results Statement: This field should contain information about the change
in behavior and/ or conditions for people, and should articulate behaviors
and/or conditions rather than attitudes.
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Milestones Tab

L Request [Mew] El |§|PZ|

File | Action Help
=] Send Letter... {¢ Writeup... 2) Alert... of fpprove... X Dedine...

Reviews ] Area Specifics ] Results ' Milestores l Approach ] Key People ] Final Success ] Performance ]

Milestones

The following information describes what data should be in the field of the
Milestones tab:

< Milestones: The organization should either list their most critical activities
or simply state what they think predicts success. In addition, what will they
look for to confirm that their participants are on track?
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Approach Tab

% Request [New] EJ|§|PZ|

File | Action Help
[=] Send Letter. .. EWritg—up... 2 Alett... (nppmg\e... ¥ Decline. ..

Reviews ] Area Specifics ] Results ] Milestones Approach ] K.ey People ] Final Success ] Performance ]

It increased caosts, how will they be covered?

Critical changes to organization, policy, staff ar behavior

The following information describes what data should be in each field of the
Approach tab:

% Ifincreased costs, how will they be covered: This field should explain how
the organization will handle increased costs (e.g., maintaining a new
computer system, adding staff, increasing the number of program
participants, etc.).

% Critical changes to organization, policy, staft or behavior: This field can
contain a list of the organization changes (i.e., policies and practices) and
the specific behavioral changes that will be needed if the capability is to be
fully expressed.
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Key People Tab

ﬂ Request [New] EJ@|§|

File Action Help
=] Send Letter.,. ¢ Writeup,., ) Alert., o fpprove... X Dedline...

Reviews ] Area Specifics ] Results W Milestanes W Approach Final Success ] Performance ]

Characteristics of new stalf person or consultant

The following information describes what data should be in each field of the
Key People tab:

% Characteristics of new staff person or consultant: This field contains
information about any new staff people or consultants, including their
qualifications.

The following Customizer fields are automatically added to any Requests
for the Request Type associated with the Achievement Building investment
type. This section lists the Request tab name first, followed by the
Customizer field names and labels and in the tab.

Note: If you have the Reviews Module or ReviewerCONNECT, the following
tabs (Results Buying, Chance at Results, Best Use of $) and associated fields
appear in the Review, not the Request. If you do not have the Reviews
Module or ReviewerCONNECT, the tabs and the fields will be created in the
Request record.
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Area Specifics

Field Name

Label

Sustainability
Core_Know_How
Past_Achievement
Similiar_Groups

Issue_Challenge

Results

Field Name

Sustainability

Core know-how

Achievements in past three years
Similar groups

Challenge or opportunity

Label

New_Capacity_Improvment

Results_Statement1

New capacity that will be created

Results Statement

Milestones
Field Name Label
Milestones Milestones
Approach
Field Name Label

Cost_Implications

Org_Change_Required

If increased costs, how will they be
covered?

Critical changes to organization, policy,
staff or behavior
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Key People

Field Name

Label

Key_Project_Lead

Results Buying

Field Name

Characteristics of new staff person or
consultant

Label

Targets_Clear

Targets_Gains

Section_1_Score_ab
Target_Ranking

Target_Notes

Chance at Results

Field Name

Will new/added capacity lead to results
in at least one of the four areas:
reduced cost, increased revenue,
increased results, or decreased time to
get results?

Is relationship clear between project
results and gains anticipated for
participants with this new/added
capacity?

Section 1 score
Section 1 rank

Comments

Label

Rating_Key_People

Rating_Mission_Alignment

Rating_Milestones

Customizer Fields by Investment Type

Do the characteristics of new staff or
consultants clearly contribute to the
project success?

Is there a clear commitment to
implementing critical organization
changes?

Is the description of three to four steps
and related achievements predictive of
success?
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Field Name

Label

Section_2_Score_ab
Chance_at_Results_Ranking

Chance_at_Results_Notes

Best Use of $

Field Name

Section 2 score
Section 2 rank

Comments

Label

Use_of_Money_Reasonable

Use_of_Money_Clear

Use_of_Money_Future

Section_3_Score_ab
Use_of_Money_Ranking
Overall_Score_ab
Use_of_Money_Notes

Proposal_Overall_Ranking

Final Success

Field Name

Are the requested funds to create new
or added capacity reasonable?

Is it clear what our funds are paying for
and how these contribute to the
organization’s ability to achieve new or
added capacity?

If operating costs increase, is it clear
how these costs will be covered?

Section 3 score
Section 3 rank
Overall score
Comments

Overall rank

Label

Final_Results_Grantee_SelfRate
Final_Results_Impediments

Five_Things_Different

Success in achieving results
Impediments to results

Five things doing differently
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Performance

Field Name Label

Performance_Rating How would you rate the grant
performance?

Rec_Next_Steps_Low Next investment steps for programs
rated low success

Rec_Next_Steps_Medium Next investment steps for programs
rated medium success

Rec_Next_Steps_High Next investment steps for programs
rated high success

Performance_Comments Comments on performance

Rec_Next_Steps_Comments Comments on recommendations

Advancing Innovation

Listed below are the fields used to track and report on outcomes data for
Advancing Innovation grants, or grants for organizations that develop and
test new approaches to outperform existing practices. This Request Type
contains the following tabs: Area Specifics, Results, Milestones, Approach,
and Key People. These tabs contain fields that are defined in the following
section.

Note: This Request Type also contains other tabs, including Final Success,
Performance, Results Buying, Chance at Results, and Best Use of $. These
tabs contain fields that are self-explanatory and thus are not included in this
section.
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Area Specifics Tab

50 Request [New] E”El El

File Action Help

[ Send Letter... ¢ Writeup... ) Al o fpprave... X Dedine...

Reviews  Area Specifics l Results ] Milestones ] Approach ] k.ey Peaple ] Final Success ] Performance ]

Sustainability

Care Know-How

Achievements in past 3 years

Similar Groups

Problem or opportunity

The following information describes what data should be in each field of the
Area Specifics tab:

e
o

Sustainability: This field should contain information that addresses
finances (such as trends, events, and other factors that influence the
organization’s financial viability), and leadership (including ability to
achieve success and past or anticipated replacement of key people).

Core Know-How: This field should contain information regarding what
the organization does especially well in this area. This can include
knowledge, skills, and how well they are able to influence others to change
their behavior or conditions.

Achievements in past 3 years: This field should contain information
describing how the organization has successfully served this group of
people in the past through other programs.

Similar Groups: This field should contain information describing how the
organization is different from other groups involved in similar programs
which would lead you to want to invest in them.
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< Problem or Opportunity: This field should contain the data relating to the
issue or problem the grantee is going to tackle.

Results Tab

% Request [New] El |§|E|

File | Action Help
[=1Send Letter... 77 Writeup...  4) Alett.. | & Approve.. X Decdine...

Feviews ] Area Specifics " Results l Milestones ] Approach ] Key People ] Final Success ] Performance ]

Fesults Statement

The following information describes what data should be in the field on the
Results tab:

« Results Statement: This field should contain information about the desired
change in behavior and/or conditions for the program participants.
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Milestones Tab

5‘ Request [New] El |§|E|

File | Action Help
=l Send Letter... {¢ Writeup... 2) Alatt... (Approga...  Decline. ..

Reviews ] Area Specifice ] Results ' Milestores l Approach ] Key People ] Final Success ] Performance ]

Milestones

The following information describes what data should be in the field on the
Milestones tab:

% Milestones: The organization should either list their most critical activities
or simply state what they think predicts success. In addition, include what
will they look for to confirm that their participants are on track.
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Approach Tab

# Reguest [New] Q|E|E|

File | Action Help
[=1 Send Letter. .. @ertg—up... 2 alett... | & Approve... ¥ Decline. ..

Feviews ] Area Specifics ] Fiesults ] Milestones | Approach ] Key People ] Final Success ] Peiformance ]

Proposed innawvation

Evidence of success

Assumptions being tested

The following information describes what data should be in each field of the
Approach tab:

< Proposed innovation: This field should explain the approach or strategy
that the organization will use and how it is different from current practices.
It should highlight the ways the proposed innovation may produce
stronger results.

< Evidence of success: If the grantee has evidence of the success of their
approach, they should include in here.

< Assumptions being tested: This field contains the program’s assumptions,
which are critical in determining program success. It should include the
information you are expecting regarding the participants, the program
resources, and the participant/program connection.
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Key People Tab

L Request [Mew] El |§|gl

File | Action Help
=] Send Letter... {¢ Writeup... ) Alert... of fpprove.. X Dedine. .

Reviews ] Area Specifics ] Results ] Milestanes ] Approach | Key People ] Final Success ] Performance ]

Perzon wha will lead the praject and their characteristics

The following information describes what data should be in each field of the
Key People tab:

< Person who will lead the project and their characteristics: This field
contains information about the person leading the project and his or her
qualifications.

The following Customizer fields are automatically added to any Requests
for the Request Type associated with the Advancing Innovation investment
type. This section lists the Request tab name first, followed by the
Customizer field names and labels in the tab.

Note: Ifyou have the Reviews Module or ReviewerCONNECT, the following
tabs (Results Buying, Chance at Results, Best Use of $) and associated fields
appear in the Review, not the Request. If you do not have the Reviews
Module or ReviewerCONNECT, the tabs and the fields will be created in the
Request record.
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Area Specifics

Field Name Label
Sustainability Sustainability
Core_Know_How Core know-how
Past_Achievement Achievements in past three years
Similiar_Groups Similar groups
Issue_Challenge Problem or opportunity
Results
Field Name Label
Results_Statement1 Results Statement
Milestones
Field Name Label
Milestones Milestones
Approach
Field Name Label
Project_Approach Proposed innovation
Project_Evidence Evidence of success
Project_Assumptions Assumptions being tested
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Key People

Field Name

Label

Key_Project_Lead

Results Buying

Field Name

Person(s) who will lead the project and
their characteristics

Label

Targets_Clear

Target_Approach_Effective

Section_1_Score_ai
Target_Ranking
Target_Notes

Chance at Results

Field Name

Are project results clear?

Do the results clearly show the
effectiveness of the approach over
existing ones?

Section 1 score
Section 1 rank

Comments

Label

Rating_Key_People

Rating_Mission_Alignment

Rating_Prior_Achievement

Rating_Strategy

Rating_Milestones

182

Do key people have the attributes and
capabilities that predict success?

Is there clear alignment between the
issue/missed opportunity and proposed
results?

Does the evidence for the approach
suggest a reasonable promise of
success?

Do the assumptions clearly link action
and consequences of the project?

Are milestones clear and presumed
predictors of success?
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Field Name Label

Rating_Partners_Resources Do project assumptions clearly address
participant, program and/or resource
needs?

Section_2_Score_ai Section 2 score

Chance_at_Results_Ranking Section 2 rank

Use_of_Money_Notes Comments

Best Use of $

Field Name Label
Use_of_Money_Reasonable Is ‘cost of learning’ strong?
Use_of_Money_Clear Are there strong project level impact

potentials beyond specific results?

Use_of_Money_Future Are there reasonable impact
possibilities or replication that go
beyond the project?

Section_3_Score_ai Section 3 score
Use_of_Money_Ranking Section 3 rank
Overall_Score_ai Overall score
Chance_at_Results_Notes Comments
Proposal_Overall_Ranking Overall rank

Final Success

Field Name Label
Final_Results_Grantee_SelfRate Success in achieving results
Final_Results_Impediments Impediments to results
Five_Things_Different Five things doing differently
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Performance

Field Name Label

Performance_Rating How would you rate the grant
performance?

Rec_Next_Steps_Low Next investment steps for programs
rated low success

Rec_Next_Steps_Medium Next investment steps for programs
rated medium success

Rec_Next_Steps_High Next investment steps for programs
rated high success

Performance_Comments Comments on performance

Rec_Next_Steps_Comments Comments on recommendations

Capital Improvements

Listed below are the fields used to track and report on outcomes data for
Capital Improvement grants, or grants that are used to increase efficiency or
effectiveness in an organization. This Request Type contains the following
tabs: Area Specifics, Results, Milestones, Approach, and Key People. These
tabs contain fields that are defined in the following section.

Note: This Request Type also contains other tabs, including Final Success,
Performance, Results Buying, Chance at Results, and Best Use of $. These
tabs contain fields that are self-explanatory and thus are not included in this
section.
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Area Specifics Tab

* Request [New]

File Action Help

[=15end Letter... E Wiite-up... 2] Alert... | & Approve... ¥ Declire...

Feviews  Area Specifics ] Hesults] Milestones] Appmach] Key Peop\e] FinaISuccess] Perfolmance]

Sustainability

Core Know-How

Achievements past 3 years

Similar Groups

Challengs o oppartunity

The following information describes what data should be in each field of the
Area Specifics tab:

K3
”

Sustainability: This field should contain information that addresses
finances (such as trends, events, and other factors that influence the
organization’s financial viability), and leadership (including ability to
achieve success and past or anticipated replacement of key people).

Core Know-How: This field should contain information regarding what
the organization does especially well in this area. This can include
knowledge, skills, and how well they are able to influence others to change
their behavior or conditions.

Achievements in past 3 years: This field should contain information
describing how the organization has successfully served this group of
people in the past through other programs.

Similar Groups: This field should contain information describing how the
organization is different from other groups involved in similar programs
which would lead you to want to invest in them.
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< Challenge or opportunity: This field should state the challenge or problem
the grantee is trying to address in clear terms as it is experienced by their

participants.

Results Tab

5% Reqguest [New] EJ'E'E'

File | Action Help
[=15end Letter... @ write-up... ) Alert...

| Resul

Feviews ] Area Specifics

Results Statement

o Approve... X Declne...

] Iilestanes ] Approach ] Key People ] Final Success ] Ferfoimance ]

The following information describes what data should be in each field of the

Results tab:

% Results Statement: This field should contain information about the desired
change in behavior and/or conditions for the program participants.
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Milestones Tab

ﬂ Request [New] El ‘Elgl

File | Action Help
=] Send Letter.,. ¢ Writeup,., ) Alert., o fpprove... X Dedline...

Reviews ] Area Specifics ] Results ' Milestones ] Approach ] K.ey People ] Final Success ] Performance ]

Milestones

The following information describes what data should be in the field on the
Milestones tab:

< Milestones: The organization should either list their most critical activities
orsimply state what they think predicts success. In addition, what will they
look for to confirm the participants are on track.
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Approach Tab

0 Request [New] E“El El

File | Action Help
[=] Send Letter. .. @Writg—up... ) alert... | & Approve... ¥ Dedline. ..

Reviews ] Area Specifics ] Results ] Milestones | Approach ] Key People ] Final Success ] Performance ]

Froposed Capital Improvement

Cost Implications

Cost Savings Steps

Critical changes in organization, policy, staff or behavior

The following information describes what data should be in each field of the
Approach tab:

< Proposed Capital Improvement: This field should contain information
from the grantee that specifically describes the capital improvement in
terms of equipment, square feet of space, etc., that will be used to increase
the effectiveness of the organization and/or program.

% CostImplications: This field should contain information that explains how
increased operation costs will be incorporated into the organization’s
annual operating budget.

< Cost Savings Steps: This field should contain specific information on what
has been done or will be done to ensure the best value or lowest costs are
obtained.

% Critical changes in organization, policy, staff or behavior: This field can
contain a list of the organizational changes (i.e., changes in policies and
practices) and the specific behavioral changes that will be needed to be

successful in achieving the stated results.
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Key People Tab

L Request [Mew] glﬁ‘g|

File | Action Help
= Send Letter... 7 Write-up... L) Alert. . o fpprave... X Decine...

Reviews W Area Specifics ] Results ] Milestanes ] Approach 1 Key People ] Final Success ] Performance ]

Perzon wha will lead the praject and their characteristics

The following information describes what data should be in each field of the
Key People tab:

% Person who will lead the project and their characteristics: This field
contains information about the person leading the project and his or her
qualifications.

The following Customizer fields are automatically added to any Requests
for the Request Type associated with the Capital Improvements investment
type. This section lists the Request tab name first, followed by the
Customizer field names and labels in the tab.

Note: Ifyouhave the Reviews Module or ReviewerCONNECT, the following
tabs (Results Buying, Chance at Results, Best Use of §) and associated fields
appear in the Review, not the Request. If you do not have the Reviews
Module or ReviewerCONNECT, the tabs and the fields will be created in the
Request record.
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Area Specifics

Field Name

Label

Sustainability
Core_Know_How
Past_Achievement
Similiar_Groups

Issue_Challenge

Results

Field Name

Sustainability

Core know-how

Achievements in past three years
Similar groups

Challenge or opportunity

Label

Results_Statement1

Results Statement

Milestones
Field Name Label
Milestones Milestones
Approach
Field Name Label

Project_Approach
Cost_Implications
Cost_Savings_Steps

Org_Change_Required

Proposed capital improvement
Cost implications
Cost savings steps

Critical changes in organization, policy,
staff or behavior
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Field Name

Using Outcomes Plus

Label

Key_Project_Lead

Results Buying

Field Name

Person(s) who will lead the project and
their characteristics

Label

Targets_Clear

Targets_Gains

Section_1_Score_ci
Target_Ranking
Target_Notes

Chance at Results

Field Name

Are project results clear and verifiable?

Does the capital improvement project
address an increase in gains for those
they served?

Section 1 score
Section 1 rank

Comments

Label

Rating_Key_People

Rating_Mission_Alignment

Rating_Timing

Rating_Milestones

Section_2_Score_ci

Chance_at_Results_Ranking

Customizer Fields by Investment Type

Does the person responsible have the
attributes and capabilities that predict
success?

Is it clear the organization will
implement any changes in approach or
staff to be successful?

Is the timing right?

Is the description of three to four steps
predictive of success?

Section 2 score

Section 2 rank
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Field Name Label

Chance_at_Results_Notes Comments
Best Use of $

Field Name Label

Use_of_Money_Reasonable

Use_of_Money_Clear

Use_of_Money_Future

Use_of_money_savings

Section_3_Score_ci
Use_of_Money_Ranking
Overall_Score_ci
Use_of_Money_Notes

Proposal_Overall_Ranking

Final Success

Field Name

Are the requested funds reasonable for
the project?

Is it clear what our funds are paying for?

If there will be an increase in operating
costs, is it clear how they will cover these
costs in the future?

Have they taken appropriate cost saving
steps?

Section 3 score
Section 3 rank
Overall score
Comments

Overall rank

Label

Final_Results_Grantee_SelfRate
Final_Results_Impediments

Five_Things_Different

Success in achieving results
Impediments to results

Five things doing differently
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Performance

Field Name

Label

Performance_Rating
Rec_Next_Steps_Low
Rec_Next_Steps_Medium
Rec_Next_Steps_High

Performance_Comments

Rec_Next_Steps_Comments

Policy or Advocacy

How would you rate the grant
performance?

Next investment steps for programs rated
low success

Next investment steps for program rated
medium success

Next investment steps for programs rated
high success

Comments on performance

Comments on recommendations

Listed below are the fields used to track and report on outcomes data for

Policy or Advocacy grants, or grants that are used to change the institutional
structures, underlying conditions, or policies and practices that influence the
likelihood of improved outcomes in their area of interest. This Request Type

contains the following tabs: Area Specifics, Project, Results, Milestones,

Approach, and Key People. These tabs contain fields that are defined in the

following section.

Note: This Request Type also contains other tabs, including Final Success,

Performance, Results Buying, Chance at Results, and Best Use of $. These
tabs contain fields that are self-explanatory and thus are not included in this

section.

Customizer Fields by Investment Type
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Area Specifics Tab

% Request [New] E'E‘ El

File Action Help

Area Specifics ] Fioject ] Fesults ] Milestones ] Approach ] Key People ] Final Success ] Performance ]

[=1 Send Letter... a wirite-up... ) Alert... | & Approve... ¥ Dedire. ..

Sustainability

Core Know-How

Achievements in past 3 years

Similar Groups

The following information describes what data should be in each field of the
Area Specifics tab:

K3
o

Sustainability: This field should contain information that addresses
finances (such as trends, events, and other factors that influence the
organization’s financial viability), and leadership (including ability to
achieve success and past or anticipated replacement of key people).

Core Know-How: This field should contain information regarding what
the organization does especially well in this area. This can include
knowledge, skills, and how well they are able to influence others to change
their behavior or conditions.

Achievements in past 3 years: This field should contain information
describing how the organization has successfully served this group of
people in the past through other programs.

Similar Groups: This field should contain information describing how the
organization is different from other groups involved in similar programs
which would lead you to want to invest in them.
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Project Tab

% Regquest [New] EJ@@

File | Action Help
[=1 Send Letter... aWritg-up... 2 Alert... (npprnge... ¥ Deciire. ..

#rea Specifics  Project ] Fesults ] Milestones ] Approach ] Key People ] Final Success ] Performance ]

Population ar community to help

Iszue to address

The following information describes what data should be in each field of the
Project tab:

< Population or community to help: This field should contain information
that describes the persons or groups that are not effectively served by
existing programs but will benefit from this program.

% Issue to address: This field should contain important problems or
constraints that people face, and funding streams, delivery mechanisms or
other large factors or forces that operate independently of individuals or
household behavior.
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Results Tab

L Request [New]

File | Action Help

=l Send Letter... g Writeup... ) Alert.. +f Approve... X Declre...

rea 5pecifics Toject esults lestones pproac ey People inal Success erformnance
Area 5pecif F Result il A h | Key Peopl Final 5 Perf

Results Statement

Results Short Tem Improvement or change in system

The following information describes what data should be in each field of the
Results tab:

Results Statement: This field should contain information about the desired
change in behavior and/or conditions for the program participants.

Results Short Term: This field should contain information that describes
the three or four critical steps that will indicate that the organization’s
initiative is on the path to success.

Improvement or change in system: This field should contain details on
how the system will be different if the program is a success and whether
this program will result in any new regulations or policy changes.
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Milestones Tab

] Request [New] El |§|Pz|

File | Action Help

=] Send Letter... 77 Writeup... 4J Alatt... ( approve... ¥ Dedine...

Area Specifice ] Praject ] Results " Milestores ] Approach ] Key People ] Final Success ] Performance ]

Milestones

The following information describes what data should be in the field on the
Milestones tab:

< Milestones: The organization can either list their most critical activities or
simply state what they think predicts success. In addition, what will they
look for to confirm the participants are on track?
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Approach Tab

ﬁ Request [New] El |§‘PX|

File | Action Help

= Send Letter... [7 Write-up... L) Alert. . o fpprave... X Dedine...

Area Specifics ] Praject ] Results ] Milestones Approach ] K.ey People ] Final Success ] Performance ]

Strategy or Approach

The following information describes what data should be in the field on the
Approach tab:

% Strategy or Approach: This field should contain information on the
organization’s particular way of solving a problem and why the
organization thinks it is the best way to encourage participants and help
them succeed.
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Key People Tab

* Regquest [Mew]

Filz | Action Help
=] Send Letter... 77 Writeup,..  £) Al + Approve... ¥ Decline...

Area Specifics W Project ] Results W Milestanes W Approach | ey People ] Final Success ] Perfarmance ]

Perzons responzible for leading the project and their characteristics

Partners/lntermediaries

The following information describes what data should be in each field of the
Key People tab:

< Person responsible for leading the project and their characteristics: This
field contains information about the person leading the project and his or
her qualifications.

% Partners/Intermediaries: The information in this field should focus on
those groups who have to play a role for the organization to be successful
and on their commitments to play that role.

The following Customizer fields are automatically added to any Requests
for the Request Type associated with the Policy or Advocacy investment
type. This section lists the Request tab name first, followed by the
Customizer field names and labels in the tab.

Note: If you have the Reviews Module or ReviewerCONNECT, the following
tabs (Results Buying, Chance at Results, Best Use of $) and associated fields
appear in the Review, not the Request. If you do not have the Reviews
Module or ReviewerCONNECT, the tabs and the fields will be created in the
Request record.
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Area Specifics

Field Name Label
Sustainability Sustainability
Core_Know_How Core know-how
Past_Achievement Achievements in past three years
Similiar_Groups Similar groups

Project
Field Name Label

Participant_Community Population or community to help

Issue_Challenge Issue to address
Results

Field Name Label

Results_Statement1 Results Statement

Results_Short_Term Results short term

New_Capacity_Improvment Improvement or change in system

Milestones

Field Name

Label

Milestones

200

Milestones
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Approach
Field Name Label
Project_Approach Strategy or approach
Key People
Field Name Label

Key_Implementors

Key_Partners

Results Buying

Field Name

Person(s) responsible for leading the
project and their characteristics

Partners/Intermediaries

Label

Targets_Clear

Targets_Gains

Target_Level_High

Target_Approach_Effective

Section_1_Score_policy
Target_Ranking

Target_Notes

Customizer Fields by Investment Type

Are project results clear and verifiable?

Are the results reasonable to achieve th
change in the system or condition they
want to bring about?

Are project results set at a high enough
level relative to the nature of the
population or community?

e

Do the expected results clearly show the

potential effectiveness of this approach

over existing ones to achieve the results?

Section 1 score
Section 1 rank

Comments
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Chance at Results

Field Name

Label

Rating_Prior_Achievement

Rating_Key_People

Rating_Mission_Alignment

Rating_Milestones

Rating_Partners_Resources

Rating_Strategy

Rating_Timing

Section_2_Score_policy

Chance_at_Results_Ranking

Chance_at_Results_Notes

Best Use of $

Field Name

Are recent accomplishments in a similar
area strong?

Do key people have the attributes and
capabilities that predict success?

Is there clear alignment between the
organization’s mission and the project?

Is the description of three to four critical
steps and achievements predictive of
success?

Are the commitments clear from partners
or intermediaries?

Is the overall strategy or method of
approach logical to achieve the stated
results?

Is the timing right?
Section 2 score
Section 2 rank

Comments

Label

Use_of_Money_Reasonable

Use_of_Money_Clear

Section_3_Score_Policy

Use_of_Money_Ranking

Are the requested funds reasonable to
achieve results?

Is it clear what our funds are paying for
and how that affects the ability to achieve
results?

Section 3 score

Section 3 rank
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Field Name Label
Overall_Score_policy Overall score
Use_of_Money_Notes Comments
Proposal_Overall_Ranking Overall rank

Final Success

Field Name Label

Final_Results_Grantee_SelfRate Success in achieving results

Final_Results_Impediments Impediments to results

Five_Things_Different Five things doing differently

Performance

Field Name Label

Performance_Rating How would you rate the grant
performance?

Rec_Next_Steps_Low Next investment steps for programs rated
low success

Rec_Next_Steps_Medium Next investment steps for programs rated

medium success

Rec_Next_Steps_High Next investment steps for programs rated
high success

Performance_Comments Comments on performance

Rec_Next_Steps_Comments Comments on recommendations

Applied Research

Listed below are the fields used to track and report on outcomes data for
Applied Research grants, or grants that are used by organizations to
generate, analyze, and interpret data to identify problems, causalty, and
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solutions. This Request Type contains the following tabs: Area Specifics,
Participants, Project, Results, Milestones, Approach, and Key People. These
tabs contain fields that are defined in the following section.

Note: This Request Type also contains other tabs, including Final Success,
Performance, Results Buying, Chance at Results, and Best Use of §. These
tabs contain fields that are self-explanatory and thus are not included in this
section.

Area Specifics Tab

t Request [New] E“E‘ El

File Action Help

[=] Send Letter... aWritg-up... ) alert... | & Approve.., ¥ pedine. ..
Area Specifics ] Participants W Project ] Results W Milestanes W Approach ] ey People W Final Success)
Sustainability
‘I
Core Know-How

Specific izsue to address

Achievements in past 3 years

Similar Groups

The following information describes what data should be in each field of the
Area Specifics tab:

+ Sustainability: This field should contain information that addresses
finances (such as trends, events, and other factors that influence the
organization’s financial viability), and leadership (including ability to
achieve success and past or anticipated replacement of key people).

% Core Know-How: This field should contain information regarding what
the organization does especially well in this area. This can include
knowledge, skills, and how well they are able to influence others to change
their behavior or conditions.
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< Achievements in past 3 years: This field should contain information
describing how the organization has successfully served this group of
people in the past through other programs.

% Similar Groups: This field should contain information describing how the
organization is different from other groups involved in similar programs
which would lead you to want to invest in them.

Participants Tab
ﬁ Request [New] Q|E|E|

File | Action Help
= Send Letter... 7¢ Writeup... 2J Alatt... +f tpprove.. X Dedine...

Area Specifics Participarts ] Praject ] Results ] Milestones ] Approach ] Key People ] Final Success 1

Participant Community

The following information describes what data should be in the field on the
Participants tab:

K3

% Participant Community: This field should contain information that
describes the persons or groups that the organization thinks is not
effectively covered or well served by existing systems or conditions.
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Project Tab

# Request [New] Ellﬁl@

File | Action Help

=1 Send Letter... @ Write-up... ) Alert... ( Approve... X Decline...

Area Specifics ] Participants | Froject ] Resultz ] Milestones ] Approach ] ey Penple ] Final Success -

Critical Audiences

The following information describes what data should be in the field on the
Project tab:

% Critical Audiences: This field should contain information about who will
use the organization’s research to change their behavior or practices.
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Results Tab

% Request [New] E“E El

File | Action Help
[=] Send Letter... EWritg-up... halert.. | of Approve.. W Decline...

Area Specwfics] Participanlsw F‘roiect. Results ] Mi\estnnesw Approach] Key F‘eoplew Final Success ]

Results Statement

Impact expected by the end of grant

The following information describes what data should be in each field of the
Results tab:

4 Results Statement: This field should contain information about the desired
change in behavior and/or conditions for the program participants.

< Impactexpected by the end of grant: This field should contain information
that focuses on interim results or milestones during the life of the grant
that predict later success.
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Milestones Tab

ﬁ Request [New] El |§‘PX|

File | Action Help

= Send Letter... [7 Write-up... L) Alert. . o fpprave... X Dedine...

Area Specifics ] Participants ] Praoject W Results Milestones ] Approach ] K.ey People W Final Success ]

3to 4 Critical Steps

The following information describes what data should be in the field on the
Milestones tab:

% 3 to 4 Critical Steps: This field should contain information that describes
the three or four critical steps that will indicate that the organization’s
initiative is on the path to success.
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Approach Tab
0 Request [New] E“Elg|

File | Action Help
[=1 Send Letter. .. EEWr\tg—up... ) alert... (npproga... ¥ Dedline. ..

Participanlsw Proiect] Hesullsw Milestones | i| Key Peoplew FinaISuccessw Performance]

Research guestions to answer

Research method and data sources

The following information describes what data should be in each field of the
Approach tab:

< Research questions to answer: This field should contain information on
what specific research questions the organization intends to answer.

< Research method and data sources: This field should contain information
on the research methods the organization intends to use and what data
sources the organization will reference.
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Key People Tab

* Request [Mew] Q|E|E|

File | Action Help
= Send Letter... 7¢ Writeup,.. £} Alert., o Approve... ¥ Declne...
Participants ] Praoject ] Results ] Milestones ] Approach Key People ] Final Success ] Performance ]

Persons rezpongible for leading the project and their
characteristics Partners/Intermediaries

The following information describes what data should be in each field of the
Key People tab:

< Persons responsible for leading the project and their characteristics: This
field contains information about the person leading the project and his or
her qualifications.

% Partners/Intermediaries: The information in this field should focus on
those groups who have to play a role for the grantee to be successful and
on their commitments to play that role.

The following Customizer fields are automatically added to any Requests
for the Request Type associated with the Applied Research investment type.
This section lists the Request tab name first, followed by the Customizer
field names and labels in the tab.

Note: Ifyou have the Reviews Module or ReviewerCONNECT, the following
tabs (Results Buying, Chance at Results, Best Use of $) and associated fields
appear in the Review, not the Request. If you do not have the Reviews
Module or ReviewerCONNECT, the tabs and the fields will be created in the
Request record.
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Field Name

Using Outcomes Plus

Label

Sustainability
Core_Know_How
Issue_Challenge
Past_Achievement

Similiar_Groups

Participants

Field Name

Sustainability

Core know-how

Specific issue to address
Achievements in past three years

Similar groups

Label

Participant_Community

Project

Field Name

Participant community

Label

Project_Audiences

Results

Field Name

Critical audiences

Label

Results_Statement1

Results_Short_Term

Milestones

Field Name

Results Statement

Impact expected by the end of grant

Label

Milestones

Customizer Fields by Investment Type

Three to four critical steps

211



1 0 Using Outcomes Plus

Approach

Field Name

Label

Learning_Questions

Project_Approach

Key People

Field Name

Research questions to answer

Research method and data sources

Label

Key_Implementors

Key_Partners

Results Buying

Field Name

Persons responsible for leading the
project and their characteristics

Partners/Intermediaries

Label

Targets_Clear

Target_Level_High

Target_Approach_Effective

Section_1_Score_ar
Target_Ranking

Target_Notes

212

Are the project results clear and
verifiable?

Are project results set at a high enough
level relative to the nature of the
population or community and the critical
audiences who will use the research?

Do the anticipated results clearly show
the potential effectiveness of this
approach over existing ones to achieve
the results?

Section 1 score
Section 1 rank

Comments
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Chance at Results

Field Name

Label

Rating_Key_People

Rating_Mission_Alignment

Rating_Prior_Achievement

Rating_Partners_Resources

Rating_Milestones

Section_2_Score_ar
Chance_at_Results_Ranking

Chance_at_Results_Notes

Best Use of $

Field Name

Do key people have the attributes and
capabilities that predict success?

Is there clear alignment between the
organization’s mission, the project and
the research methods to be used?

Are recent accomplishments in a similar
area strong?

If the project is dependent on partners or
intermediaries for success, are the
commitments from these players clear
and agreed to?

Is the description of the three to four
critical steps and achievements
predictive of success?

Section 2 score
Section 2 rank

Comments

Label

Use_of_Money_Reasonable

Use_of_Money_Clear

Section_3_Score_ar

Use_of_Money_Ranking

Overall_Score_ar

Customizer Fields by Investment Type

Are the requested funds reasonable to
achieve results?

Is it clear what our funds are paying for
and how it affects the ability to achieve
results?

Section 3 score
Section 3 rank

Overall score
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Field Name Label

Use_of_Money_Notes Comments

Proposal_Overall_Ranking Overall rank
Final Success

Field Name Label

Final_Results_Grantee_SelfRate
Final_Results_Impediments

Five_Things_Different

Performance

Field Name

Success in achieving results
Impediments to results

Five things doing differently

Label

Performance_Rating
Rec_Next_Steps_Low
Rec_Next_Steps_Medium
Rec_Next_Steps_High

Performance_Comments

Rec_Next_Steps_Comments
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How would you rate the grant
performance?

Next investment steps for programs rated
low success

Next investment steps for programs rated
medium success

Next investment steps for programs rated
high success

Comments on performance

Comments on recommendations
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Requirement Customizer Fields

The following Customizer fields are automatically added to Requirements
on the Interim tab: Is the project on track, Course Correction, and Issues, as
the image below demonstrates.

45 Grant Requirement [18082] Elil@

File Action Help
Save and Close Mark as Done

sctiviy | Longhotes | ntein |

Is the project on 1ack? [(loney 7]

Course Comection lssugs

Additional fields will be added to the Interim tab if you have selected the
Improving Lives (Direct Service) investment type during the Outcomes Plus
installation process. These fields will display for all investment types but are
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specific to tracking outcomes for the Improving Lives (Direct Service)

investment type.

Ele Action Help
Save and Close Mark as Done

ity | Long Notes e |

lsthe paieston taek? [oonsy v

Course Correction Issues

B Grant Requirement [18082] Elil@

Those served with few bariers

0 ;

These served midrange bariers [~ Q2]

These served vith mary bariers [~ Q2]
Thase achieving resulls

Total Served to Date ofFl [ of
Total Served to Date (calculated) |0

Note: In the table below, field names with an asterisk next to them are only
added if you have selected the Improving Lives (Direct Service) investment
type during the Outcomes Plus installation process.

Interim  This tab contains the following field names and labels.

Field Name

Label

On_Track
On_Track_Course_Correction
On_Track_Issues

* Interim_Num_Few_Barriers

* Interim_Num_Mid_Barriers

* Interim_Num_Many_Barriers

* Interim_Num_Served

* Total_Served_to_Date_calculated

* Interim_Num_Results1

Is the project on track?

Course Correction

Issues

Those served with few barriers
Those served mid-range barriers
Those served with many barriers
Total Served to Date

Total Served to Date (calculated)

Those achieving results
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Code Tables

Code Tables

Outcomes Code Table

During the Outcomes Plus installation process, a new code table is added to
your Coding Sheets called Outcomes. The image below displays the new
Outcomes code table.

‘;?-"-'E-Cu de Maintenance [Outcomes]

File | Action  Help

Oww R E = 2 v |

iy .
== Table Mainienance

Select ltem
Loding Shests ] System ] l—_
Results 1
Table L3 tpproach 1

Age Group

Auspices

Budget Cammittee
Conference Board
Declination Classifications
Ethnicity

Fund

Gender

Geaographical Area Serves
Internal Program
Organization Type
Outcome:

185
Paopulation Served
Program Area

Recipient User T able 1
Recipient User Table 2
Recipient User Table 3

The Outcomes code table contains three levels. You can select up to five
codes for each request. Once you have defined the coding sheet information,
you can add the Outcomes category (code table) to the Request coding
sheet. For more information, see “Maintaining Codes” on page 19 of the
GIFTS Administrator’s Guide.

Note: By default, this code table will not be added to the Request coding sheet.
For more information, see “Coding Sheet Preferences” on page 61 of the
GIFTS Administrator’s Guide.
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Request Giving Program, Type, Status Code Table

If you select ‘New’ as the Request Type to associate to the investment type
when installing Outcomes Plus, the investment type and the status will be
added to the Giving Program, Type and Status system code table. If you did
not associate any of the investment types with a new Request Type, then no
changes will be made to the code table.

The image below displays the updated Giving Program, Type, Status code
table.

Eile Action Help
Oter B2HE =2 = + | Fnd
N Select [tem
Coding Shests  Swystem ] .
HErimpraving Lives
L[ Pending Review
et =1 Considered far Board
|| Activity Type 2 Active Grant
|__|Branch / Divisian L[= Closed Grant
Contact Role HErAchievement Building
|| Contact Type L[ Pending Review
| county =1 Considered for Board
o . =1 Active Grant
|| Declination Reason L& Closed Grart
|__|Degres HErddvancing Innovation
| |Discipline L[ Pending Review
| |Donor Class 21 Considered for Board
Donar Gift Type 3 Active Grant
I | Fom L= Closed Grant
1 HErCapital Improvement
G0 Accnunts L[ Pending Review
=1 Considered far Board
[ arng Lis 2l Active Grant
| |Match Hold Reason L= Closed Grant
| |Occupatian HeErPalicy or Advacacy
| |Organization Class ’E EE"diSD F‘dﬁ;’ie'g 4
=l Considered for Boar
Payment Type =1 Active Grant
L1 Closed Grant
HeErapplied Research
L[S Pending Review
=1 Considered far Board E|
=1 Active Grant
=1 Closed Grant e

Outcomes Plus Review Stages
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If you have the Reviews Module or ReviewerCONNECT, the following
internal Review Stages are added during the Outcomes Plus installation,
depending on the investment types selected during installation. If any

investment types are not selected, the associated internal Review Stage is not
added.

e

< Proposal Review - Achievement Building

Outcomes Plus Review Stages
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< Proposal Review - Advancing Innovation
% Proposal Review - Applied Research

< Proposal Review - Capital Improvement
% Proposal Review - Policy or Advocacy

% Proposal Review - Improving Lives

For the review stages added above, the following tabs will also be added to
the Review: Results Buying, Chance at Results, and Best Use of $. For a list
of the specific fields with these tabs, refer to “Customizer Fields by
Investment Type” on page 151.

Outcomes Plus Views and Saved Searches

Organizer Views allow you to combine and save Organizer display settings,
including column headings, column widths, sorts, saved searches, and
printing options. During the Outcomes Plus installation process, certain
Views and associated saved searches are added to GIFTS based on the
investment types selected.

The following section details the Views added for each investment type
selected and the saved search applied to each View for Requests, Reviews,
and Requirements. There is also a section which lists all the saved searches
and the criteria for these searches.

For more information about Views, see “Using Organizer Views” on page 65
of the GIFTS User’s Guide. For more information about saved searches, see
“Using Saved Searches” on page 99 of the GIFTS User’s Guide.

For more information about the Customizer fields added during the
Outcomes Plus installation process, please see “Customizer Fields by
Investment Type” on page 151.

Note: Blank fields under Column Heading indicate a combined column.
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Request Views

The following section details the Views added for Requests and the saved
search applied to each View, depending on the investment types selected
during the Outcomes Plus installation process.

Important: The saved search applied to each View assumes the creation of new
Request Types when setting up Outcomes Plus. If you chose to add the
fields to existing Request Types, the saved search associated to each View
will need to be modified manually.

Note: If you have the Reviewers Module or ReviewerCONNECT, the Views
with an asterisk (*) next to them appear in the Reviews folder instead of the
Requests folder.

Achievement Building View This view contains the following fields and
column headings.

Field Name Column Heading
Request: Organization, Contact, Phone Organization
Request: Project Title Project Title

Coding Sheet: Program Area Program Area

Coding Sheet: Outcomes Result Area

Request: Request Amount Request Amount
Request: Issue Challenge Issue or Challenge
Request: New Capacity Improvement New Capacity
Request: Results Statement1 Results Statement
Request: Milestones Milestones

This view includes the Achievement Building Pending saved search, which
filters Requests that have a Disposition of ‘Pending’, and a Request Type of
‘Achievement Building.’

Outcomes Plus Views and Saved Searches
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Advancing Innovation View This view contains the following fields and

column headings.

Field Name

Column Heading

Request: Organization, Contact, Phone
Request: Project Title

Coding Sheet: Program Area

Coding Sheet: Outcomes

Request: Request Amount

Request: Project Description

Request: Issue Challenge

Request: Project Approach

Request: Results Statement1

Request: Milestones

Organization

Project Title

Program Area

Results Area

Request Amount

Project Description
Challenge or Opportunity
Project Approach

Results Statement

Milestones

This view includes the Advancing Innovation Pending saved search, which
filters Requests that have a Disposition of ‘Pending’, and a Request Type of

‘Advancing Innovation.’

Applied Research View This view contains the following fields and

column headings.

Field Name

Column Heading

Request: Organization, Contact, Phone
Request: Project Title

Coding Sheet: Program Area

Coding Sheet: Qutcomes

Request: Request Amount

Request: Issue Challenge

Request: Participant Community

Outcomes Plus Views and Saved Searches

Organization
Project Title
Program Area
Result Area
Request Amount
Issue or Challenge

Population to Help
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Field Name

Column Heading

Request: Project Audiences
Request: Project Approach

Request: Results Statement1
Request: Results Short Term

Request: Milestones

Project Audiences

Research Question and Approach
Results Statement

Results Short Term

Milestones

This view includes the Applied Research Pending saved search, which filters
Requests that have a Disposition of ‘Pending’, and a Request Type of

Applied Research.’

Capital Improvement View This view contains the following fields and

column headings.

Field Name

Column Heading

Request: Organization, Contact, Phone
Request: Project Title

Coding Sheet: Program Area

Coding Sheet: Outcomes

Request: Request Amount

Request: Project Description

Request: Issue Challenge

Request: Project Approach

Request: Results Statement1

Request: Milestones

Organization
Project Title
Program Area
Result Area
Request Amount
Project Description
Issue or Challenge
Project Approach
Results Statement

Milestones

This view includes the Capital Improvement Pending saved search, which
filters Requests that have a Disposition of ‘Pending’, and a Request Type of

‘Capital Improvement.’
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Improving Lives View This view contains the following fields and column

headings.

Field Name

Column Heading

Request: Organization, Contact, Phone
Request: Project Title

Coding Sheet: Program Area

Coding Sheet: Outcomes

Request: Request Amount

Request: Issue Challenge

Request: Participant Community
Request: Pct w many barriers

Request: Results Statement1

Request: Milestones

Organization

Project Title

Program Area

Result Area

Request Amount

Issue or Challenge
Participant Community
Percent with many barriers
Results Statement

Milestones

This view includes the Improving Lives Pending saved search, which filters
Requests that have a Disposition of ‘Pending’, and a Request Type of

‘Improving Lives.’

Policy or Advocacy View This view contains the following fields and

column headings.

Field Name

Column Heading

Request: Organization, Contact, Phone
Request: Project Title

Coding Sheet: Program Area

Coding Sheet: Qutcomes

Request: Request Amount

Request: Issue Challenge

Request: Participant Community

Outcomes Plus Views and Saved Searches

Organization
Project Title
Program Area
Result Area
Request Amount
Issue or Challenge

Participant Community
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Field Name

Column Heading

Request: Project Approach
Request: Results Statement1
Request: Results Short Term

Request: Milestones

Project Approach
Results Statement
Results Short Term

Milestones

This view includes the Policy or Advocacy Pending saved search, which
filters Requests that have a Disposition of ‘Pending’, and a Request Type of

‘Policy or Advocacy.’

* End of Grant Summary View (Excludes Improving Lives) This view
contains the following fields and column headings.

Field Name

Column Heading

Organization: Name
Organization: City

Organization: State

Request: Project Title

Request: Grant Amount

Request’s Coding Sheet: Program Area
Request’s Coding Sheet: Outcomes
Request’s Coding Sheet: Outcomes
Request: Results Statement1
Review: Results Short Term
Review: Proposal Overall Ranking
Request: Performance Rating

Request: Performance Comments

Organization, Location, Project Title

Grant Amount

Program Area

Outcome Addressed
Result Area

Project Results

Results Short Term
Proposal Ranking

End of Grant Performance

Performance Comments
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This view includes the End of Grant Reports (Excludes Improving Lives)
saved search, which filters Requests that have a Disposition of ‘Pending’, and
a Request Type of ‘Achievement Building’, Advancing Innovation’, ‘Capital
Improvement’, ‘Policy or Advocacy’, or ‘Applied Research.’

* End of Grant Summary View (Improving Lives) This view contains the
following fields and column headings.

Field Name Column Heading

Organization: Name Organization, Location, Project Title
Organization: City
Organization: State

Request: Project Title

Request: Grant Amount Grant Amount

Request’s Coding Sheet: Program Area Program Area

Request’s Coding Sheet: Outcomes Outcome Addressed
Request’s Coding Sheet: Outcomes Result Area

Request: Results Statement1 Project Results

Review: Proposal Overall Ranking Proposal Ranking
Request: Performance Rating End of Grant Performance
Request: Performance Comments Performance Comments

This view includes the End of Grant Reports (Improving Lives) saved search,
which filters Requests that have a Disposition of ‘Pending’, and a Request
Type of Improving Lives.’

* Pending Requests with Ranking (Improving Lives) This view contains
the following fields and column headings.

Field Name Column Heading

Organization: Name Organization, Location

Organization: City

Outcomes Plus Views and Saved Searches 225



10

226

Using Outcomes Plus

Field Name

Column Heading

Organization: State
Organization: Total Grant Amount

Request: Request Amount

Request’s Coding Sheet: Program Area

Request’s Coding Sheet: Outcomes
Request: Project Title

Request: Results Statement1
Request: Results Num1

Request: Pct w many barriers
Request: Investment per result
Review: Proposal Overall Ranking
Review: Overall Score il

Review: Section 1 Score il

Review: Section 2 Score il

Review: Section 3 Score il

Prior Year Grant
Current Year Requested
Program Area

Result Area

Project Title

Project Results

# Projected to Achieve
% with Many Barriers
Investment per Result
Proposal Ranking
Overall Score

Section 1 Score
Section 2 Score

Section 3 Score

This view includes the Improving Lives Pending saved search, which filters
Requests that have a Disposition of ‘Pending’, and a Request Type of
‘Improving Lives.’

* Pending Requests with Ranking (Achievement Bldg) This view
contains the following fields and column headings.

Field Name Column Heading

Organization: Name Organization, Location
Organization: City
Organization: State

Organization: Total Grant Amount Prior Year Grant
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Field Name

Column Heading

Request: Request Amount

Request’s Coding Sheet: Program Area
Request’s Coding Sheet: Outcomes
Request: Project Title

Request: Results Statement1

Review: Proposal Overall Ranking
Review: Overall Score ab

Review: Section 1 Score ab

Review: Section 2 Score ab

Review: Section 3 Score ab

Current Year Requested
Program Area

Result Area

Project Title

Project Results
Proposal Ranking
Overall Score

Section 1 Score

Section 2 Score

Section 3 Score

This view includes the Achievement Building Pending saved search, which
filters Requests that have a Disposition of ‘Pending’, and a Request Type of

‘Achievement Building.’

* Pending Requests with Ranking (Adv Innovation) This view contains
the following fields and column headings.

Field Name

Column Heading

Organization: Name

Organization: City

Organization: State

Organization: Total Grant Amount
Request: Request Amount

Request’s Coding Sheet: Program Area
Request’s Coding Sheet: Outcomes
Request: Project Title

Request: Results Statement1

Outcomes Plus Views and Saved Searches

Organization, Location

Prior Year Grant
Current Year Requested
Program Area

Result Area

Project Title

Project Results
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Field Name

Column Heading

Review: Proposal Overall Ranking
Review: Overall Score ai

Review: Section 1 Score ai
Review: Section 2 Score Al

Review: Section 3 Score ai

Proposal Ranking
Overall Score
Section 1 Score
Section 2 Score

Section 3 Score

This view includes the Advancing Innovation Pending saved search, which
filters Requests that have a Disposition of ‘Pending’, and a Request Type of

‘Advancing Innovation.’

* Pending Requests with Ranking (Applied Research) This view
contains the following fields and column headings.

Field Name

Column Heading

Organization: Name
Organization: City

Organization: State

Organization: Total Grant Amount
Request: Request Amount
Request’s Coding Sheet: Program Area
Request’s Coding Sheet: Outcomes
Request: Project Title

Request: Results Statement1
Request: Results Short Term
Review: Proposal Overall Ranking
Review: Overall Score ar

Review: Section 1 Score ar

Review: Section 2 Score ar

Organization, Location

Prior Year Grant

Current Year Requested
Program Area

Result Area

Project Title

Project Results

Project Results Short Term
Proposal Ranking

Overall Score

Section 1 Score

Section 2 Score
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Field Name

Column Heading

Review: Section 3 Score ar

Section 3 Score

This view includes the Applied Research Pending saved search, which filters
Requests that have a Disposition of ‘Pending’, and a Request Type of

‘Applied Research.’

* Pending Requests with Ranking (Capital Improve) This view contains
the following fields and column headings.

Field Name

Column Heading

Organization: Name
Organization: City

Organization: State

Organization: Total Grant Amount
Request: Request Amount
Request’s Coding Sheet: Program Area
Request’s Coding Sheet: Outcomes
Request: Project Title

Request: Results Statement1
Review: Proposal Overall Ranking
Review: Overall Score ci

Review: Section 1 Score ci

Review: Section 2 Score ci

Review: Section 3 Score ci

Organization, Location

Prior Year Grant
Current Year Requested
Program Area

Result Area

Project Title

Project Results
Proposal Ranking
Overall Score

Section 1 Score

Section 2 Score

Section 3 Score

This view includes the Capital Improvement Pending saved search, which
filters Requests that have a Disposition of ‘Pending’, and a Request Type of

‘Capital Improvement.’

Outcomes Plus Views and Saved Searches
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* Pending Requests with Ranking (Policy) 'This view contains the

following fields and column headings.

Field Name

Column Heading

Organization: Name
Organization: City

Organization: State

Organization: Total Grant Amount
Request: Request Amount
Request’s Coding Sheet: Program Area
Request’s Coding Sheet: Outcomes
Request: Project Title

Request: Results Statement1
Request: Results Short Term
Review: Proposal Overall Ranking
Review: Overall Score policy
Review: Sec1 Score policy

Review: Sec2 Score Policy

Review: Sec3 Score Policy

Organization, Location

Prior Year Grant
Current Year Requested
Program Area

Result Area

Project Title

Project Results

Project Results Short Term
Proposal Ranking
Overall Score

Section 1 Score

Section 2 Score

Section 3 Score

This view includes the Policy or Advocacy Pending saved search, which
filters Requests that have a Disposition of ‘Pending’, and a Request Type of

‘Policy or Advocacy.’

Portfolio Review (Improving Lives)

fields and column headings.

Field Name

This view contains the following

Column Heading

Grantee Organization: Name

Request: Project Description

Organization Name

Project Description
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Field Name

Column Heading

Coding Sheet: Program Area
Coding Sheet: Outcomes
Request: Total to be served
Request: Final Num Served1
Request:Pct w many barriers
Request: Results Statement1
Request: Results Num1
Request: Final Num Achieved1

Request: Grant Amount

Program Area

Result Area

Projected # to be served
# Served

% with many barriers
Project Results
Projected to achieve

# Achieved Results

Grant Amount

This view includes the End of Grant Reports (Improving Lives) saved search,
which filters Requests that have a Disposition of ‘Pending’, and a Request

Type of ‘Improving Lives.’

Success Details (Improving Lives)

and column headings.

Field Name

This view contains the following fields

Column Heading

Request: Performance Rating
Grantee Organization: Name
Grantee Organization: City
Grantee Organization: State
Request: Project Title

Coding Sheet: Outcomes
Request: Grant Amount
Request: Results Statement1
Request: Final pct achieved

Request: Rec Next Steps High

Outcomes Plus Views and Saved Searches

Performance Rating

Org Name, Location, Project Title

Result Area
Grant Amount
Project Results
% Who Achieved

Recommendations
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Field Name Column Heading

Request: Rec Next Steps Low
Request: Rec Next Steps Medium
Request: Rec Next Steps Comments Comments

Request: Staff Person Program Officer

This view includes the End of Grant Reports (Improving Lives) saved search,
which filters Requests that have a Disposition of ‘Pending’, and a Request
Type of Improving Lives.’

Success Details (Other funding types) This view contains the following
fields and column headings.

Field Name Column Heading
Request: Performance Rating Performance Rating
Grantee Organization: Name Org Name, Location, Project Title

Grantee Organization: City
Grantee Organization: State

Request: Project Title

Coding Sheet: Outcomes Result Area
Request: Grant Amount Grant Amount
Request: Results Statement1 Project Results
Request: Rec Next Steps High Recommendations

Request: Rec Next Steps Low
Request: Rec Next Steps Medium
Request: Rec Next Steps Comments Comments

Request: Staff Person Program Officer
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This view includes the End of Grant Reports (Excludes Improving Lives)
saved search, which filters Requests that have a Disposition of ‘Pending’, and
a Request Type of ‘Achievement Building’, Advancing Innovation’, ‘Capital
Improvement’, ‘Policy or Advocacy’, or ‘Applied Research.’

Review Views

The following section details the Views added for Reviews and the saved
search applied to each View, depending on the investment types selected
during the Outcomes Plus installation process

Important: The saved search applied to each View assumes the creation of new
Request Types when setting up Outcomes Plus. If you chose to add the
fields to existing Request Types, the saved search associated to each View
will need to be modified manually.

End of Grant Summary View (Excludes Improving Lives) This view
contains the following fields and column headings.

Field Name Column Heading

Organization: Name Organization, Location, Project Title
Organization: City
Organization: State

Request: Project Title

Request: Grant Amount Grant Amount

Request’s Coding Sheet: Program Area Program Area

Request’s Coding Sheet: Outcomes Outcome Addressed
Request’s Coding Sheet: Outcomes Result Area

Request: Results Statement1 Project Results

Review: Results Short Term Results Short Term
Review: Proposal Overall Ranking Proposal Ranking
Request: Performance Rating End of Grant Performance
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Field Name Column Heading

Request: Performance Comments Performance Comments

This view includes the End of Grant Reports (Excludes Improving Lives)
saved search, which filters Requests that have a Disposition of ‘Pending’, and
a Request Type of Achievement Building’, Advancing Innovation’, ‘Capital
Improvement’, ‘Policy or Advocacy’, or Applied Research.’

End of Grant Summary View (Improving Lives) This view contains the
following fields and column headings.

Field Name Column Heading

Organization: Name Organization, Location, Project Title
Organization: City
Organization: State

Request: Project Title

Request: Grant Amount Grant Amount

Request’s Coding Sheet: Program Area Program Area

Request’s Coding Sheet: Outcomes Outcome Addressed
Request’s Coding Sheet: Outcomes Result Area

Request: Results Statement1 Project Results

Review: Proposal Overall Ranking Proposal Ranking
Request: Performance Rating End of Grant Performance
Request: Performance Comments Performance Comments

This view includes the End of Grant Reports (Excludes Improving Lives)
saved search, which filters Requests that have a Disposition of ‘Pending’, and
a Request Type of ‘Improving Lives.’
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Pending Requests with Ranking (Improving Lives) This view contains
the following fields and column headings.

Field Name

Column Heading

Organization: Name
Organization: City

Organization: State

Organization: Total Grant Amount
Request: Request Amount
Request’s Coding Sheet: Program Area
Request’s Coding Sheet: Outcomes
Request: Project Title

Request: Results Statement1
Request: Results Num1

Request: Pct w many barriers
Request: Investment per result
Review: Proposal Overall Ranking
Review: Overall Score il

Review: Section 1 Score il

Review: Section 2 Score il

Review: Section 3 Score il

Organization, Location

Prior Year Grant
Current Year Requested
Program Area

Result Area

Project Title

Project Results

# Projected to Achieve
% with Many Barriers
Investment per Result
Proposal Ranking
Overall Score

Section 1 Score
Section 2 Score

Section 3 Score

This view includes the Improving Lives Pending saved search, which filters
Requests that have a Disposition of ‘Pending’, and a Request Type of

‘Improving Lives.’

Outcomes Plus Views and Saved Searches
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Pending Requests with Ranking (Achievement Bldg) This view contains
the following fields and column headings.

Field Name

Column Heading

Organization: Name
Organization: City

Organization: State

Organization: Total Grant Amount
Request: Request Amount
Request’s Coding Sheet: Program Area
Request’s Coding Sheet: Outcomes
Request: Project Title

Request: Results Statement1
Review: Proposal Overall Ranking
Review: Overall Score ab

Review: Section 1 Score ab
Review: Section 2 Score ab

Review: Section 3 Score ab

Organization, Location

Prior Year Grant
Current Year Requested
Program Area

Result Area

Project Title

Project Results
Proposal Ranking
Overall Score

Section 1 Score

Section 2 Score

Section 3 Score

This view includes the Achievement Building Pending saved search, which
filters Requests that have a Disposition of ‘Pending’, and a Request Type of

Achievement Building.’

Pending Requests with Ranking (Adv Innovation) This view contains
the following fields and column headings.

Field Name

Column Heading

Organization: Name
Organization: City

Organization: State

Organization, Location

Outcomes Plus Views and Saved Searches



Using Outcomes Plus

Field Name

Column Heading

Organization: Total Grant Amount
Request: Request Amount

Request’s Coding Sheet: Program Area
Request’s Coding Sheet: Outcomes
Request: Project Title

Request: Results Statement1

Review: Proposal Overall Ranking
Review: Overall Score ai

Review: Section 1 Score ai

Review: Section 2 Score Al

Review: Section 3 Score ai

Prior Year Grant
Current Year Requested
Program Area

Result Area

Project Title

Project Results
Proposal Ranking
Overall Score

Section 1 Score

Section 2 Score

Section 3 Score

This view includes the Advancing Innovation Pending saved search, which
filters Requests that have a Disposition of ‘Pending’, and a Request Type of

‘Advancing Innovation.’

Pending Requests with Ranking (Applied Research) This view contains
the following fields and column headings.

Field Name

Column Heading

Organization: Name

Organization: City

Organization: State

Organization: Total Grant Amount
Request: Request Amount

Request’s Coding Sheet: Program Area
Request’s Coding Sheet: Outcomes

Request: Project Title

Outcomes Plus Views and Saved Searches

Organization, Location

Prior Year Grant
Current Year Requested
Program Area

Result Area

Project Title
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Field Name Column Heading
Request: Results Statement1 Project Results

Request: Results Short Term Project Results Short Term
Review: Proposal Overall Ranking Proposal Ranking
Review: Overall Score ar Overall Score

Review: Section 1 Score ar Section 1 Score

Review: Section 2 Score ar Section 2 Score

Review: Section 3 Score ar Section 3 Score

This view includes the Applied Research Pending saved search, which filters
Requests that have a Disposition of ‘Pending’, and a Request Type of
Applied Research.’

Pending Requests with Ranking (Capital Improve) This view contains
the following fields and column headings.
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Field Name

Column Heading

Organization: Name
Organization: City

Organization: State

Organization: Total Grant Amount
Request: Request Amount
Request’s Coding Sheet: Program Area
Request’s Coding Sheet: Outcomes
Request: Project Title

Request: Results Statement1
Review: Proposal Overall Ranking
Review: Overall Score ci

Review: Section 1 Score ci

Organization, Location

Prior Year Grant
Current Year Requested
Program Area

Result Area

Project Title

Project Results
Proposal Ranking
Overall Score

Section 1 Score
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Field Name

Column Heading

Review: Section 2 Score ci

Review: Section 3 Score ci

Section 2 Score

Section 3 Score

This view includes the Capital Improvement Pending saved search, which
filters Requests that have a Disposition of ‘Pending’, and a Request Type of

‘Capital Improvement.’

Pending Requests with Ranking (Policy)

fields and column headings.

Field Name

Column Heading

This view contains the following

Organization: Name
Organization: City

Organization: State

Organization: Total Grant Amount
Request: Request Amount
Request’s Coding Sheet: Program Area
Request’s Coding Sheet: Outcomes
Request: Project Title

Request: Results Statement1
Request: Results Short Term
Review: Proposal Overall Ranking
Review: Overall Score policy
Review: Sec1 Score policy

Review: Sec2 Score Policy

Review: Sec3 Score Policy

Outcomes Plus Views and Saved Searches

Organization, Location

Prior Year Grant
Current Year Requested
Program Area

Result Area

Project Title

Project Results

Project Results Short Term
Proposal Ranking
Overall Score

Section 1 Score

Section 2 Score

Section 3 Score
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This view includes the Policy or Advocacy Pending saved search, which
filters Requests that have a Disposition of ‘Pending’, and a Request Type of
‘Policy or Advocacy.’

Requirement Views

The following section details the Views added for Requirements and the
saved search applied to each View, depending on the investment types
selected during the Outcomes Plus installation process.

Off Track (Improving Lives) This view contains the following fields and
column headings.

Field Name Column Heading

Organization: Name Org Name, Location, Project Title, ID
Organization: City
Organization: State

Request: Project Title

Request: ID

Request: Project Description Project Description
Request: Total to be served Total to be Served
Requirement: Interim Num Served Served to Date

Request: Results Statement1 Project Results

Request: Results Num1 Total to Achieve Results
Requirement: Interim Num Results1 Achieved Results to Date
Requirement: On Track Issues Problems

Requirement: On Track Course Correction  Course Correction

This view includes the Off Track (Improving Lives) saved search, which has
the On track field set to ‘No’ and a Request Type of Tmproving Lives.’
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Off track (Other Investment Types) This view contains the following
fields and column headings.

Field Name Column Heading

Organization: Name Org Name, Location, Project Title, ID
Organization: City
Organization: State

Request: Project Title

Request: ID

Request: Project Description Project Description
Request: Results Statement1 Project Results
Requirement: On Track Issues Problems

Requirement: On Track Course Correction  Course Correction

This view includes the Off Track (Other Funding Areas) saved search, which
has the On track field set to ‘No’ and a Request Type of Achievement
Building’, ‘Advancing Innovation’, ‘Capital Improvement’, ‘Policy or
Advocacy’, or Applied Research.’

Saved Searches
The following section details the saved searches added to GIFTS, depending
on the investment types added during the installation process.

Achievement Building Pending  Filters Requests that have a Disposition
of ‘Pending’, and a Request Type of ‘Achievement Building.’

Advancing Innovation Pending  Filters Requests that have a Disposition
of ‘Pending’, and a Request Type of ‘Advancing Innovation.’

Applied Research Pending  Filters Requests that have a Disposition of
‘Pending’, and a Request Type of Applied Research.’

Capital Improvement Pending  Filters Requests that have a Disposition
of ‘Pending’, and a Request Type of ‘Capital Improvement.’
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End of Grant Reports (Excludes Improving Lives)  Filters Requests that
have a Disposition of ‘Pending’, and a Request Type of Achievement
Building’, ‘Advancing Innovation’, ‘Capital Improvement’, ‘Policy or
Advocacy’, or Applied Research.’

End of Grant Reports (Improving Lives)  Filters Requests that have a
Disposition of ‘Pending’, and a Request Type of ‘Improving Lives.’

Improving Lives Pending  Filters Requests that have a Disposition of
‘Pending’, and a Request Type of ‘Improving Lives.’

Off Track (Improving Lives)  Filters Requests which have the On track
field set to ‘No’ and a Request Type of Improving Lives.’

Off Track (Other Funding Areas)  Filter Requests which have the On
track field set to ‘No’ and a Request Type of Achievement Building’,
‘Advancing Innovation’, ‘Capital Improvement’, ‘Policy or Advocacy’, or
Applied Research.’

Policy or Advocacy Pending  Filters Requests that have a Disposition of
‘Pending’, and a Request Type of ‘Policy or Advocacy.’

Outcomes Plus Reports

During the Outcomes Plus installation process, up to four Outcomes Plus
reports are added to the GIFTS Report Library.

e

< Success Summary Grouped by Outcome and Result Area: This report
provides a summary view of the number of grants in each success category
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and the total investment that was made. This report displays information
first by outcome and then by the result area.

Success Summary Grouped by Outcome and Result Area
10/2009
High Success General Success Low Success Total
#of Grant #of Grant Zof Grant #of Grant
Outcome Result Area Grants Dollars  Grants Dollwrs  Grants Dollars Grants Dollars
Excellence in Education for
Underserved Youth
Increase number of parents 1 $10,000 o $0 1 $5,000 | 2 $16,000
reading to their children
regularly
Total: 1 $10,000 [ 40 1 $5,000 H $15,000
% of Total Investment: 67% 0% 33% 100%
Healh Intative for a
healthier oity
Prevention of Infant 3 $97.000 2 $18.500 o 30 5 $115.500
mortality
Prevantion of malnutrition 1 $20000 1 $11,000 o 30 2 $31,000
Totak 3 $117,000 3 $29,500 ] $0 7 $146,500
% of Total nvestment: 0% 20% 0% 100%
Reduce crime in our
townahip 50 that all
residents reportthey feel
save waking at night
Increase # of ctizens who o $0 0 $0 2 $17.500 2 $17.500
report suspicious beh avior
in their neighborhood
Increase in # of teens who 2 $37.000 2 $35.000 [ $0 4 $72.000
are off the street at night
Reduce or replace # of adult 1 $5.000 o $0 o $0 1 $5.000
theatres and stores in town
Total: 3 $42,000 ? $35,000 2 $17,500 7 $94,500
% of Total Investment: 44% 3T 19% 100%

% Success Summary Grouped by Result Area and Approach: This report
provides a summary view of the number of grants in each success category
and the total investment that was made. This report displays information
first by result area and then by approach.

The following two additional reports are only added to the Report Library if
the Improving Lives (Direct Service) investment type was selected during
the Outcomes Plus installation process:

< Portfolio Summary Report Grouped by Outcome and Result Area: This
report provides a summary view of the larger impacts that were achieved
by grants. This report shows the return on investment in the number of
participants who were helped and your investment for each of these

Outcomes Plus Reports 243



Using Outcomes Plus

participants to succeed. This report displays information first by the
outcome and then by the result area.

Portfolio Summary Report Grouped by Outcome and Result Area
310/2009
Grant ® L % Investment
Outcome Result Area Count Grant Amount __ Served  Achieved Achieving Per Result
Excellence in Education for
Underserved Youth
Increase number of parents 3 §70,000 350 246 70% $285
reading ta their children
reqularly
Total 3 $70,000 350 246 T0% $285
Health Initative for a heathier
city
Prevention of Infant mortality 5 $115,500 815 5717 % $200
Prevention of malnutrition 2 $31,000 375 296 79% $105
Total 7 $146,500 1,190 873 73% $168
Reduce crime in our township
so that all residents report they
feel save walking at night
Increase ¥ of citizens wha report 2 $17,500 720 250 36% $70
suspicious behavior in their
neighborhood
Increase in # of teens who are 4 $72,000 570 432 6% $167
off the street at night

e

< Portfolio Summary Report Grouped by Result Area and Approach: This
report provides a summary view of the larger impacts that were achieved
by grants. This report shows the return on investment in the number of
participants who were helped and your investment for each of these
participants to succeed. This report displays information first by result area
and then by the approach used by the grantee.

You can access these reports via the Requests tab in the Reports window. For

more information about reports, see “Running Reports” on page 140 of the
GIFTS User’s Guide.

Outcomes Plus Correspondence
Templates

During the Outcomes Plus installation process, up to two correspondence
templates are added. These templates are added to the Writeup letter Event
for Requests.
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The following correspondence template is added if the Improving Lives
(Direct Service) investment type was selected during the Outcomes Plus
installation process:

< Improving Lives Review Summary: This template helps capture answers
for the following question categories in relation to the Improving Lives
investment type: What are we buying? What are the chances we will get
the result? Is this the best use of our money? Each of these question
categories have multiple questions contained within them, such as Are
targets clear and verifiable?, Do key people have the attributes and capabilities
that predict success?, and Are the requested funds to achieve results reasonable for
this participant group and project approach?

Improving Lives Review Summary

Organization: Sunflower House for Youth in Distress
Proposal Nuraber: 4
Project Title: Night classes/activities to help keep teens off the street at night.
What are we Proposal Content
huying?

1. Aretargetsclear | What results ave you committed to aclhieving and for how many persons ¥ persons will get to the
amd verifiable? following resalt

How will pou fmow when your results have been achisved? What information or svidence will you wie to
verify success?
2. Aretargetesetat | What problem are pou addressing and about how many individuals within your focus area have it?
a compelling high | individals have this isme
level relative to: a)
what would have | W#ho ave your parficipants? What are their characteristics and are they in axp way different from the full
set of peopls who have the problem within pour geographic focus ? We plan on serving with these
characteristics:

happened without
the prograt and
b the nature of

petiipents? What results are you committed o ackieving and for how manp persons? persons will get o the

followring vesult

What is your projectsd result longevity? [foome peopls are forscast to lose within the nsxt five pears the
success they reached. what will you do 10 help insure the staying power of accomplishment?

For the people you serve, what would happen without pou? That is, how many people are likely to gt
1 the resul you state fyov did not exisn?
‘people woruld still get to this result.

The following correspondence template is added if the Achievement
Building investment type was selected during the Outcomes Plus installation
process:

% Achievement Building Review Summary: This template helps capture
answers for the following question categories in relation to the
Achievement Building investment type: What are we buying? What are
the chances we will get the result? Is this the best use of our money? Each
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of these question categories has multiple questions contained within
them, such as Is the relationship clear between project results and the gains
anticipated for program participants, with this new or added capacity?, Do the
characteristics described for new staff or consultants clearly contribute to the
project’s success?, and Are the requested funds to create the new or added capacity
reasonable?

Achievement Building Review Summary

Organization: Sunflower House for Youth in Distress

Proposal Number: 714
Project Title: Hight classesfactivities to help keep teens off the street at night

‘What are we buying? Proposal Content

. Will the new or added Defing ihe new or added results pou will achieve once fhe capacity is fully operational.
capacity to be created lead to
results in at least one of the
following four areas

1. Reduced costs.

2. Increased reverme.

3. Increased results.

4. Decreased time to get

results
2. Is the relationship clear Describe the new caprcily pou will creqte in response fo the challenge or opporfunily defined above,
between project results and | Please be specific abouf whai new capabilify will be in place.
the gains anticipated for
program participants, with Define ihe new or added results pou will achisve once fhe capacity is fully operational.
this new or added capacity?
What are the chances we Proposal Comdent
will get the result?
1. Do the characteristics I the new capacity is dependenf on either a new Staff person or conmeltand, what charectaristi.
deseribed for new staff or are critieal fo their success?

consultant clearly contribute to
the project’s success?

2. Is there a clear corumitment What are the crifical changes in organizational policy or staff behavior that must take place for
from the organization to this new capaciy to have i#s greafest impact?
implement critical changes in
policy, staffing or actions?

For more information about generating correspondence, see “Generating
Correspondence” on page 453 of the GIFTS User’s Guide.
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About Link Plus

248

GIFTS Link Plus for use with Outlook allows you to send Outlook email to
GIFTS as a Mail Activity. If you have Document Manager, you can store the
email and/or email attachments as documents. During the linking process,
you can choose to link the Mail Activity with a record in GIFTS.

Depending on how Link Plus has been configured, the body of the email
will be saved in the Long Notes section of the Mail Activity, or the email will
be saved as a message (.msg) file in Document Manager. Also, depending on
how Link Plus has been configured, email attachments may be exported
into GIFTS as External Document Activities.

Note: The examples in this section have the body of the email saved in the
Long Notes section of the Mail Activity.

For more information about configuring Link Plus, see “Setting Up Link
Plus Security” on page 19.

Note: Essential GIFTS users cannot use GIFTS Link Plus.

Working with the Link Plus Icon

After you install Link Plus, the Link Plus icon appears as a MicroEdge daisy
on your Outlook Standard toolbar. After selecting any sent or received

email, you can click this icon to export it to GIFTS.
Help
sply to All i Forward | S SendfReceive ~ | BoFind [ | [ Typeacontacttofind — « | (@) Fn”— Link Plus icon

B ¥ [ Subject

(=] Date: Today
(=4 (i Request Information

Note: If you have the Standard toolbar hidden, the icon will not appear. Also,
if Word is your default email editor and you are using Outlook 2003, ‘Send
to GIFTS  appears in place of the icon in the email window.

About Link Plus
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For any unsent message, you can depress the Link Plus icon to automatically
export the message to GIFTS when the email is sent. The Link Plus icon is
depressed after you click it. The image below displays an unsent email
message in which the Link Plus icon has been depressed.

=

Twpe a question For help

Gl 9 100%  » (@) | Read !

rEO-v-A-H

Important: An email with a depressed Link Plus icon is automatically exported
to GIFTS just before the email is sent, so a Mail Activity is created in GIFTS
regardless of whether or not the email is delivered to its recipient(s). If you
do not want a Mail Activity in GIFTS for an undelivered email that did not
reach its intended recipient(s), you must manually delete the Mail Activity in
GIFTS.

Exporting Outlook Email into GIFTS

If you have both GIFTS 6.2.1 and Plus Pack 5, you can export one or more
Outlook email messages to GIFTS.

To export Outlook email and create a new Mail Activity in GIFTS:
1 Select one or more email messages in Outlook.
Note: You cannot export any unsent emails into GIFTS.

2 Click the Link Plus daisy icon in the Outlook toolbar.
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Note: If you have previously exported this email to GIFTS, a message
appears asking you if you want to export it again.

Tip: If you want to see which emails have already been exported to GIFTS,
you can add the MERECID column to your Outlook Inbox. This column
displays a GIFTS Activity ID if the email has already been exported to
GIFTS. To add this column:

i. Right-click on the Outlook Inbox column and select ‘Field Chooser’.

ii. Select “‘User-defined fields in Inbox’ from the Field Chooser drop-down
menu.

ili. Drag and drop ‘MERECID’ to any Inbox column heading location.
If you are not currently logged into GIFTS, a GIFTS Login dialog box

appears. Enter your GIFTS login information and click OK. The GIFTS
Link Plus Matching Options window appears.

% GIFTS Link Plus - Matching Options CEE

‘When exporting the selected message to GIFTS:
() Match to existing Activity (%) Create new Activity
Link to el [
Quick Search
Mo matching Requests could be found. Use the Quick ar
Advanced search above to look for possible matching
Requests.

In the two radio buttons at the top of the window, select whether you
would like to create a new Mail Activity, or link the email(s) to an existing
Mail Activity currently in GIFTS.

Note: If you select Match to existing Activity, your new Mail Activity will
either overwrite or create a new Activity, depending on your Link Plus
preferences. For more information, see “Setting Up Link Plus Security”
on page 19.

Exporting Outlook Email into GIFTS



Using Link Plus for Use with Outlook

5 Using the Link to drop-down menu, select the kind of existing GIFTS
record to which you want to link the email(s), or if you do not want to
link the email(s) to any existing GIFTS record.

Note: This field is only active if you selected the Create new Activity radio
button.

6 Enter search text in the Quick Search text box to help find the GIFTS
record(s) to which you want to link the email(s), and then click Go.
Possible matches display in the GIFTS Link Plus Matching Options
window.

Note: For more information about using this field as well as the Advanced
search functionality, refer to “Linking Email to Existing GIFTS Records”
on page 253.

5 GIFTS Link Plus - Matching Options

‘Wwhen exporting the selected message to GIFTS

() Match to existing Activity (%) Create new Activity
Link to eristing Request(s) e
Quick Search | Mew York
Organization/Contact Request N
The Children's Fund Charles 424
Roberts Engage more New Yorkers in

learning about, shaping, informing,
and acting on public policy issues to.
Big Brothers Big Sisters of New Yok 434
] City Suzanne Celebrate Mew Tork
James

Big Brothers Big Sisters of New Yok 434.01
] City Suzanne Celebrate Mew Tork
James

Big Brothers Big Sisters of New Yok 434.02
] City Suzanne Celebrate Mew Tork A

[ Next H Finish ” Cancel ]

7 Enable the checkbox next to the GIFTS record(s) to which you want to
link the email(s) and then click Next. The GIFTS Link Plus Export Options
window appears.

Exporting Outlook Email into GIFTS 251



1 1 Using Link Plus for Use with Outlook

10

252

Note: You can link an email to multiple GIFTS records (except for
Activities), and you can link multiple emails to a single GIFTS record, but
you cannot link multiple emails to multiple GIFTS records.

8 GIFTS Link Plus - Export Options

Contact
Request Primary Contact (M. Charles Roberts, -Change
robertsc@tef.arg)

Organization

Request Frimary Organization (The Childien’s Fund)

Tite Trasmitial Letted

Kemmards

Motes Email received

Download attachments

[ Back ][ Finish H Cancel ]

Note: Click Change next to the Contact or Organization fields to change
these records. These fields are not active if you are exporting multiple
emails.

Enter an Activity Title, Keywords, and Notes, if necessary.

If you want to include any email attachment(s) in the export, enable the
Download attachments checkbox.

Note: This field only appears if Link Plus is configured to allow email
attachments, and your email contains an attachment. In order to
download email attachments, you must have the Document Manager.

If you selected to match this Activity to an Existing Activity, enable the
Delete existing Activity if you want this Activity to replace the existing
one.

Note: This field only appears if your Link Plus preferences have been
configured to allow this option. For more information, see “Setting Up
Link Plus Security” on page 19.
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11 Click Finish. A process monitor appears.

5 GIFTS Link Plus FEX

Export to GIFTS completed successfully
p | Activity [3BE7] created in GIFTS

Save Log

PFrint Log

Close

12 Click Close.

Note: You can click Save Log to save thislog information as a text (.txt) file,
or Print Log to print it. Please note that this is the only log created for the
Mail Activity, so if you do not save it, you will have no history of'it.

Linking Email to Existing GIFTS Records

You can use the Quick Search text box and the Advanced button on the
GIFTS Link Plus Matching Options window to locate the correct GIFTS
record to which you want to link the Outlook email. This section describes
step 6 in “Exporting Outlook Email into GIFTS” on page 249.

4 GIFTS Link Plus - Matching Options

‘when exporting the selected message to GIFTS:

(%) Match to existing Activity () Create new Activiy
Link ta
Quick Search

Mo matching Activities could be found.  Use the Quick or
Advanced search above to look for possible matching
Activities.

Cancel
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Working with the Quick Search

Depending on which selection you make in the Link to drop-down menu,
you can enter search criteria in the Quick Search field and click Go to display
all related GIFTS records containing that criteria.

4% GIFTS Link Plus - Matching Options

‘when exparting the selected message to GIFTS

() Mateh to existing Activity (%) Create new Activity
Link to existing Request(s) v
Guick Search |New York
Organization/Contact Fequest fa
The Children's Fund Charlzs 424
Raberts Engage mare New Yarkers in

learning about. shaping. infarming.
and acting on public policy issues to..
Big Biathers Big Sisters of Mew Yark 434
| City Suzanne Celebrate Mew York,
James

Big Brothers Big Sisters of Mew York 43401
City Suzanne Celebrate New York
James

Big Brothers Big Sisters of Mew York  434.02
E City Suzanne Celebrate New York 3

[ Met |[ Fish ][ Cancel |

The Quick Search uses the following logic to find possible matches,
depending on the selection in the Link to drop-down menu:

Existing Request(s) The functionality searches first for a Request ID that
matches the search criteria. If no match is found, the functionality searches
for a Request Reference Number that matches the search criteria. If no
match is found, the functionality then searches for a Project Title that
contains the search criteria.

Existing Organization(s) The functionality searches for any Organization
Name that contains the search criteria.

Existing Contact(s) If the search criteria contains a space, the functionality
uses the first word to search for a Contact First Name that matches the
search criteria, and uses the second word in the search criteria to search for a
Contact Last Name that matches the search criteria. If no match is found,
the functionality then searches for a Contact Last Name that contains the
search criteria.

Linking Email to Existing GIFTS Records



Using Link Plus for Use with Outlook 1 1

Match to existing Activity If you select this radio button, the Link to drop-
down menu is grayed out. The functionality searches for a Letter Subject
that contains the search criteria. If no match is found, the functionality
searches for a Request ID that matches the search criteria. If no match is
found, the functionality then searches for Letter Keywords that contain the
search criteria.

Working with Advanced Search

The Link Plus Advanced search functionality works similarly to the Quick
Find Search functionality in GIFTS. The Advanced search functionality
appears when you click Advanced on the GIFTS Link Plus Matching
Options window.

To use the Advanced search functionality to export Outlook email and
create a new Mail Activity in GIFTS:

1 Select one or more email messages in Outlook.
2 Click the Link Plus icon in the Outlook toolbar.

Note: If you have previously exported this email to GIFTS, a message
appears asking you if you want to export it again.
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3 Ifyou are not currently logged into GIFTS, a GIFTS Login dialog box
appears. Enter your GIFTS login information and click OK. The GIFTS
Link Plus Matching Options window appears.

#% GIFTS Link Plus - Malching Options =03

‘When exporting the selected message to GIFTS:
(3) Match to existing Activity () Create new Activiey

Link ta

Quick Search | | [ Go ] [ Advanced

Mo matching Activities could be found. Use the Ouick or
Advanced search above to look for pozzible matching
Activities.

Cancel

4 At the top of the window, select to link the email(s) to an existing Mail
Activity currently in GIFTS if it is not already selected.

Note: Your new Mail Activity will either overwrite or create a new
Activity, depending on your Link Plus preferences. For more
information, see “Setting Up Link Plus Security” on page 19.

5 Click Advanced. The Search for Activities window appears.

3 Search for Activities

Add...
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6 After selecting a field in the Available Fields drop-down menu, click Add
to add a search expression to the search criteria. A window allowing you
to enter specific search parameters for that expression appears.

2 Primary Contact Last Name

is | | Anderzon

Note: The drop-down menu on the left side of the window allows you to
enter an operator, such as “is”, “begins with” or “contains.” The field on
the right side allows you to enter a value.

7 Enter search parameters for the field, and then click OK. The expression
appears in the Search for Activities window.

Tip: Click Edit to edit the search parameters for a selected expression, or
Remove to remove any selected expression. Click Clear to remove all
expressions from the search criteria.

8 Add more search expressions to the search criteria, if necessary.
9 Click Finish. Any records matching the search criteria appear.

10 Enable the checkbox next to the GIFTS record(s) to which you want to
link the email(s) and then click Next. The GIFTS Link Plus Export Options
window appears.
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11
12

13

14
15

Note: You can link an email to multiple GIFTS records, and you can link
multiple emails to a single GIFTS record, but you cannot link multiple
emails to multiple GIFTS records.

# GIFTS Link Plus - Export Optians B
Contact
Request Primary Contact [Mr. Charles Roberts, Change.
robertsc@tef.arg)

Organization

Request Frimary Organization (The Childien’s Fund)

Tite Trasmitial Letted

Kemmards

Motes Email received

Download attachments

[ Back ][ Finish H Cancel ]

Note: Click Change next to the Contact or Organization fields to change
these records. These fields are not active if you're exporting multiple
emails.

Enter an Activity Title, Keywords, and Notes, if necessary.

If you want to include any email attachment(s) in the export, enable the
Download attachments checkbox.

Note: This field only appears if Link Plus is configured to allow email
attachments, and your email contains an attachment. In order to
download email attachments, you must have the Document Manager.

If you selected to match this Activity to an Existing Activity, enable the
Delete existing Activity if you want this Activity to replace the existing
one.

Note: This field only appears if your Link Plus preferences have been
configured to allow this option. For more information, see “Setting Up
Link Plus Security” on page 19.

Click Finish. A process monitor appears.

Click Close.
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Note: You can click Save Log to save thislog information as a text (.txt) file,
or Print Log to print it. Please note that this is the only log created for the
Mail Activity, so if you do not save it, you will have no history of'it.

Working with Link Plus Email Activities in

GIFTS

After you export an Outlook email into GIFTS, you can view the associated
Mail Activity in GIFTS. The Mail Activity appears in both the Activities and
Documents tabs in GIFTS.

The image below displays a Mail Activity.

% Document [3694] (A=
File Action Help
Save and Close ‘El Browse for File

Activity ] Long Maotes W

Reference

Abuse Prevention and Rehabilitation Fund i Feq. ID / Ref. No.
[Abuse Prevention and Rehabilitation Fund] _
Washington, DC 20001
LContact |Hazlett, Haward j 3693
Document
Date 06/13/2003 -
File Marme |
Title |E-Mai
Subject |RE: please review the iant information for the Davis Health Alliance
Author |#nna
EKepwards |Grant Propozal
Netes Sent E-Mail
[F3 = Spell]
[¥ Shareable
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If you selected the ‘Save Messages in Activity Notes” preference in the Link
Plus section of the Plus Pack Configuration utility, the email content is
displayed in the Long Notes section of the Mail Activity.

% Document [3694] EEX

Eile | Action Help
Save and Clase | gy Browse for File
Activitg  Long Notes ]

[F3 = Spel]

Too Anna
Hey Anna,

Thiz look s fine but let me check on the determination letter with respect to their curent
statuz.

- &ne

--iiginal Meszage--

From: Anna

Sent: Thursday, June 11, 2009, 10:45 &AM

Tar Anne Srith

Subject: Please review the grant information from the D avis Health liance

Hi there,

Can yau take a look at the attached and let me know if we shauld mowve fanward?

Thanks,

- &nna

If you selected the ‘Save messages as .msg files” preference in the Link Plus
section of the Plus Pack configuration utility, the email content is attached
to the Mail Activity as an .msg file. You can view the .msg file containing the
email content by clicking View File on the Mail Activity, or by zooming in
on the Activity and clicking the Documents tab.

For more information about Link Plus and the Plus Pack Configuration
utility, see “Setting Up Link Plus Security” on page 19.

Working with Email Attachments in GIFTS

If the email contains attachments, and you selected the ‘Download
Attachments’ checkbox while exporting the email, each email attachment
appears in GIFTS as an External Document Activity. Below is an image
showing two related Activities: a Mail Activity and an External Document
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Activity. Both of these Activities were created when one email with one
attachment was exported to GIFTS using Link Plus.

Viohrioer Gt | ooeprs A R J
Bkt | Bermcts Reabevorts | [ 1 Mt Gt
Oiganastions | Feuests | Aipan | Gontacts Acfpetms

Advertae Chr of Marhstion [ENGIFT S \Documes Created §/3/2009 by

iton Repert doc] ADMIN
Tet (212) 1234767
Fac 2121 RHTTT

moe

Both Activities display in both the Activities tab and the Documents tab.

Nofe: If you do not have the Document Manager, you cannot export any
email attachments to GIFTS, and no External Document Activities will be
created.
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Appendix: Tax Status
Codes

The following is a list of tax status codes and their associated
descriptions and organization types. Your GIFTS Administrator can
use this table when setting up tax status codes. For more information,
please see “Setting Up Tax Status Codes” on page 110.

Tax Status Description Organization Type
Code

01 501(c)1 Government Instrumentality
02 501(c)2 Title-Holding Corporation
03 501(c)3 Charitable Organization

Educational Organization

Literary Organization

Organization to Prevent Cruelty to Animals
Organization to Prevent Cruelty to Children
Organization for Public Safety Testing
Religious Organization

Scientific Organization

04 501(c)4 Civic League
Local Association of Employees
Social Welfare Organization

05 501(c)5 Agricultural Organization
Horticultural Organization
Labor Organization
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Tax Status Description Organization Type

Code

06 501(c)6 Board of Trade
Business League
Chamber of Commerce
Real Estate Board

07 501(c)7 Pleasure, Recreational, or Social Club

08 501(c)8 Fraternal Beneficiary Society, Order or
Association

09 501(c)9 Voluntary Employees’ Beneficiary Association
(Non-Government Employees)
Voluntary Employees’ Beneficiary Association
(Government Employees)

10 501(c)10 Domestic Fraternal Societies and Associations

1 501(c)11 Teachers Retirement Fund Association

12 501(c)12 Benevolent Life Insurance Association
Mutual Ditch or Irrigation Company
Mutual Cooperative Telephone Company
Organization Like Those on Three Preceding
Lines

13 501(c)13 Burial Association
Cemetery Company

14 501(c)14 Credit Union
Other Mutual Corporation or Association

15 501(c)15 Mutual Insurance Company or Association
Other Than Life or Marine

16 501(c)16 Corporation Financing Crop Operations

17 501(c)17 Supplemental Unemployment Compensation
Trust or Plan

18 501(c)18 Employee Funded Pension Trust (created before
6/25/59)

19 501(c)19 Post or Organization of War Veterans



Tax Status Description Organization Type

Code

20 501(c)20 Legal Service Organization

21 501(c)21 Black Lung Trust

22 501(c)22 Multiemployer Pension Plan

23 501(c)23 Veterans Association Formed Prior to 1880

24 501(c)24 Trust Described in Section 4049 of ERISA

25 501(c)25 Title Holding Company for Pensions, etc.

26 501(c)26 State-Sponsored High Risk Health Insurance
Organizations

27 501(c)27 State-Sponsored Workers’ Compensation
Reinsurance

40 501(c)40 Apostolic and Religious Organizations (501(d))

50 501(c)50 Cooperative Hospital Service Organization
(501(e))

60 501(c)60 Cooperative Service Organization of Operating
Educational Organization (501(f))

70 501(c)70 Child Care Organization (501(k))

71 501(c)71 Charitable Risk Pool

81 501(c)81 Qualified State-Sponsored Tuition Program

92 501(c)92 4947(a)(1) - Private Foundation (Form 990PF

Filer)
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Index

Numerics
1st Payment Date option 45, 49

A

adding codes 26
Adjust for weekends option 37, 39, 45, 49
attachments, e-mail 107, 110

B

BCC recipients 107, 110
budget resolution of payments 46, 51

C

CC recipients 107, 110

Charts Plus
3D charts 88
about 70

axes settings 91
chart properties 96
editing chart data 95
grouping options 80
grouping Payment data 78
grouping Request data 76
point labels 94
selecting chart groupings 76
selecting data 71
toolbar 86
viewing a chart 71
closed activities, updating 28
codes, modifying 25
Coding Sheets, modifying 25
creating
batches of Grant Requirements 36
batches of Payment Requirements 38
payment schedules for Requests 45, 54

D

default reserve funds 51
deleting requirements 41

E

Email attachments 260
e-mail, sending 106, 114
Exporting Outlook Email 249

F

Fund, updating 33
future activities, updating 28
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G/L Account
default for payment schedules 46, 50
updating in batch 33

Grant Requirements, creating batches of 36

L

Link Plus 247

Link Plus Advanced Search 255
Link Plusicon 248

Log Mail Activity option 108, 111

M

make a code primary 26
Mark Payments as Contingent option 39
Meeting Dates, updating 32

0

organizations’ tax status, verifying 116

Outcomes Plus 149, 247

Outcomes Plus Code Tables 217

Outcomes Plus Correspondence
Templates 244

Outcomes Plus Reports 242

Outcomes Plus Review Stages 218

Outcomes Plus Views and Saved
Searches 219

overdue activities, updating 28

P

parameters, for silent batches 62, 63
Payment Requirements, creating batches
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of 38
payment schedules
creating 45, 54
creating in batch 48
modifying 47
Payment Type
default for payment schedules 46, 50
updating in batch 33
payments, updating 33
percentage allocation of payments 46, 50
primary codes, updating 26
Project Description, updating 31

R

Read Receipt option 108, 111
removing codes 26
removing e-mail attachments 108, 111
replacing codes 26
Request Type/Status, updating 29
Requirement Customizer Fields 215
requirements
creating batches for payments 38
deleting batches of 41
reserve funds, default 51
rounding payment amounts 46, 49

S

sending e-mail 106, 114
silent mode 62, 63

staff, updating 28

Support Type, updating 33

T

tax exempt organizations, searching for 123
Tax Status Plus 113



w

WatchLists Plus 131, 149, 247
WatchLists Plus and GIFTS Activities 132
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